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In the view of the changing business environment and suggestions received from experts, 
this book has been thoroughly planned and updated. This book provides a comprehensive 
and balanced coverage of the subject. In addition to usual topics, the book presents 
contemporary topics also. High quality and quantity of topics is maintained for application 
in global set up. The student and faculty will find the contents of the book short and 
precise. Explanations are given in understandable language with a sufficient support 
from real business information. I have great pleasure in presenting the book titled Office 
Management and Secretarial Practice.

This volume is an attempt to provide the students with thorough understanding of 
office management and secretarial practice concepts and methods. This book presents the 
subject in a systematic manner with liberal use of figures applicable to the content. 

This book will prove extremely useful to students and teachers alike. It also can be 
adopted and used successfully. This book is even suited for self study. 

This book covers following areas: Office Activities, Functions and organization, 
Qualities of Office Manager, Office Accommodation and Principles, Office System and 
Procedures, Office records, Office Committee, Office Communication and Mail Service, 
Office Automation - Office Machines and Manuals, Importance of Typing in modern 
era, Book keeping and Accountancy, English and Communication Skills, Business 
Correspondence, Basis of Information Technology, Internet and Networking, Business 
Management, Personnel Management and Secretarial Practice

It’s sure that this book will be more useful for the student fraternity, teachers, 
executives and other professionals. Suggestions and comments for the improvement of 
the books are welcomed.

To get employment opportunities in Industrial Sectors. 

Office Management And Secretaryship has been revamped by SCERT in col-
laboration with Tamil Nadu Skill Development Corporation in order to get immediate 
employment opportunities  for the vocational students in the Industrial Sectors in future. 
The skill certificate for practical assessment is given to every student by concerned Sector 
Skill Councils (SSCs) which are accredited by National Skill Development Corporation 
(NSDC) and TNSDC.

PREFACEPREFACE

FM.indd   3 5/2/2022   5:09:12 PM

www.tntextbooks.in



iv

E-book Assessment

BRIEF CONTENTSBRIEF CONTENTS

Chapter Topic Page. No. Month

Preface iii

1 Modern Office and Management 1
June

2 Office Accommodation and Layout 10

3 Modern Office Furnitures and Stationeries 21
July

4 Records, Filing and Indexing 33

5 Office Management Software 44 August

6 Office Systems and Procedures 56 September

7 Database Management System(DBMS) 65 October

8 Office Management Related Banking Services 77 November

9 IT and ITES SERVICES 86 December

Model Question Paper 98

FM.indd   4 5/2/2022   5:09:12 PM

www.tntextbooks.in



OFFICE MANAGEMENT AND SECRETARYSHIP

1.	� MODERN OFFICE AND 
MANAGEMENT  01–09

	 1.1	 Introduction	
	 1.1.1	� Meaning
	 1.1.2	� Definition
	 1.2	 Importance and Functions of 		
		  Office Management
		  1.2.1	Importance of office 		
			   management 
		  1.2.2 Functions of Office 		
			   Management
	 1.3	 Types of an Office Management
	 1.4	� Office Manager
	 1.5	 Roles and Duties of an Office 		
		  Assistant
	 1.5.1 Role of an Office Assistant
	 1.5.2 Duties of an Office Assistant

	 1.6	� Introduction to an Office 
Automation

		    1.6.1 Meaning
	 1.6.2 Objectives of an Automation
	 1.6.3 �Importance of Office 	

Automation
	 1.6.4 Types of Office Automation

	 1.7 Accommodating a Mobile 		
		  Workforce
	 1.7.1 Strategies and Techniques
	 1.7.2 Productive usage

2.	� OFFICE ACCOMMODATION AND 
LAYOUT  10–20

	 2.1 Introduction 
	 2.2 �Selection of Office 

Accommodation
	 2.3 Shared Workspace
	 2.4 �Navigation IoT (Internet of 

Things) and Sensors
	 2.5 Introduction of Office Layout
	 2.6 Recent Trends in Office Layout
	 2.6.1	 Eco-Friendly office

	 2.7 Maintaining a Healthy and Safety
		  Office Equipment
	 2.7.1	� Protection of Health and 

Safety of employees
	 2.7.2	� Safety Measures at 

Workplace

3.	� MODERN OFFICE FURNITURES 
AND STATIONERIES  21–32

	 3.1 Introduction
	 3.2 Office Furniture, Fittings and 		
		  Accessories
	 3.2.1	� Selecting, Purchase 

Procedure and Methods of 
using Office Furniture

	 3.2.2	 Uses of Office Furniture
	 3.3 Purchasing and Safeguarding the 	
		  Assets
	 3.4 Introduction - Office 			 
		  Stationeries
	 3.4.1	� Classification of Office 

Stationeries
	 3.4.2	� Importance of Managing 

Stationeries
	 3.4.3	� Selection and Purchasing 

of Stationeries
4.	� RECORDS, FILING AND 

INDEXING  33–43
	 4.1	� Introduction
	 4.1.1.	� Meaning of Records
	 4.1.2.	� Types of Records
	 4.1.3.	� Records Management
	 4.2	� Filing
	 4.2.1 	 Classification of Files
	 4.2.2 	 Uses of Filing
	 4.3 Introduction - Indexing
		  4.3.1 	 Types of Indexing
		  4.3.2	 Selection of a Suitable 		
			   Indexing System
		  4.3.3	 Advantages of Indexing

CONTENTSCONTENTS

v

FM.indd   5 5/2/2022   5:09:12 PM

www.tntextbooks.in



7.5	Create Forms and Reports Using 		
	 Wizard
	 7.5.1	 Forms in Base
	 7.5.2	� Creating a Form Using 

Wizard
	 7.5.3	� Steps to Create REPORT 

using Wizards
8.	� Office Management Related Banking 

Services  77–85
	 8.1	� Introduction
	 8.1.1	 Meaning
	 8.1.2	� Procedure for Opening 

Bank Accounts
	 8.1.3	� Maintaining of Bank 

Statements
	 8.1.4	� Different forms used in 

banks
	 8.1.5	 Modern Banking Services
	 8.1.6	� Types of Accounts/

Deposits
	 8.2	 Core Banking Solutions
	 8.3	 No-Frills Account
	 8.4	 Common Banking Services

9.	 IT  and ITeS Services  86–94
	 9.1	 Introduction
	 9.1.1 Meaning:
	 9.2	 Business Process Outsourcing 		
		  (BPO) Services
	 9.2.1	� Important BPO Services
	 9.2.2	� Advantages of BPO 

services
	 9.2.3	� BPO Services in India
	 9.2.4	� Classsification of major 

BPO Services
	 9.2.5	� Advantages of BPO Service 

Industry
	 9.3	 Business Process Management 	
		  (BPM) Industry in India
	 9.3.1	� Definition
	 9.4	� Structure of the IT-BPM 

industry
	 9.4.1	� Parameters of IT-BPM 

industry 
	 9.5	 Various IT applications

5.	� OFFICE MANAGEMENT 
SOFTWARE  44–55

	 5.1	� Introduction
	 5.2	� Various Functions of Office
		  Management Software
	 5.2.1	� Application of Office 

Management Software
	 5.3	� Introduction-Cloud Computing
	 5.3.1	� Meaning
	 5.4	� Activity Based Working
	 5.5 	 Bring Your Own Device (BYOD)
6.	� OFFICE SYSTEMS AND 

PROCEDURES  56–64
	 6.1	 Introduction
	 6.1.1	� Meaning
	 6.1.2	� Definition
	 6.1.3	 Principles of Office 
	 6.1.4	� Importance of Office 

Systems and Procedures
	 6.1.5	� Distinguish between Office 

Systems and Procedures
	 6.2	 Introduction - Office Manuals
	 6.2.1	 Meaning
	 6.2.2	 Definition
	 6.2.3	 Types of Office Manuals
	 6.2.4	 Steps in Preparation and 		
		  Writing of Office Manuals
	 6.2.5	 Revision and Distribution 	
		  of Office Manuals
7.	� DATABASE MANAGEMENT 

SYSTEM(DBMS)  65–76
	 7.1	� Introduction
	 7.1.1	 Meaning
	 7.1.2	� Definition
	 7.1.3	 Features of DBMS
	 7.1.4	 Concept of DBMS
	 7.2	� Create a Table using Table 

Wizard
	 7.2.1	� Steps to create a table using 

table wizard
	 7.2.2	� Table Data View Dialog 

Box
	 7.3	� Perform Operations on Table
	 7.4	 Retrieve Data using Query

vi

FM.indd   6 5/2/2022   5:09:12 PM

www.tntextbooks.in



1

Content:

Introduction – Meaning – Definition 
– Importance and Functions of 
Office Management – Types of Office 
Management – Office  Manager – Roles and 
Duties of Office Assistant – Introduction 
to Office Automation – Meaning – 
Objectives of Automation – Importance 
of Office Automation – Types of Office 
Automation – Accommodating a Mobile 
Workforce – Strategies and Techniques – 
Productive usage.

•	 Enable the students to understand 
the importance and functions of 
modern office management.

•	 The students can gain knowledge 
about the roles and duties of an 
office assistant, office automation 
and accommodating a mobile 
workforce.

1.1 Introduction:

	 The management of the modern 
office is responsible for obtaining and 
administrative accomplishments with 
strategy. The office management functions 
are concerned with designing, evaluating, 
implementing the work processes carried 
out in offices and the traditional office 
environments. It is a part of the business 
management function.

Learning Objectives

Modern office management aims 
to enhance productivity and efficiency by 
improving the performance of office work. 
The office usually is a place for transacting 
business where clerical and administrative 
functions are carried out by co-ordination 
and control activities of the organisation. 
This provides motivation to the workforce 
and makes them to realise the ambition of 
the organisation. 

1.1.1 Meaning:

Office management helps to 
maintain a close relationship between 
the different departments and people. 
It regularly supplies order, command 
and instruction to different people. It 
performs various functions like planning, 
organising, staffing, co-ordinating , 
controlling,  supervising, motivating and 
an effective leadership.

1.1.2 Definition:

In simple words, office 
management can be defined as “a distinct 
process of planning, organising, staffing, 
directing, co-ordinating and controlling 
offices in order to facilitate achievement 
of objectives of any business enterprises”.

According to Mills & Standing 
ford “The office is the administrative 
centre of a business. The purpose of an 
office has been defined as the providing of 
a service of communication and record”.

UNIT – 1
MODERN OFFICE  MANAGEMENT

1
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established in the planning function. 
Resources include materials, 
personnel and financial backing.

(iv)	 Directing: Direction can thus be 
regarded as the process of guiding 
and supervising staff. 

(v)	 Training: The regular training 
programmes are also conducted 
for the new  recruits as well as 
existing staff. Orientation training 
programme is a programme 
provided to existing staff. 

(vi) 	 Controlling Systems: Controlling 
systems refers to all the processes that 
leaders create to monitor success.

(vii)	 Discipline: The implementation of 
rules and regulations of the office is 
in the hands of the office manager. 
There should not be personal bias 
while implementing rules and 
regulations. He also attends to the 
grievances of office staff. In this 
way discipline is maintained. 

1.3 Types of an Office Management:

(i)	 Corporate Office Management: 
Corporate office management 
includes the manager at each 
branch of a given company. The 
district manager oversees all 
other branch managers, therefore 
travelling between company 
branch locations is often a main 
aspect of the job. 

(ii)	 Medical Office Management: 
Medical office management requires 
detailed knowledge of anatomy and 
lab procedures, as well as health care 

1.2� Importance and Functions of Office    
Management: 

1.2.1 Importance of office management:

(i)	 Helps in achievement of targets and 
managing change if any.

(ii)	 Optimum use of resources for social 
benefits.

(iii)	 Minimization of costs.

(iv)	 Smooth flow of work and maintain 
public relations.

(v)	 Helps in maintaining office effi-
ciency.

(vi)	 Managing survival and growth.

(vii)	 Encourages innovation.

(viii)	Helps in retaining talent.

(ix)	 Provides leadership.

1.2.2 Functions of Office Management:

(i)	 Planning: Planning is the basic 
function of office management. It is 
concerned with deciding in advance 
what is to be done and how it is to 
be done. To plan is to produce a 
strategy to action. 

(ii)	 Staffing: Top management determine 
the number of staff required, their 
qualification and experience if any, 
decide the sources of recruitment, 
receiving  applications, conduct the 
interviews and tests and finally select 
the right personnel.

(iii)	 Organising Resources: The  
organising function brings resources 
together to achieve the goals 
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laws. Medical office managers typically 
work in doctors’ offices, where they 
supervise all medical assistants.

(iii)	 Legal Office Management: Legal 
office management requires practical 
law experience and an extensive 
understanding of law procedures. Law 
office managers oversee the practices 
of legal administrative assistants, 
payroll management and the firms’ 
human resources department.

(iv)	 Virtual Office Management: Rather 
than work for me at a time as a full time 
employee, virtual office managers often 
work for several smaller companies 
part-time. This is due to the tendency 
of small businesses to contract out 
virtual office management. 

 

Fig.1.3 Virtual Office or Online Mode of  
working

Fig.1.4 Back Office 

1.4 Office Manager:

An office manager is an individual, 
who is in charge of an office and whose 
function is to organise and control the 
activities of the office. He is appointed to 
head the office. “The office manager is the 
pivot around which the office function 
revolves” (Denyer.J.C.).

He extracts the work from the 
subordinates to achieve organisational goals. 
It is his responsibility to plan, organise 
and control  the  clerical aspects of the 
organisation, coordination and storage of data 
to support production and other important 
operations of industrial establishments. He 
monitors the work processes and evaluates 
their outcome. On the whole he is appointed 
as an administrative head of office. 

Fig.1.2 Modern Office

Fig.1.1 Old Office
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1.6 Introduction to an Office 
Automation:

The term office has undergone 
drastic changes, “The office is now in a 
period of transition” where more and more 
information processing functions are 
being automated through sophisticated 
electronic systems. New electronic 
procedures and systems are becoming more 
and more popular in modern automated 
offices which are otherwise called 
“Paperless offices”. A “Paperless office’ 
is one in which paper has been replaced 
by electronic, digital, micrographic and 
micro processing systems. Several modern 
offices provide satellite communication , 
video teleconferences, electronic mail and 
computer to computer hook-ups for intra-
company use. 
1.6.1 Meaning:

An automation may be described 
as usage of advanced technology with the 
help of specific devices of communication 
and control in self-regulation without 
human intervention. It can also be termed 
as application of information technology 
to the typical clerical and secretarial tasks 
such as communication, correspondence, 
documentation and filing. 

1.6.2 Objectives of an Automation:

An automation in the office refers to 
a process whereby sophisticated machines 
and equipments are introduced in the 
office with a view to aid the administrative 
process. Automation in the office has the 
following objectives. 
(i)	 Automation aims at saving manpower

(ii)	 Office automation enables promptness.

Fig.1.5 Duties of Office Manager

1.5 Roles and Duties of an Office 
Assistant

1.5.1 Role of an Office Assistant:

The role of an office assistant differs 
from company to company. Small but 
growing company to manage the day-to-
day administrative aspects of running 
the business. The successful assistant will 
have a positive attitude, a desire to work 
as efficiently as possible, and excellent 
client-facing communication skills. If 
they have worked in a fast-paced office in 
the past and they enjoy establishing our 
own organisational systems.

1.5.2 Duties of an Office Assistant:

(i)	 Overseeing clerical tasks, such as 
sorting and sending mail. 

(ii)	 Keeping an inventory of office sup-
plies and ordering new materials as 
needed.

(iii)	 Maintaining files.
(iv)	 Welcoming visitors.
(v)	 Answering phone calls.
(vi)	 Taking and delivering messages.
(vii)	 Ensuring the office runs smoothly.
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Fig.1.6 Mobile Phone

Fig.1.7 Swipe Machine 

Fig.1.8 Laptop

1.7 Accommodating a Mobile Workforce:

A mobile workforce is a group of 
employees that is not bound by a central 
physical location, Instead of the employees 
are connected by various types of mobile 
technology i.e computers, smartphones 
and other mobile devices. The idea of a 
mobile workforce goes well beyond simply 
working from home. A mobile workforce 

(iii)	 Automation enables completion of 
work with accuracy.

(iv)	 Elimination of monotony.

(v)	 Minimises the chances of fraud in 
office work.

(vi)	 Data can be stored for future reference. 

1.6.3 Importance of Office Automation:

An office automation has got 
various importance for a modern office 
management which is listed as follows:

(i)	 Automation increases the productivity

(ii)	 Automation eliminates heavy physi-
cal labour.

(iii)	 Automation improves the quality of 
decision making in business.

(iv)	 It improves the working conditions 
and employees safety.

(v)	 Automation leads to quick comple-
tion of work. 

1.6.4 Types of Office Automation:

a. �Telephone, Mobile Phones, Dictation 
Machines

b. �Adding machines, Calculating 
machines, Billing machines, Copier 
machines, Fax machines etc.,

c. �Franking machines, Impression 
stamps, Time recording machines

d. �Slide rule, Punching machine, 
Stapler, Calculators etc.,

e. �Swipe machine, Laptop, Pen drive, 
LED/LCD projector, Biometric 
device, CCTV device
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(iii)	 Let mobile workers define com-
munication and reporting 
practices they want to follow.

(iv)	 Manage deliverables not activities.

(v)	 Engage in more frequent and informal 
performance management activities. 

1.7.2 Productive usage: 

The following are the effective 
elements to be adopted at the workplace 
to increase overall productivity. 

1.	 Be efficient

2.	 Delegate

3.	 Reduce distractions

4.	 Have the right tool and equipment

5.	 Improve workplace conditions

6.	 Offer support and set realistic goals.

7.	 Practice positive management 

8.	 Ensure employees are happy. 

 Fig.1.10 Productive Workforce 

is defined as a workforce comprising 
individuals who work outside of a physical 
office location. These professional workers 
are not limited to employees who work 
from home. Desk-less workers such as 
retail employees, insurance sales persons 
and gig workers such as uber/ola drivers 
are all considered part of accommodating 
a mobile workforce.

A  mobile workforce is more 
common in industries such as 
manufacturing, construction, retail and 
healthcare, where workers are on the field 
and not in an office. They are commonly 
known as desk-less workers or field 
workers. 

Washington Post in 1979 titled. 
“Working at Home can save Gasoline”. 
Portable machines are widely used to 
record dictation previously taken down in 
shorthand by secretaries in an office. It is 
also possible for persons working at home 
to use the telephone to dictate directly 
into machines located in their offices and 
listen to playbacks of relevant passages. 

1.7.1 Strategies and Techniques:

(i)	 Keep communication simple, clear 
and focused on the relationship.

(ii)	 Spend more time listening 

 Fig.1.9 Mobile Workforce
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Evaluation

PART – A

OBJECTIVE TYPES:

I.	 Choose the Correct Answer:� (1 Mark)

1.	 The management of the ________________________ is responsible for obtaining 
and administrative accomplishments.

	 a. Modern Office	 b. Traditional Office 

	 c. Virtual Office  	 d. Front Office� Ans. ( a )

 2.	 Planning is the _____________________ function of office management.

	 a. Best	 b. First  

	 c. Basic  	 d. Important � Ans. ( c )

 3.	 The ______________________ functions bring resources together to achieve the goals.

	 a. Co-ordinating	 b. Organising

	 c. Directing 	 d. Decision Making � Ans. ( b )

4.	 A person who is incharge of office is called _______________________

	 a. Office Manager   	 b. Secretary 	

	 c. Director 	 d. Administrator� Ans. (a)

Points to be Remembered

•	 Modern office management is a part 
of the business management function

•	 Functions of office management 
classified as Planning, Organising, 
Staffing, Directing,Co-ordinating and 
Controlling.

•	 Discipline.

•	 An office manager is in charge of an 
office

•	 Automation may be described as usage 
of advanced technology.

•	 A mobile workforce is more common 
in industries
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5.	 A _____________________ office is one in which paper has been replaced by 
electronic systems.

	 a. Virtual  	 b. Back      

	 c. Front  	 d. Paperless� Ans. ( d )

6.	 _____________________ aims at saving manpower

	 a. Automation   	 b. Skill

	 c. Efficiency   	 d. Workforce� Ans. ( a )

7. 	 Direction can thus be regarded as the process of __________________ staff.

	 a. Planning  	 b. Organising  

	 c. Guiding and Supervising  	 d. Administrative� Ans. ( c )

8.	 The implementation of ____________________ of the office is in the hands of 
the office manager.

	 a. Rules and Regulations	 b. Characteristics  

	 c. Principles	 d. Strategy � Ans. (a )

9.	 The role of __________________________ differ from company to company.

	 a. Officer 	 b. Office Assistant  

	 c. Manager 	 d. Supervisor  � Ans. ( b )

10.	 Legal office management requires practical ___________________ experience.

	 a. Writing	 b. Typing

	 c. Law	 d. Dictating  � Ans. ( c )

 PART – B

II. 	 Very Short Answers: �  ( 3 Marks)

1. 	 Define the term office management.

2.	 Who is the office manager?

3. 	 Write short notes on Virtual office management.

4.	 What is meant by Automation?

5.	 List out the objectives of Automation.

PART – C

III. 	 Short Answers:� ( 5 Marks)

1.	  Explain the types of office management.

2. 	 What are the duties of an office assistant?
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3.	 Write a short note on accommodating a mobile workforce.

PART – D

IV. 	 Essay Type Questions:� (10 Marks)

1.	 Explain the importance and functions of office Management.

2.	 Elaborate the terms office automation.

Teachers Activity:

•	 Should teach basic concepts through classroom discussion.

•	 Prepare charts on functions and types of office management.

Students Activity: 

•	 Students can be asked to conduct role play as office manager.

•	 Visit an office and observe objectives and importance of office automations.

ACTIVITY

References :

1.	 Modern office and its Functions by Dr. R.K. Chopra

2.	 https://en.m.wikipedia.org.

3.	 Source: https://www.slideshare.net

1. Administration : The process of running a business.
2. Automation: Usage of advanced technology without human intervention.
3. Organising : Arranging the work systematically.
4. Procedures: An established or official way of doing something
5. Systems : A set of principles or procedures according to which something is done.
6. Mobile workforce: Comprising individuals who work outside of a physical office location.
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Content:

Introduction to Office 
Accommodation - Selecting Office 
Accommodation and its Mobility – 
Shared Workspace – Navigation, IoT and 
Sensors – Introduction of Office Layout – 
Meaning and Definition – Recent Trends 
in Office Layout, Eco friendly office- 
Maintaining a Healthy and Safety Office 
Equipment, Protection of Health and 
Safety Of Employees, Safety Measures at 
Workplace.

Learning Objectives

•	 To comprehend the students 
about importance of Office 
Accommodation and Layout.

•	 To acquire knowledge and know 
the new trends in office layout.

•	 To understand the basic 
concepts related to Healthy 
and Safety measures at the 
workplace.

2.1 Introduction: 

Office accommodation refers to 
the selection of the appropriate office 
location, office building and other 
facilities required for office.  The office 
accommodation consists of following 
factors office location, office building, 

office layout, shape and size of office, 
convenience to the staff and visitors, 
physical condition of office, the cost of 
office accommodation etc.,

The following factors should be 
considered before making the final choice 
of location of office building:

(i)	 Suitability to Neighbourhood

(ii)	 Proximity to Other Units

(iii)	 Proximity to Related Business 

(iv)	 Nearness to service Facilities

(v)	 Nearness of Transport Facilities

Fig.2.1 Office Accommodation

2.2 Selection of Office Accommodation:

Following factors are to be 
considered in providing the right type of 
office accommodation:

1.	 Location of the office building
2.	 Securing the required office 

accommodation

OFFICE ACCOMMODATION AND LAYOUT

UNIT – 22
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Fig.2.2 Shared workspace

2.4 �Navigation IoT (Internet of Things) 
and Sensors:

The act or practice of navigating, the 
science of getting ships, aircraft or spacecraft 
from place to place especially.  The method 
of determining position, course and distance 
travelled. The purpose of navigation is 
to ascertain the present position and to 
determine the speed, direction etc., to arrive 
at the port or point of destination.

A smart office is a workplace 
incorporated with IoT technology in a 
bid to allow employees to work faster and 
more efficiently, while allowing them to 
have a better time doing so. Examples: 
There are several top devices in the market.  
Smart mobiles, smart refrigerators, smart 
watches, smart fire alarms, smart door 
locks, smart bicycles, medical sensors, 
fitness trackers, smart security systems 
etc., are few examples of IoT products.

Office sensors are indoor motion-
detecting devices that use infrared, 
ultrasonic, microwave or a similar 
technology to detect occupancy.  Sensors 
can turn any facility into a “smart” 
workplace that improves efficiency and 
well-being.   

3.	 Size of office accommodation

4.	 Lighting and ventilation facilities

5.	 Layout and facilities for office 
organization

6.	 Customer and staff conveniences

7.	 Cost of office space or 
accommodation

8.	 Miscellaneous consideration

Examples of Reasonable 
Accommodations in the Workplace:

Making existing facilities accessible; 
job restructuring; part-time or modified 
work schedules; Acquiring and modifying 
equipment, changing tests, training 
materials or policies, providing qualified 
readers and interpreters, reassignment to 
a vacant position

2.3 Shared Workspace:

Physically collaborative shared 
workspaces, also known as co-working 
spaces are, spaces that are created in an 
office that provide employees the ability 
to collaborate together and work more 
closely.

Need for the shared workspace:

Shared workspace enable you to 
grow your business and the number of 
employees they hire. They need not have 
to commit to inflexible leases in a more 
traditional building.  With a collaborative 
space, they have the freedom to change 
the size of their team or even location, 
without much effort or extra cost.  
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Fig.2.3 Navigation IoT and Sensors

2.5 Introduction of Office Layout:

According to Littlefield, “Office 
layout may be defined as the arrangement 
of equipment within the available floor 
space”.

According to, “The problem of 
layout relates to the arrangement in the 
space involved so that all the equipment, 
supplies, procedures and personnel can 
function at maximum efficiency”.

The object of an office layout is 
to make arrangements for placing of 
men, materials, machines, furniture and 
equipment within the available floor space 
of the office in such a way that everything 
can be utilized in the best possible manner.

An office layout involves:

(i)	 The determination of the cor-
rect amount of space for each 
employee and for machin-
ery and equipment they use.

(ii)	 The correct arrangement of fur-
niture, equipment and machinery.

(iii)	 The best possible environmental 
conditions. 

Need for the Office Layout:

•	 Be adaptable to meet volume changes

•	 Provide enough work and storage 
space

Principles of Good Office Layout:

•	 Layouts need to account for 
the physical environment and 
psychological needs of the 
organization.

•	 One key layout trade-off is between 
proximity and privacy.

Requirements of a Good Layout:

•	 An understanding of capacity and 
space requirements.

•	 Selection of appropriate material 
handling equipment.

•	 Decision regarding environment 
and aesthetics.

Fig.2.4 Office Layout

2.6 Recent Trends in Office Layout:

(i)	 Landscaped Office: A landscaped 
office is an open office where the 
desks are arranged individually or 
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2.7 �Maintaining a Healthy and Safety 
Office Equipment:

Office environment has an 
important bearing on the efficiency of 
employees.  It is a common experience that 
people work better if they are given the 
surroundings and equipment appropriate 
to their work.

According to Terry, “an individual’s 
performance is significantly familiarized 
by the environment in which he works”.

Lighting:

Lighting is the most important of 
all the physical conditions in the office. 
Proper lighting is important because it 
offers the following advantages:

•	 Increased productivity

•	 Better quality of work

•	 It results in fewer errors

•	 Reduction in eye strain and mental 
fatigue

•	 Better employee morale

•	 Quantity of Light 

•	 Brightness of Light

•	 Diffusion of Light

Ventilation:	
Ventilation in the office refers to 

the supply of clean and fresh air in the 
right amount, at the right temperature and 
of the right humidity. Proper ventilation 
is an important aspect of the office 

in groups and at different angles 
from one another.

(ii)	 Movable Partitions: Movable parti-
tions are now being used in setting 
up private offices. These partitions 
are made of metal, wood, plastic or 
glass.

(iii)	 Modular Units: Modular units are 
becoming increasingly popular now. 
These units normally consist of a 
combined desk and filing cabinet 
with small partitions up to a height 
of four to six feet. The most popular 
type of modular desk is the L pattern 
desk unit with a flat surface.

2.6.1 Eco-Friendly office:

Being an environmentally friend 
office simply means  having a lifestyle 
that is better for ecosystems and the 
environment. Environmentally friend 
office is also known as eco friendly office 
space, nature-friendly, and green, but 
ecologically approved doesn’t necessarily 
mean sustainable.

Fig.2.5 Eco-Friendly office 
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2.7.1 Protection of  Health and Safety of 
employees:
How do you maintain healthy and safety 
in workplace?

(i) Train employees well. 
(ii) Reward employees for safe behavior.
(iii) Partner with occupational 
clinicians. 
(iv) Use labels and signs.
(v) Keep things clean. 
(vi) Make sure employees have the 
right tools and have regular equipment 
inspections. 
(vii) Encourage stretch breaks. 

Fig.2.6 Pandemic Safety Guidelines

2.7.2 Safety Measures at Workplace:

One of the vital functions of a 
modern office is to keep and preserve 
documents and records for future 
guidance or reference. All documents 
or records of office should therefore be 
kept under proper security. The following 
precautions should be taken to secure 
documents and employees:

(i)	 Fire Precautions: Adequate fire 
precautions should be taken for the 
preservation of office records and 
documents, machines against risk 

environment. Fresh air must pass through 
the office regularly. Arrangements of 
rooms and partitions should be such as to 
allow free circulation of fresh and dustless 
air. The following methods are generally 
used to maintain proper ventilation:

(i) Natural Ventilation

(ii) Artificial Ventilation

Temperature and Humidity: Temperature 
and humidity are two vital factors in the 
offices that exercise a great influence over 
the worker and their output. Temperature 
and humidity in the rooms should be 
maintained at a proper level. 

Freedom from Noise:
A noisy place is never an efficient office. 
Noise is one of the great disturbances. 
Noiseless and quiet atmospheres are must 
for an office to maintain the efficiency of 
the employees at a high level. 

Cleanliness: A clean and tidy office 
is important as it offers the following 
advantages:

(i) It is healthier as a workplace for 
different types of office workers.

(ii) Since people react to their 
surroundings, a clean and healthy office 
contributes to accuracy and efficiency.

(iii) A clean and tidy office also projects a 
good image of the organization in the eyes 
of the people who visit it.

Disposal of Waste: Proper disposal of 
waste and waste paper is very essential.

Toilets: Proper provision of toilets and 
their proper cleanliness are important.
Toilets should be conveniently located 
with adequate numbers. 
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Fig.2.7 Safety Equipments

Fig.2.8 First Aid Kit 

Accidents and Emergencies:

An accident is an unplanned, 
uncontrolled or unforeseen event resulting 
in injury or harm to people and damages 
to goods.  For example, a person falling 
down and getting injured or a glassware 
item that broke upon being knocked over.  
Emergency is a serious or crisis situation 
that needs immediate attention and action. 

Workplace Safety:

Workplace safety refers to the 
working environment at a company and 
encompasses all factors that impact the 
safety, health and wellbeing of employees.  
Work environment is the basic right of 
every worker.

of loss or destruction by fire. Sim-
ilarly precautionary measures to 
safeguard the employees in the of-
fice should also be provided in the 
office. Fire alarms should be fixed in 
conspicuous places. Such appliances 
should be regularly inspected to en-
sure that they are in working order.

(ii)	 Accident Prevention: Most acci-
dents occur due to overcrowding in 
the office; use of obsolete machines 
and equipment, improper and care-
less handling of machines etc. Hence 
Adequate precautionary steps to 
prevent accidents should be taken in 
the office.

(iii)	 Provision of Safe Working Place: 
Arrangements should be made to 
provide a safe working place for 
the employees. Shape and size of 
the office rooms, location and size 
of doors, gangways, etc., must be 
such as to eliminate hazards of ac-
cidents.  

(iv)	 Provision of First Aid Service: To 
ensure immediate treatment to inju-
ries, there should be a first aid box 
in every office with sufficient med-
icines.

(v)	 Safety Education and Training of 
Employees: Each employee should 
be made thoroughly aware of the 
dangers of their job. Training 
should be given to employees and 
Safety regulations should be care-
fully framed and strictly enforced.
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Responsibilities of employer at workplace:

An employer should ensure a safe 
and healthy workplace for their employees 
and also for any customers who may visit 
the workplace.

Training to employees for prevent accidents 
and emergencies:

1.	 Individual roles and responsibilities

Points to be Remembered

Office accommodation refers to the place 
of work and its surroundings which are 
important that affect the efficiency of the 
employees to a large extent.

Principles of Office Accommodation:

•	 Convenient Location

•	 Sufficient space and scope for 
expansion.

•	 Provision for the convenience 
and amenities for the well-
being of the staff

•	 Service facilities should be 
available in the office and 
near the office premises.

Factors to be Considered While 
Selecting Office Accommodation:

•	 Locating the office building

•	 Securing the required office 
accommodation

•	 Size of office accommodation

•	 Lighting and ventilation of 
the space

•	  Layout and facilities for office 
organization

•	 Customer and staff 
conveniences

•	 Cost of office space or 
accommodation

•	 Miscellaneous considerations

The Need for Smart Office:

•	 Track maintenance with IoT printers

•	 Enable intelligent lighting with 
smart bulbs

•	 Use smart assistants for office 
awareness

•	 Replace custodians with smart 
vacuums

•	 Save on climate control with smart 
thermostats

•	 Track equipment with IoT tagging.

Office Layout:

Definition: arrangement of equipment 
within the available floor space

2.	 Threats, hazards and protective 
actions.

3.	 Notification, warning and 
communication procedures

4.	 Means for locating family members 
in an emergency

5.	 Emergency response procedures
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Evaluation

PART - A

OBJECTIVE TYPES:

I.	 Choose the Correct Answer: � (1 Mark)

1. 	 Arrangement of equipment within the available floor space is _________.

	 (a) Office Accommodation 	 (b) Office Layout 

	 (c) Office Environment 	 (d) Office Building� Ans (a)

2.	 Shared workspace also known as ___________.

	 a) Co-working Spaces 	 b) Private Space 

	 c) Public Space 	 d) Common Space� Ans (a)

3.	  ____________ must provide good and satisfactory working conditions.

	 a) Office Accommodation 	 b) Office Layout 

Principles of Good Office Layout:

•	 Layouts need to account for 
the physical environment and 
psychological needs of the 
organization.

•	 One key layout trade-off is 
between proximity and privacy

•	 Open concept offices promote 
understanding and trust

•	 Flexible layouts incorporating 
“Office landscaping” help to 
solve the privacy issue in open 
office environments.

How do you maintain healthy and safety 
in workplace:

•	 Train employees well.

•	 Reward employees for safe 
behavior.

•	 Partner with occupational 
clinicians.

•	 Use labels and signs.

•	 Keep things clean.

•	 Make sure employees 
have the right tools and 
have regular equipment 
inspections.

•	 Encourage stretch breaks.

•	 Implement safety protocols 
from the start.

•	 Evaluation
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	 c) Office Environment 	 d) Office Building� Ans (c)

4.	 A well planned layout brings a number of benefits to the office and to the 
__________.

	 a) Employees	 b) Outsiders 

	 c) Customers 	 d) Manager� Ans (a)

5.	 Air conditioner provides ____________.

	 a) Natural Ventilation 	 b) Artificial Ventilation 

	 c) Humidity 	 d) Air Circulation� Ans (b)

6.	 Environmentally friendly office is also known as  ______________.

	 a) Eco Friendly Office  	 b) Modular Office 

	 c) Open Office  	 d) Private Office� Ans (a)

7.	 Office environment is an important bearing on the ________________ of the 
employees.

	 a) Efficiency 	 b) Quality 

	 c) Work force 	 d) Performance� Ans (a)

8.	 Roof ventilation and internal tube ventilators provide ___________ventilation.

	 a) Natural 	 b) Artificial 

	 c) Direct 	 d) Indirect� Ans (a)

9.	 The ideal office temperature is approximately __________ Fahrenheit.

	 a) 58 degree 	 b) 68 degree 

	 c) 78 degree 	 d) 48 degree� Ans (b)

10.	 The cleaning work should be undertaken ______________the business hours in 
the office.

	 a) During 	 b) Before 

	 c) After 	 d) Either before or after� Ans (d)

 PART - B

II.	 Very Short Answers:� (3 Marks)

1.	 What is meant by office accommodation?

2.	 How do you select office accommodation?

3.	 What is a shared workspace?
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4.	 What is an IoT?

5.	 Give a note on smart offices.

6.	 What is the office layout?

7.	 Define the term office environment.

8.	 What is artificial ventilation?

9.	 How do you prevent accidents in the workplace?

10.	 What are safety measures?

 PART - C

III.	 Short Answers:� (5 Marks)

1. 	 What are the factors to be considered in choosing office accommodation?

2. 	 Bring out the recent trends in office.

3. 	 State the objectives and importance of office layout.

4.	 Explain the factors determining lighting System.

5.	 Describe the importance of maintaining cleanliness.

6.	 How do you maintain healthy and safety in the workplace? Explain

7.	 Discuss the general safety measures to be followed in office.

 PART - D

IV. 	 Essay Type Questions:							�        (10 Marks)

1.	 Write a note on Office Accommodation.

2.	 Explain the advantages and disadvantages of office layout.

3. 	 Explain in detail about office environment.
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Teachers Activity:

•	 Take students to an office and expose them about office accommodation, 
layout,  office environment & safety measures.

•	 Organize a debate amongst students on how office plays a vital role in the 
workplace?

Students Activity: 

•	 Visit an office and observe office layout, environment and safety measures 
provided.

•	 Prepare model of office layout in groups

ACTIVITY

References:

1. �Office Management – Kathiresan and Radha, Prasanna Publishers & Distributors, 
Chennai

2. �Office Management – R.K.Chopra, Himalaya Publishing House, New Delhi

3. Office Management Revised Edition – P K Ghosh, Sultan Chand Publishers, New Delhi

4. �Office Organization and Management Second Revised Edition – S P Arora, Vikas 
Publishing

House Pvt. Ltd, New Delhi

 

1. Amenities : A desirable or useful feature or facility of a building.

2. Cubicles : A very small enclosed area.

3. Diffusion of Light : Spreading of light.

4. Fluorescent : Fluorescence is the emission of light by a substance that has absorbed light 
or other electromagnetic radiation.

5. Humidity : A quantity representing the amount of water vapour in the atmosphere.

6. Incandescent : Producing a bright light from a heated filament.

7. Landscape : A landscape includes the physical elements of landforms and different forms 
of land use, buildings and structures.
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Content:

Introduction - Modern Office 
Furniture – Office Furniture, Fittings 
and Accessories - Selecting, Purchase 
Procedure and Methods of using Office 
Furniture - Uses of Office Furniture - 
Purchasing and Safeguarding the Assets 
- Introduction - Office Stationeries - 
Classification of Office Stationeries - 
Importance of Managing Stationeries - 
Selection and Purchasing of Stationeries 

Learning Objectives

•	 To know the various factors 
to be considered for selecting 
furniture.

•	 To enable the students 
to learn and understand 
the classification of office 
stationeries.

•	 To understand the factors have 
to be considered for selection 
and purchasing of stationeries.

3.1 �Introduction:

Furniture refers to movable 
objects intended to support various 
human activities such as seating, eating, 
storing items, eating and/or working 
with an item, and sleeping. Furniture is 
also used to hold objects at a convenient 

height for work or to store things. Office 
furniture means any furnishing that is free 
standing and does not require installation 
with component parts. Examples are 
desks, chairs, file cabinets, tables, lounge 
seating and computer desks.

(i)	 Modern Office Furniture: It 
sleek, clean and simple; it does not 
resemble the old traditional office 
furniture. Because of its simplic-
ity it makes the office space feel 
sleek instead of cluttered. In ear-
lier times weight of the furniture 
and its dull appearance was asso-
ciated with success mantras. Mod-
ern furniture can be described as 
furniture that is lightweight and is 
made up of a lot of steel and glass 
or wood. 

(ii)	 New Design Furniture: Modern 
furniture available in new mate-
rials, fabrics, new fabric designs, 
shapes and sizes. With the days go-
ing by rates of modern office fur-
niture are getting more and more 
economical, especially when pur-
chased in a large amount. It is very 
important for a business to project 
itself with the right image in front 
of their clients, customers and 
prospective employees. For this it 
is important that to do something 
creative for the office furniture ar-
rangements. 

MODERN OFFICE FURNITURES AND STATIONERIES

UNIT – 33
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basket, etc. When choosing or selecting 
such items, their colour may be considered, 
because the colour of these must not ruin 
the pleasing atmosphere of the office. 
Clerks should be provided with certain 
accessories in order to perform their work 
efficiently. Such items may be pen holders, 
sorting trays, boxes, cabinets, etc. 

Fig.3.1 Modern Office Furniture

Types of Furniture Used in Office:

Every office requires different types 
of furniture. Furniture can be classified 
on the basis of its physical appearance 
and the purpose for which it is used. 
E.g. Executive furniture, Special purpose 
furniture, Built-in furniture and General 
clerical furniture.

Desk:  The performance of an 
office  employee is very much influenced 
by the type of desk he uses. The primary 
function of any desk is to provide a suitable 
surface for writing, checking, sorting and 
examining. 

Executive Desk:  These are 
designed to suit individual tastes and quite 
often they are designed as a show piece of 
an organisation. Their purpose is also to 

(iii)	 Professionalism and Competence: 
The office furniture increases the 
confidence of employees. This can 
only be achieved by cheap, trendy, 
stylish and sleek modular office fur-
niture. Modern furniture is available 
in vast designs and shapes and so, it 
is suggested that when you are look-
ing to refurbish an office, you must 
select modern office furniture. 

(iv)	 Functionality and Flexibility: It 
incomparable with other types of 
furniture. Even comfort and safe-
ty features are much enhanced in 
comparison to the other types of 
furniture available. Some common 
items of modern office furniture 
are office chairs, executive chairs, 
office desks, conference table, exec-
utive table, manager’s tables, recep-
tion table, cabinets and executive 
collections. 

3.2 �Office Furniture, Fittings and 
Accessories:

Office furniture is necessarily a 
part of the total environment in which the 
employees work. Right kind of furniture 
must be provided so as to provide 
maximize comfort to the employee. 

The number and the type of 
furniture to be purchased for any 
office will depend on the number 
of departments and office workers, 
the nature and volume of work to be 
performed and the office space available 
for their accommodation.

Generally office fittings include 
desk lamp, telephone stand, waste paper 
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impress visitors. Sharp edges and corners 
are eliminated. Table top is covered with a 
sheet of glass.

General Purpose Desk:  It is a 
general purpose single pedestal desk with 
less elaborate design.

Computer Desk:  Computer desks 
are  generally standard flat-topped, single 
or double pedestal desk with provision for 
placing keyboard.

Tables: Tables are generally needed 
for  sorting of mail despatch, for holding 
meeting of committees, etc. However, in 
some office tables fitted with drawers and 
other devices are still used by clerks for 
writing purposes.

Chairs:  There is a need for 
providing  the right type of chairs to the 
office employees as they spend most part 
of the day in the office. Chairs meant 
for computer operators should have 
adjustable back rest to enable the user to 
perform their work efficiently.

Filing Cabinet: A filing cabinet is 
a piece of office furniture usually used to 
store paper documents in file folders. The 
two most common forms of filing cabinets 
are vertical files and lateral files. A vertical 
file cabinet has drawers that extend from 
the short side of the cabinet. A lateral file 
cabinet has drawers that extend from the 
long side of the cabinet.

Modular Furniture:  Modular 
furniture is  pre-made or readymade 
furniture which can be used according to the 
need and room spacing. It is easy to install 
and dismantle according to need. It gives a 
modern look to the office. It is also available 
in various colours and designs. There are 
various types of modular furniture-Two in 
one furniture. This type of furniture has two 
purposes. Three in one furniture. This type 
of furniture has three purposes.

3.2.1 �Selecting, Purchase Procedure and  
Methods of using Office Furniture:

Buying office furniture can be 
hard because it is so difficult to find the 

Fig.3.2 General Purpose Desk (Office Chairs and Tables)
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include features such as adjustable arm, 
head, and backrests. Investing in furniture 
that can be adjusted to the specifications 
of your employees can help keep everyone 
in the office comfortable and focused on 
their work.

Warranty:

Office furniture is a substantial 
investment, and you want to be sure that 
dependable warranties are provided to 
the furniture. This will ensure that if 
you experience an issue with your office 
furniture, you’ll be able to have it dealt 
with quickly and at a reasonable cost.

Impact on Employee Wellness:

The right office furniture can 
greatly impact the lives of employees. 
Several studies have found that choosing 
office furniture that is both comfortable 
and ergonomically considered can 
have a noteworthy impact on employee 
happiness, as well as their productivity.

Multi-functionality:

Many desks are designed 
primarily to function as single employee 
workstations, but can easily be transformed 
into collaborative hubs. Similarly,  tables 
can be designed to move around the 
office as they’re needed, making them 
perfect for in-house presentations, 
training programs, strategy sessions in the 
boardroom, and much more.

Brand Reputation:

When choosing office furniture, it 
is essential to work with a brand that has 
earned a reputation as a leader. Always

information you need, upfront, before 
being pulled into a consultation with a 
salesperson. Depending on your situation, 
there are many different factors to keep in 
mind when choosing the office furniture. 
The list of potential factors considered for 
selection is as follows:

Aesthetics:

The look of your workplace can 
play a critical role in the success of your 
company. Studies have shown that an 
aesthetically pleasing office can help 
with attracting and retaining top talent. 

Ergonomics:

The science of designing a workplace 
with the abilities and needs of the  employees 
in mind, also known as ergonomics, should 
be factored into every piece of office 
furniture you purchase.

From footrests to adjustable 
monitor arms or chairs that properly 
support the lower backs of your employees, 
ergonomics can have a significant impact 
on the productivity, health, and happiness 
of team members.  Choosing office 
furniture built with ergonomics in mind 
is essential for any efficient workplace.

Adjustability and Flexibility:

Employees come in all different 
shapes and sizes, which is why the office 
furniture you choose needs to have the 
flexibility required to meet their individual 
needs. Many desks and table solutions are 
height adjustable to ensure employees can 
be productive while maintaining proper 
posture. Likewise, the office chairs should 
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to the furniture supplied company and it 
will be resolved.

3.2.2 Uses of Office Furniture:

•	 It increases the efficiency of work

•	 It makes the office more attractive 
and pleasant.

•	 It helps to maintain the prestige of 
office

•	 It provides better working 
environment for the employees

•	 It helps in reducing fatigue.

•	 It helps in protection of documents 
from fire, dust, insects etc.

•	 It helps in proper storage of files

3.3 �Purchasing and Safeguarding the 
Assets:

Many business owners are 
discovering that their assets are not as 
well protected as they thought.   Smaller 
businesses with one or two employees 
managing all of the finances are particularly 
susceptible to misappropriation of 
assets.   Often there are no checks and 
balances to verify that transactions are 
accurate or appropriate.

 choose products from office furniture 
brands who are all known for using 
quality building materials and are 
committed to deliver the best furniture in 
an environmentally responsible way.

Office Furniture Purchase Procedure:

The process of buying office furniture  is 
based on key stages: 

(i)	 Searching: The purchase team of the 
company will first search for various 
vendors who provide good office 
furniture at low cost.

(ii)	 Identification: In this stage the pur-
chase team will identify the best furni-
ture supplying company based on their 
reputation, company brand image , 
their overall sales , market share and 
other company feedback.

(iii)	 Placing Order: In this stage the list 
of required furniture is created and 
order is placed to the selected furni-
ture company.

(iv)	 Payment: Once furniture is received 
payment is made to the furniture 
company.

(v)	 Put to use: The furniture is put to use by 
the various employees for their work and 
any problems faced will be complained 

Fig.3.3 On-line purchase
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have a regular maintenance schedule 
to keep them in steady proper working 
conditions. Even employees also 
need vacations, annual assessments, 
and other routines to maintain high 
productivity and efficiency.

Intellectual Property Protection:
Brand recognition and reputation, 
for instance, go a long way in 
determining the competitive edge 
and even volume of sales. It can 
employ professional legal services 
to help guard against intellectual 
thefts or copyright infringements.

Physical, Digital, and Data Security: 
Employ a viable security team or 
contract a security company can 
protect all physical properties. The use 
of security cameras can also help you 
monitor activities around company 
environment right from the comfort 
of an office. Also use vehicle tracking 
systems to monitor company vehicles 
or even recover stolen machinery. 

3.4 Introduction - Office Stationeries:

Stationery refers to commercially 
manufactured writing materials, including 
cut papers, envelopes, writing implements, 
continuous form papers, and other office 
supplies. Stationery includes materials to be 
written on by hand (e.g., letter paper) or by 
equipment such as computer printers.

3.4.1 Classification of Office Stationeries:

•	 Business Stationery: Business card, 
letterhead, invoices, receipts

•	 Desktop instruments: hole punch, 

How to Safeguard the Assets: 
Different assets have different kinds of 
risks associated with them. Since the 
goal is to prevent or at least minimize 
those risks, different measures can 
help safeguard the assets.

Proper Documentation and Monitoring:
It must keep all records of the assets 
and track the activities associated with 
it. For example, maintaining accurate 
inventory records can help to trace 
any missing or stolen goods. Regular 
machinery checks can also helps to 
notice faults or potential damage risks 
more easily and fix them before they 
result in any serious harm.

Insurance: 
Physical assets are susceptible to 
dangers such as robbery, fire outbreaks, 
and other environmental hazards. So, 
there is a need to get good insurance 
coverage for vehicles, buildings, and 
other tangible assets. Thats’ way, don’t 
have to worry much about repairing 
or replacing them.

Regular Maintenance: 
Machinery can wear and tear with 
time and consistent usage. It need to 

Fig.3.4 Uses of Office Furniture 
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stapler and  staples, tapes and tape 
dispensers.

•	 Drawing instruments: brushes, 
colour pencils, crayons,  water 
colour.

•	 Erasers.

•	 Ink and toner:

•	 Dot matrix printer’s ink ribbon

•	 Inkjet cartridge

•	 Laser printer toner

•	 Photocopier toner

•	 Filing and storage:

•	 Expandable file

•	 File folder

•	 Hanging file folder

•	 Index cards and files

•	 Two-pocket portfolios

•	 Mailing and shipping supplies:

•	 Envelope

•	 Paper and pad:

•	 Notebooks, wire bound notebook, 
writing pads, college ruled paper, 
wide-ruled paper.

Fig.3.5 Classification of Office Stationeries 
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•	 Office paper:  Dot matrix paper, 
Inkjet printer paper, Laser printer 
paper, Photocopy paper.

•	 Writing instruments: ballpoint 
pen,  fountain pen, pencil,  porous 
point pen,  rollerball pen, 
highlighter pen.

3.4.2 �Importance of Managing 
Stationeries:

Fig.3.6 Importance of Stationeries

(i)	 Productivity: Having the right 
office supplies is essential for 
the day to day running of the 
business. Objects such as  pens,  
pencils, paper, calculators and other 
office equipment such as  printers, 
need to be available for employees 
to work productively and efficiently.

(ii)	 Quality and comfort: When looking 
for items, make sure that they are fit 
for the job and that they are of a quality 
and comfort. For example a company 
sends lot of internal mail provide the 
type of envelopes need, or if staff are 
often on the phone call provide the 
right type of notepad to them.

(iii)	 Operations department: From the 
basic  pen,  highlighter  and  pencil  to 
more complex items such as  binding 
machines, data storage and projectors – 
the operations department of the 
company should ensure that the office 
will have everything it need, whilst 
ensuring the price is just right.

3.4.3 �Selection and Purchasing of 
Stationeries:

Certain factors have to be 
considered for selection of quality 
stationery items to the office as follows:

Standard – Proper criteria for standard has 
to be followed while selecting stationery 
and popular brands can be identified in 
this regard by concerned departments. 

Suitability – Stationery items have to be 
purchased according to the preferences of 
concerned departments  
like for accounts, ledgers, and register 
books, are needed.
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Durability – Cheaper quality standards 
should not be taken into consideration 
while purchasing stationery items as 
they do not guarantee durability. Hence, 
superior quality products should be taken 
care of.

Goodwill – To create a best impression on 
the organisation, items with proper and 
catchy headings are selected. 

Performance – The purchasing authority 
should consider the quality of stationery 
items they purchase as a specific brand 
gives longer performance and satisfaction.

Preservation – Multiple copies can be 
taken with the help of quality carbon sheets 
and hence carbon papers are preserved for 
future purpose in offices. 

Quality – Cheaper quality stationery items 
are short-lived and hence may create loss 
and tampering while handling by specific 
departments. Hence, superior quality 
which may be little expensive should be 
purchased in order to save time and cost.

Purchasing Stationery:

The office manager has to purchase 
the stationery if the business office is 
very small. In the case of large business 
organizations, a separate department is 
created to buy all the stationary items. 
Hence, the department’s manager must 
have a good knowledge of purchasing 
quality stationery in an economical way. 

(a) �Receipt of purchase requisition, which 
is a request of purchase from the 
required departments.

(b) �After receipt of requisition the amount 
of stationery to be purchased is 
determined.

(c) The sources of supply are selected.

(d) Placing order for supply of stationary.

(e) �Taking follow-up measures when supplies 
are not received in the proper time.

(f) �Receipt of supplies and checking their 
quality as per the standards set.

Points to be Remembered

•	 Office furniture  means any 
furnishing that is free standing 
and does not require installation 
with component parts.

•	 Modern office furniture is sleek, 
clean and simple.

•	 Professionalism and competence 
of the office increases confidence 
of office employees.

•	 Physical assets are susceptible 
to dangers such as robbery, 
fire outbreaks and other 
environmental hazards.
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Evaluation

PART – A

OBJECTIVE TYPES:

1.	 Choose the Correct Answer :� (1 Mark)

1.	 __________________________ makes office space feels sleek instead of cluttered

	 a. Simplicity  	 b. Requirement 

	 c. Classification	 d. Clarity � Ans. (a)

2. 	 Furniture can be classified on the basis of ______________________________ 
appearance.

	 a. Company 	 b. Physical 

	 c. Individual 	 d. Group� Ans. (b)

3. 	 ______________________ are designed to suit individual tastes

	 a. General purpose 	 b. Meeting

	 c. Executive	 d. Computer � Ans (c)

4. 	 Modular furniture is ______________________ furniture

	 a. Popular	 b Cheapest

	 c. Highly risk 	 d. Ready-made� Ans (d)

5. 	 The science of designing a workplace is known as __________________

	 a. Ergonomics  	 b. Office

	 c. Department 	 d. Enterprise� Ans (a)

6. 	 Office furniture is a ______________________ investment.

	 a  Systematic 	 b Strong 

	 c Substantial	 d Natural � Ans (c)

7. 	 _______________________ to create a best impression on the organisation

	 a. Good will  	 b. Information  

	 c. Functions 	 d. Administration � Ans (a)

8. 	 Office furniture is necessary a part of the total environment in which the 
_______________________ work.

	 a Employer 	 b. Employees 

	 c. Owner	 d. Worker.� Ans (b)
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9. 	 The use of Security cameras can ___________________________ activities

	 a Supervise	 b. Check 

	 c. Evaluate	 d. Monitor� Ans. (d)

10.	 _________________________ is essential for the day to day bus

	 a  Office Supplies 	 b. Office Stationeries 

	 c. Office Furniture   	 d. Office Accommodation� Ans. (a)

PART – B

II.	 Very Short Answers:� ( 3 Marks)

1.	 	 Write a short note on modern office furniture.

2.	 	 What is new furniture design?

3.	 	 What is meant by modular furniture?

4.	 	 What is intellectual property protection?

5.	 	 Write a short note on office stationeries

PART – C

III. 	 Short Answers:�  ( 5 Marks)

1.	 	 Explain the classification of office stationeries.

2.	 	 Explain the importance of managing stationary.

3.	 	 What are the uses of office furniture?

Part – D

IV. 	 Essay Type Questions:							�        (10 Marks)

1.	 	 Explain the types of furniture used in the office.

2.	 	 Explain the selection and purchasing of stationeries
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Teachers Activity :

1.	 Must teach basic concepts about office furniture

2.	 Can take the students to a nearby office to show various modern furniture used in the 
office.

Students Activity :

1.	 Students can be asked to prepare assignments on modern office furniture and their 
usage.

2.	 Students can be asked to prepare models on office furniture.

ACTIVITY

References :
1. http://www.themob.com.tr/office/furniture.

2. http://www.india.com/furniture/office/values.

3. www.pinterest.com

1.  Modular : Employing or involving a module or modules as the basis 
of design or construction.

2.  Sleek : Make smooth and glossy.

3.  Filing Cabinet : It is a piece of office furniture usually used to store paper documents in file 
folders .

4. Multi-functionality : Many desks are designed Primarily to function as single employee work 

stations.
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Content:

Introduction - Meaning of Records 
- Types of Records - Records Management 
- Introduction - Filing - Classifications 
of Filing - Uses of Filing - Introduction - 
Indexing - Types of Indexing - Selection 
of Suitable Indexing System - Advantages 
of Indexing

Learning Objectives

•	 To know the importance of 
records for day to day business 
activities and its functions.

•	 To analyse the principles of 
maintaining records.

•	 To understand the types of 
filing and classification of files.

•	 To know about the essence of 
indexing and its advantages.

4.1 Introduction:

Business enterprises, government 
agencies, and other social institutions all 
depend on records to function. Any firm 
highly depends on accurate reporting. 
The record-keeping system should be 
accurate, consistent, simple to use, and 
consistent in terms of the principles 
employed. Good record keeping is 
essential for satisfying the firm’s financial 

obligations and providing information on 
which to build future business operations. 
While businesses maintain records to 
monitor and document typical company 
activity, they are also required under taxes 
regulations. These documents are official 
documents that can also be used as legal 
proof in the event of an emergency.

Many documents are received, sent 
out, and prepared on a daily basis in the 
course of business. These documents are 
important in the functioning  a firm and 
in making decisions. Such documents 
should be kept on hand to make sure 
they are required. Every organization has 
developed a file system to do this. Any 
organization’s memory is its filing system.

4.1.1 Meaning of Records:

Fig.4.1 Office Records 

A document used by an organisation 
to carry out its different tasks is referred 
to as a record. A record is some form of 
physical evidence of an organization’s 

RECORDS, FILING AND INDEXING

UNIT – 44
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into any of the previous categories, such 
as records pertaining to advertising 
campaigns and marketing research.

4.1.3 Records Management:

Meaning:  Records management is a 
modern business program that embraces 
filing and is improved by the design and 
review of business forms and records. It 
is that area of office administration which 
is concerned with creation, presentation, 
and use and disposal of records.
Definition: According to Jane K Crucible 
“Records management refers to the 
activities designed to control the lifecycle 
of a record from its creation to its ultimate 
disposition”

Functions:

1. Creation of Records: New forms and 
records should be developed only when 
their need is fully satisfied. The design of 
the forms should be given careful utilized 
by an organization to carry out its various 
functions. 

2. Storage of Records: The storage is 
concerned with the classification of 
records and then filing in the suitable 
filing equipment which is in the easily 
accessible location. 

3. Retrieval of Records: An efficient 
procedure must be established so that 
records may be retrieved and delivered in 
time. 

4. Disposal of Records: The last stage in 
the record cycle is the disposal stage which 
is concerned with preserving valuable 
documents and disposing the expired 
documents. 

activity. It could be a letter, circular, 
invoice, voucher, image, report, payroll, 
contracts, deeds, work in progress, orders, 
stock records, estimates, progress reports, 
financial and statistical statements.

4.1.2 Types of Records:

1. Correspondence: Correspondence 
includes letters, notices, circulars, 
memorandums, reports and other items 
that the business receives, as well as copies 
of letters that are sent out. Telegrams and 
fax communications are also included.

2. Accounts Department Records: All 
papers or documents pertaining to the 
firm’s accounts are included in this category. 
Invoices, petty cash vouchers, receipts, 
bank statements, accounting ledgers, and 
other documents are examples.

3. Purchases and Sales Records: These 
comprise all documents related to the 
firm’s purchases, sales, and inventory 
management, such as price lists, quotes, 
samples and copy orders.

4. Personal Records: These contain all 
documents relating to the firm’s workers, 
such as completed application forms and 
records of employee attitude, absenteeism 
and turnover.

5. Administrative Records: Insurance 
policies, car registration books, licences, 
hire purchase agreements, share 
certificates, and other records that are 
important for the management of the 
company, either because of legislative 
obligations or otherwise.

6. Miscellaneous Records: Modern 
businesses keep records that do not fit 
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Objectives of Record Management:

Leffingwell and Robinson 
were identified the objectives of record 
management, which as follows:

1. To keep an orderly account of progress

2. To facilitate comparison

3. To deduct errors and wastes

4. To follow up the legal formalities

Conclusion:

As a result, filing is the act of 
keeping official documents in a systematic 
and scientific manner for future reference 
or evidence. It includes filing documents, 
letters, and other correspondence. It is 
a scientific and systematic method of 
maintaining important documents for 
future access.

4.2 Filing:

Meaning: Filing can be described as the 
core of records management. It is rightly 
said that the keystone of office organization 
is the maintenance of a comprehensive, 
simple and efficient filing system. Filing 
cannot be treated as an unimportant 
function of the office, perhaps it is the 
most important amongst its functions.

Definition: G.R Terry has defined filing 
as “the placing of documents and papers 
in acceptable containers according to 
some predetermined arrangement so that 
any of these may be located quickly and 
conveniently, when required”.

Organization of Filing: In any large 
business establishment, the management 
has to decide whether filing should be 

centralized. The main object of filing is 
speedy and accurate location of records at 
minimum cost.

1. Centralized Filing:

Centralized filing of records refers 
to graphing and storing of records in 
the same place where they are accessible 
to a number of persons. In other words, 
the records pertaining to activities of 
all the departments of an enterprise are 
preserved in the centralized index plan. 
Central file comprises papers relating to 
general correspondence, office branch 
correspondence, orders, invoice, vouchers, 
estimate, quotations, credit and debit 
memos and other papers which several 
departments need to refer.

2. Decentralized Filing:

Fig.4.2 File Cabin

In this system, files relating to 
different departments are kept in the 
respective departments. Decentralized 
filing is necessary for maintaining records 
of work-in-progress, such as unexecuted 
orders, unpaid bills etc. Further there are 
certain records which will be used only 
by certain departments, for e.g. Price 
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2. Numerical Classification: In this 
method of classification, each folder or 
record is given a number, and the files are 
placed in strict numerical order. 

3. Geographical Classification: As the 
name implies, this classification is based 
on the geographical origin of a document 
or paper. This system is combined with 
one of the two systems already discussed. 
The classification can be town-wise, 
district-wise, state wise, country-wise and 
continent-wise. 

4. Subject Classification: It is a method 
of classification in which all documents 
relating to a subject are brought together 
in one file, even though they may have 
come from different sources and from 
many different people. 

Fig.4.3 Online Files and Offline Files 

quotation in the purchase department, 
blueprints and drawings in the engineering 
department. 

Types of Filing:

The important types or methods of 
modern filing are:

1. Horizontal or Flat Filing: Under this 
method the documents or letters are placed 
in a horizontal or flat position one on the 
top of another in order of date and the latest 
is on the top. The letters are filed along with 
their replies. These files come in a variety of 
folders. More important of horizontal files 
are Lever Arch Files and Flat Files.

2. Vertical Filing: This method of filing 
can be said to be the most modern. It 
is so named because the contents are 
kept in an upright or standing position. 
This method of filing is the result of the 
growing needs of business organizations. 
The greatest drawback of the horizontal 
filing is the time consumed in locating 
a paper or document. As the business 
expands the bulk of papers increases and 
location of a paper becomes difficult and 
time consuming activity, vertical filing 
eliminates this drawback of horizontal 
filing. Hence it has become a very popular 
method of filing in large offices where the 
number of subjects is large.

4.2.1 Classification of Files:

There are five methods of classification. 
They are:

1. Alphabetical Classification: 
Alphabetical classification is based on the 
occurrence of the letters in the alphabet as 
it is done for the dictionary.
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located easily and quickly whenever they 
are needed. Indexing thus adds to the 
efficiency of the filing method. It ensures 
speed and consequently economy results 
due to increased speed. The objective of 
indexing is best achieved where the right 
type of indexing system is chosen. 

Fig.4.4 File Indexing 

Essentials of a Good system of Indexing:

In order to achieve its objectives, a 
good system of indexing should have the 
following essential features;

5. Chronological Classification: Under this 
method various records are identified and 
arranged in strict date order and sometimes 
even according to the time of the day. It is a 
useful method for filing invoices and other 
vouchers associated with accounts.

4.2.2 Uses of Filing:

Records are stored under a suitable system 
of filing in order to achieve the following 
purposes and benefits.

•	 Ready reference

•	 Safety of records

•	 Documentary proof

•	 Prompt handling of 
correspondence

•	 Statutory requirements

•	 Barometer of progress

•	 Decision making and policy 
formulation

•	 Increased efficiency

4.3 Introduction - Indexing :

Meaning:

Index is anything that “points out” or indicates. 
Indexing can be described as a method of 
providing indicators for a body of data or 
collection of records. The term ``indexing” 
should not be confused with the term 
“classification”. Classification is the method of 
filing while indexing is basically the method 
used for making reference to the matter filed.

Objectives of Indexing:

The principal objective of indexing 
is to assist filing so that filed papers are 
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divided into alphabetical sections where 
the names of persons are entered. Each 
section has the leaves cut away at the 
right hand side so that the initial letters 
of all the sections are visible at a glance. 
The book index is very cheap and is a 
good long term record. 

ii. Loose leaf Book Index (or) Vertical 
Card Index: Loose sheets are used for 
indexing and the fastened are metal 
rings or hinges or some other device 
which allows the pages to be taken out 
and also helps in insertion of additional 
pages. This type of index is also fitted 
with a lock. 

iii. Vowel Indexing: In cases where 
the number of correspondents is very 
large the alphabetical indexing is 
further classified. The names of the 
correspondents are entered on one page 
or the other according to the letter with 
which his name begins and first vowel in 
his name. This sort of indexing is known 
as “Vowel Indexing”. E.g. Ashika the 
first vowel in the name is “I”. It will be 
classified under “Ai”

(b) Card Index: Under this method 
references are entered on the cards of 
uniform size. These cards bear the names, 
number of the files and other particulars 
to be indexed. Cards are arranged in 
either alphabetical or numerical order 
and are placed in drawers or boxes which 
may have a rod running from one ending 
to the other end for holding cards in their 
places. 

(c) Visible Index: The major defect of card 
indexing is that a large number of cards 
cannot be seen at one glance. This defect is 

1. It should be simple.

2. It should be economical in operation.

3. It should allow for speed.

4. It should go well with the system of filing in 
the organization.

5. It should be flexible to allow for expansion 
when needed.

4.3.1 Types of Indexing 

Indexing may be classified into the 
following main categories, namely: 

(a) Page Index; 

(b) Card Index and 

(c) Visible Index.

(a) Page or Book Index: This system is 
also known as alphabetical indexing as 
classification is based on the letters of the 
alphabet. One page or leaf is allotted for 
each letter of the alphabet, fitted with a tab 
showing the letter and quoting the relevant 
page numbers. The pages may be held in a 
loose form or in a bound book form. Each 
page consists of a list of all the correspondents 
whose names begin with the letter to which 
that page or sheet is allotted. For example, 
all names beginning with the letter ‘A’ like 
Anuradha, Aruna, Akila will be written on 
the page allocated to the letter ‘A’. The folder 
number of correspondents relating to a 
particular person will appear against his/ her 
name. Page Index is divided into three forms

(1) Bound Book Index 

(2) Loose Leaf Book Index and 

(3) Vowel Index.

i. Bound Book Index: It is in the form 
of a bound book or register which is 
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overcome by visible indexing under which 
a large number of cards are visible at one 
glance. Visible card index, strip index and 
wheel index are the systems of visible in-
dexing.

1. Visible Card Index: Visible card index 
system has gained more popularity in 
recent years. It is based on the principle 
“look at the card, not for it”. Visible 
card indexing can be used for retaining 
records such as accounts receivable, 
personal history of employees and 
specimen signatures of customers in a 
fairly permanent position for frequent 
reference. The speed in which the cards 
can be located and the necessary entries 
made, justifies the use and cost of visible 
card filing equipment.

2. Strip Index: It is a type of visible 
indexing which is used when the entries 
are limited to a few lines (names, 
addresses, etc.,) It consists of a frame into 
which strips of stiff paper can be fixed in 
any required order. Frames containing 
these strips may be either fixed on the 
wall or arranged on a rotary stand which 
can be turned round to look at any part of 
the index.

3. Wheel Index: It is an improvement over 
visible card index. Cards are arranged 
about the circumference of the wheel. A 
single wheel can hold as many as 1000 
cards. Cards can be inserted into or taken 
out of the slits of the metal rod whenever 
needed. An entry can be made on the card 
by applying the brakes to keep the wheel 
fixed.

4.3.2 �Selection of a Suitable Indexing 
System: 

Every system of indexing has its own 
merits and demerits. Some methods are 
rigid while others are flexible and expensive. 
The installation of a suitable indexing system 
depends mainly on the following factors.

•	 The type and extent of 
information needed.

•	 The cost of equipment in each 
system.

•	 The cost of labour in each 
system.

•	 The space required for each 
system.

•	 The frequency of adding or 
deleting.

4.3.3 Advantages of Indexing:

1. Easy Location: The required papers 
and documents are located very easily 
with the help of their index. Referencing 
is not a painful process.

2. Easy Cross-Referencing: A good 
system of indexing also ensures easy 
cross-referencing and thus saves on time 
and botheration.

3. Lower Costs: The operating costs of 
records administration are also low due 
to improved efficiency of the records 
administration. Time is not wasted in 
locating the necessary documents or 
papers.
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Points to be Remembered

•	 A document used by an organization 
to carry out its different tasks is 
referred to as a record.

•	 Types of Record : Correspondence, 
Account Department Records, 
Purchases and Sales Records, 
Personal Records, Administrative 
Records & Miscellaneous Records.

•	 Records Management is defined 
by Jane K. Crucible, “It refers to 
the activities designed to control 
the lifecycle of a record from its 
creation to its ultimate disposition”.

Functions of Records Management :

•	 Creation of Records, Storage of 
Records, Retrieval of Record and 
Disposal of Record.

•	 Filing can be described as the core 
of records management.

•	 Organization  of  Filings : Centralized 
Filing and Decentralized Filing.

•	 Types of Filing : Horizontal or flat 
filing and vertical filing.

•	 Classification of Filing : Alphabetical, 
Numerical, Geographical, subject and 
chronological classification of filing.

•	 Indexing can be described as a method 
of providing indicators for a body of 
data or collection of records.

•	 Indexing may be classified into 
main categories. Such as,

a.  Page Index

b.  Card Index

c.  Visible Index

•	 Advantages of Indexing: Easy 
Location, Easy Cross – Referencing 
and Lower costs.

Evaluation

PART – A

OBJECTIVE TYPES:

I.	 Choose the Correct Answer:							       (1 Mark)

1. 	 Records of employee attitude belong to the __________________________ type 
of Record.

	 a. Accounts Department   	 b. Personal 

	 c. Administrative   	 d. Purchase and Sales� Ans (b)
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2.	 A modern business program that embraces filing and is improved by the design 
and review of business forms and records is known as _____________________

	 a. Indexing    	 b. Filing  

	 c. Record Keeping 	 d. Records Management� Ans (d) 

3.	 The ___________________________ stage which is concerned with preserving 
valuable documents and disposing the expired documents.

	 a. Disposal 	 b. Storage 

	 c. Creation 	 d. Retrieval� Ans (a)

4.	  ___________________ can be described as the core of Records Management.

	 a. Indexing 	 b. Filing

	 c. Records 	 d. Vowel indexing� Ans (b)

5.	  _____________________ Filing is a very popular method of filing in large offices 
where number of subjects is large.

	 a.  Horizontal	 b. Flat 

	  c. Vertical 	 d. Centralized.� Ans (c)

6. 	 There are _____________________________ methods of classification of files.

	 a.  4	 b. 3  

	 c. 5	 d. 6� Ans (c) 

7.	 ________________________ can be described as a method of providing indicators 
for a body of data or collection of Records.

	 a.  Records 	 b. Indexing 

	 c. Filing  	 d. Record Management.� Ans (b)

8.	 _______________________ index is not classified under page Index.

	 a.  Bound Book 	 b. Loose Leaf Book

	 c. Vowel 	 d. Visible� Ans (d)

9.	 Records Management refers to the activities designed to control the life 
cycle of a record from its creation to its ultimate disposition is defined by 
__________________________

	 a. Jane K Crucible	 b. G.R. Terry

	 c. Denyer 	 d. Letting well and Robinson� Ans (a)
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10.	 ________________________ is referred as a document used by an organization 
to carry out its different tasks.

	 a. Filing	 b. Record

	 c. Indexing	 d. Personal Record.� Ans (b)

 PART – B

II.	 Very Short Answers:� ( 3 Marks)

1.	 	 What are the types of records ?

2.	 	 Define records management.

3.	 	 What is decentralized filing ?

4.	 	 What are the essential features of indexing ?

5.	 	 What is a visible card index?

6.	 	 What is meant by filing ?

7.	 	 Define the term filing.

PART - C

III.	 Short Answers:� ( 5 Marks)

1.	 	 Explain the types of records

2.	 	 What are the differences between centralized and decentralized filing ?

3.	 	 What are the advantages of indexing ?

4.	 	 What are the types of filing ?

PART - D

IV.	  Essay Type Questions:�      (10 Marks)

1.	 Elaborate the term records management.

2.	 Explain the types of indexing.
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Teachers Activity:

•	 Ask the students to file all their test papers and prepare an index of the same.

•	 Ask the students to submit the assignment on various filing systems and indexing 
methods followed in offices by referring to the net.

Students Activity: 

•	 Download the materials regarding various filing and indexing systems followed in 
offices and submit the assignment on the same.

ACTIVITY

 Reference :
1. https://www.document-logistics.com
2. https://kullabs.com
3. https://myeglearning.com
 

1. �Chronological : (of a record of events ) following the order   
in which they occurred.

2. Horizontal filing : A technique to store documents horizontally.
3. Alphabetical – based on the occurrence of the letters in the alphabet.
4. Retrieval – The process of getting something back from somewhere.
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Content:

Introduction to Office Management 
Software -Various Functions of Office 
Management Software-Introduction to 
Cloud Computing-Activity based Working-
Bring Your Own Device (BYOD) and its 
Concepts.

Learning Objectives

•	 To comprehend the students 
about the importance of Office 
Management Software.

•	 To acquire knowledge about 
Activity based working by using 
office tools.

•	 To understand the basic concepts 
related to own devices that can 
be used to office management.

5.1 �Introduction

The most common software 
currently being used for office work 
is word processing software like Microsoft 
Word, spreadsheet software like Microsoft 
Excel, and presentation software like 
Microsoft PowerPoint.

Office Tools

MS-PowerPoint: 
Retail Cross-Platform presentation 

tool/ Lotus Freelance: proprietary software 

presentation tool. Google Slides: Freeware 
Cloud Based presentation tool. LibreOffice 
Impress: Open Source presentation tool.

Office Tools are a type of application 
software. They help the users to perform 
office-related tasks easily and efficiently. 
Therefore, these tools help to create, 
manage, and manipulate large amounts of 
data and documents. Moreover, they help 
create presentations, reports, databases, etc.

Meaning of Office Management Software

Office management software gives 
us much-needed storage space. By using 
office management software  to scan the   
existing business documents and store 
them on the  desktop computers or in the 
cloud, we’ll get rid of file cabinets and the 
stacks of paper that are taking up precious 
space in your facility.

Management Software:

Management software is that which 
is  designed to streamline and automate 
management processes in order  to lessen 
the complexity. Many other projects and 
tasks, trying  to  encourage or facilitate 
team cooperation, collaboration and 
proper project reporting.

5.2 �Various Functions of Office 
Management Software

E-�Office Management system in PHP 
(Hypertext Preprocessor)

OFFICE MANAGEMENT SOFTWARE

UNIT – 55
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Advantages of Office Management 
Software

1.	 Collaboration

2.	 Sharing resources

3.	 Cost and time

4.	 Flexibility and automation

5.	 Report preparations

Disadvantages of Office Management 
Software

1.	 Unnecessary investment

2.	 Difficult to adapt

3.	 Vulnerability

4.	 Added complexity

5.	 Software dependency

5.2 Office Management Software
5.2.1 Application of Office Management 
Software
Top free software for small businesses

•	 Wix – Best free software for 
creating websites

•	 Mailer lite – Best free 
software for email marketing

Fig.5.1 Office Management Software

•	 Office management

•	 Employee manager

•	 Attendance system

•	 Leave application manager

•	 Payroll

•	 Accounts management

•	 Transactions

•	 Employee portal

Key Benefits of Using Task Management 
Software

(i)	 Managing everything from a 
single place

(ii)	 Make task prioritization easier

(iii)	 Access data from anywhere time

(iv)	 Keep an eye across all tasks

(v)	 Boost your productivity

(vi)	 Make task delegation easy

(vii)	 Improve team collaboration

(viii)	Track time spent on projects
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•	 Profit books – Top free 
accounting software

•	 Google docs – Best free 
office suite

•	 Canva – Best free image editor

•	 Buffer – Top free social 
media manager

•	 Calendly – Best free tool for 
scheduling meetings

•	 Hubspot – Best free Customer 
Relationship Management 
(CRM) software

•	 Slack – Best free tool for 
team communication

•	 Trello – Free software for 
managing projects

•	 Fresh desk – Free helpdesk 
system

•	 Xtensio – Create and share 
beautiful documents

Ten Best Software Tools for Small 
Businesses in 2021

1.	 The best accounting software 
– Xero

2.	 The best e-commerce 
software – Shapify

3.	 The best project management 
software - Trello

4.	 The best time tracking software 
– Toggl

5.	 The best online payment 
software – Paypal

6.	 The best email marketing 
software – Mail chimp

7.	 The best collaboration tools 
– Slack

8.	 The best document 
management software – 
G-suite

9.	 The best human resources / 
payroll software : Gusto

10.	 The best customer 
relationship management 
software – Act

Most Popular Office Management 
Software Examples

a.	 Making sure no one’s too hot 
or cold – Comfy

b.	 Communicating and sharing 
information – Slack

c.	 Managing task and monitoring 
projects – Trello

d.	 Worry-free video conferencing 
– Zoom

Fig.5.3 Popular Office Management Soft-
ware
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5.3 Introduction-Cloud Computing

5.3.1 Meaning

Cloud Computing is  the delivery 
of computing services such as servers, 
storage, databases, networking, software, 
analytics, intelligence, and more, over 
the Cloud (Internet). Cloud Computing 
provides an alternative to the on-premises 
datacenter.

Purpose of Cloud Computing

Cloud computing  makes data 
backup, disaster recovery and business 
continuity easier and less expensive.  The 
data can be mirrored at multiple redundant 
sites on the cloud provider’s network.

Types of Cloud Computing

Cloud computing services fall 
into 3 main categories:  Infrastructure as 
a Service (IaaS), Platform as a Service 
(PaaS), and Software as a Service (SaaS). 
Functions as a Service (FaaS) is a relatively 
new Cloud service model. These are 
sometimes called the Cloud computing 
stack because they build on top of one 
another.

Office managers should be very 
experienced with Microsoft office.   It’s 
great to mention their level of proficiency. 
They acquired very good knowledge in 
each program, reference, and also   any 
other related software skills that they have.  

Common types of Software used in 
Business are

1.	 Word processing programs

2.	 Accounts software

3.	 Billing software

4.	 Payroll software

5.	 Database software

6.	 Asset management software

7.	 Desktop publishing software

Software that we use Daily

•	 Microsoft office

•	 Mozilla Firefox

•	 Google apps

•	 Adobe Photoshop

•	 Adobe acrobat professional

Fig.5.4 Cloud Computing 
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There are basically 5 essential 
characteristics of Cloud Computing.

•	 On-demand self-services

•	 Broad network access

•	 Rapid elasticity

•	 Resource pooling

•	 Measured service

Challenges of Cloud Computing

•	 Security issues

•	 Cost management and 
containment

•	 Lack of resources/expertise

•	 Governance/Control

•	 Compliance

•	 Managing multiple clouds

•	 Performance

•	 Building a private cloud

Components of Cloud Computers 
are 1) Client Infrastructure, 2) Application, 
3) Service, 4) Runtime Cloud, 5) Storage, 
6) Infrastructure, 7) Management, 8) 
Security, and 9) Internet. Cloud computing 
makes a complete Cloud computing 
system simpler.

Future of Cloud Computing

Cloud computing is powerful and 
expansive and will continue to grow in the 
future and provide many benefits. Cloud 
computing is extremely cost-effective and 
companies can use it for their growth. The 
future of cloud computing is bright and 

will provide benefits to both the host and 
the customer.

5.4 Activity Based Working:

Activity-based working is a work 
style. It allows employees to choose from a 
variety of settings according to the nature 
of what they are doing, combined with a 
workplace experience that empowers them 
to use those spaces throughout the day.

The concept of activity-based 
working (ABW) revolves around the idea of 
giving people the possibility to do their work 
tasks in a setting that is fully optimized to 
do that specific activity. Examples of such a 
setting are silent zones, collaboration zones, 
learning zones, social zones, etc.

Fig.5.5 Activity Based Working 
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Need for Activity Based Work

Activity-based office 
design  empowers employees and is more 
conducive to creativity and collaboration. 
It also makes it easier to encourage 
employees to come into the office a few 
times a week, rather than every day

Activity Based Office Design

The activity-based workspace or 
workplace (ABW, also known as activity-
based working) is  one that moves away 
from traditional assigned seating and 
empowers employees. This is done by 
giving them the necessary tools and spaces 
to direct their own work.

5.5 Bring Your Own Device (BYOD) :

Bring your own device  (BYOD) 
refers to the trend of employees 
using personal  devices  to connect 
to  their  organizational networks and 
access work-related.

What does “Bring Your Own 
Device” mean? “Bring Your Own Device,” 
or “BYOD” for short, refers to the practice 
of using personal electronic devices for 
professional purposes.

There are some key advantages 
to operating a BYOD strategy, including 
increased employee satisfaction (they can 
work more flexibly), cost savings (reduced 
hardware spend, software licensing and 
device maintenance) plus productivity gains 
(employees are happier, more comfortable 
and often work faster on their own).

Bring your own device refers to 
employees bringing personal devices 

such as laptops, smartphones or tablets to 
the workplace. BYOD may also refer to 
employees using such devices to connect 
to work-related systems from out of the 
workplace.

Fig.5.6 Bring Your Own Device

BYOD Policy

BYOD (bring your own device) 
is  a policy that allows employees in an 
organization to use their personally owned 
devices for work-related activities. Those 
activities include tasks such as accessing 
emails, connecting to the corporate 
network, and accessing corporate apps 
and data.

Importance of BYOD

Users can take advantage of devices 
they already own, and the enterprise saves 
on cost.   There are less security concerns 
if users operate with their own devices. 
The organization does not have to pay for 
a replacement if a device is lost or stolen.

Employee satisfaction is another 
reason employers adopt BYOD policies. 
Employees often have specific preferences 
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regarding what phones and computers they 
like to use  and can use most efficiently, 
so allowing your workers to use their 
preferred devices can make them happier 
and more efficient while working.

With the BYOD approach, 
companies can save on costs while 
increasing employee satisfaction 
and productivity. The company can 
provide predictable stipends for user 
equipment and IT only need focus on 
providing a secure access method and 
ecosystem.

Top 10 Companies Supporting Bring-
Your-Own-Device Culture

•	 Air Watch: Air Watch is a VMware 
company, so you would imagine 
it has all the virtualization tools 
necessary to enable BYOD in a 
variety of environments

•	 Qlik

•	 Parallels

•	 Riverbed Technology

•	 Trustonic

•	 Wombat Security Technologies

•	 3CX

•	 Last Pass

How to Manage and Monitor BYOD 
(Bring Your Own Device)

Step 1: �Understand the Benefits of 
BYOD. ...

Step 2: Consider BYOD Risks. ...

Step 3: �Determine Which Employees 
Will Be Permitted to Use BYOD 
and What Type of Use Will Be 
Permitted

Step 4: Establish a BYOD Policy

Step 5: �Provide BYOD Training to 
Employees and Supervisors

Security of BYOD

Make passwords compulsory on all 
BYOD devices

Create a blacklist of prohibited 
applications

Restrict data access

Invest in reliable security solutions for 
devices

Backing up device data

Educate your staff about security
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Points to be Remembered

Office Tools:

MS-PowerPoint: Retail Cross-
Platform presentation tool. Lotus 
Freelance: proprietary software 
presentation tool. Google Slides: 
Freeware Cloud Based presentation 
tool. Libreoffice Impress: Open Source 
presentation tool.

Advantages of Office Management 
Software:

•	 Collaboration

•	 Sharing resources

•	 Cost and time

•	 Flexibility and automation

•	 Report preparations

The Most Popular Office Management 
Software Examples:

•	 Making sure no one’s too hot 
or cold – Comfy

•	 Communicating and sharing 
information – Slack

•	 Managing task and 
monitoring projects – Trello

•	 Worry-free video 
conferencing – Zoom

Software that we use Daily:

•	 Microsoft office

•	 Mozilla Firefox

•	 Google apps

•	 Adobe Photoshop

•	 Adobe acrobat professional

Challenges of Cloud Computing:

•	 Security issues.

•	 Cost management and 
containment.

•	 Lack of resources/expertise. 

•	 Governance/Control.

•	 Compliance.

•	 Managing multiple clouds.

•	 Performance.

•	 Building a private cloud.

Activity Based working.

Activity-based working is a work 
style that allows employees to choose 
from a variety of settings according 
to the nature of what they are doing, 
combined with a workplace experience 
that empowers them to use those spaces 
throughout the day.

BYOD Policy:

BYOD (bring your own device) 
is  a policy that allows employees in an 
organization to use their personally 
owned devices for work-related 
activities. Those activities include tasks 
such as accessing emails, connecting to 

OSS_EM_Chapter_5.indd   51 5/2/2022   5:11:58 PM

www.tntextbooks.in



52

Evaluation

PART - A

OBJECTIVE TYPES:									       

Choose the Correct Answer:								        (1 Mark)

1.	 Office Tools are a type of _______________ 

	 a. Application Software	 b. Office related Tasks

	 c. Microsoft Office 	 d. Database Management 
	     System.� Ans (a)

2.	 Office Management Software Gives You Much-Needed ________________

	 a. Storage Space 	 b. Computer Space

	 c. Physical Space	 d. Software Space� Ans (a)

3.	 ______________ is the Best free software for creating websites.

	 a. Mailer Lite 	 b. Profit Books

	 c. Google Docs 	 d. Wix� Ans (d)

4.	 ____________ is the free software for managing projects.

	 a. Canva 	 b.  Xtensio

	  c. Trello	 d. Fresh Desk � Ans (c)

5.	 The best collaboration tools _____________.

	 a. Merge	 b. Slack

the corporate network, and accessing 
corporate apps and data.

How to Manage and Monitor BYOD 
(Bring Your Own Device)

Step 1: Understand the benefits of BYOD. 

Step 2: Consider BYOD risks.

Step 3: Determine which employees will 
be permitted to use BYOD and what type 
of use will be permitted.

Step 4: Establish a BYOD policy.

Step 5: Provide BYOD training to 
employees and supervisors.
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	 c. Sleek	 d. Slim� Ans (b)

6.	 Office managers should be very experienced with ______________

	 a. Over all Working	 b. Microsoft Office

	 c. Books of Accounts	 d. Computer� Ans (b)

7.	 Cloud Computing provides an alternative to the on-premises_____________.

	 a. Data Center 	 b. Data Software 

	 c. Data Systems 	 d. Clouding � Ans (a)

8.	 _______________ is the component of cloud computers.

	 a. Infrastructure 	 b. Structure 

	 c. Inbuilt Structure 	 d. Hardware� Ans (a)

9.	 ABW stands for ____________________.

	 a. Array Bounds Write 	 b. All Being Well 

	 c. Alternatives for Battered 	 d. Activity Based Workplace� Ans (d)

10.	 BYOD Stands for ___________________.

	 a. Bring your own desk 	 b. Bring Your own digital 

	 c. Bring your own device 	 d. Bring your own Diary� Ans (c)

PART - B

II. 	 Very Short Answers:							�        (3 Marks)

1.	 		 What is meant by Office tools?

2.	 		 What is management software?

3.	 		 Give any two examples for office management software.

4.	 		 Write a note on cloud computing.

5.	 		 List out the types of cloud computing.

6.	 		 What is ABW?

7.	 		 What is BYOD?

8.	 		 Give a note on BYOD policy.

PART - C

III.	 Short Answers:� ( 5 Marks)

1.	 		 What are the key benefits of using task management software?
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2.	 		 State the advantages of office management software.

3.	 		 State the free software for small businesses.

4.	 		 What are the characteristics of cloud computing?

5.	 		 Explain the components of cloud computers?

6.	 		 Are there any challenges for cloud computing? Explain.

7.	 		 Discuss the importance of BYOD.

PART - D

IV.	  Essay Type Questions:�      (10 Marks)

1.	 		 Explain Office management software elaborately.

2.	 		 Explain the advantages and disadvantages of cloud computing.

3.	 		 Explain in detail about BYOD.

Teachers Activity:

1.	 Field visit can be made to nearby banks/software companies along with students.

2.	 IT industries visit can be planned to explain about BYOD, Cloud computing 
and Task management software.

Students Activity: 

1.	 Students Can prepare assignments on “Cloud computing” topic.

2.	 Charts can be prepared and displayed in class room for “Office management 
software”.

ACTIVITY

References:

1.  https://www.productdossier.com

2.  https://www.taskopad.com
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1. Management Software: It is that which is designed to streamline and automate 
management process.

2. PHP: Hypertext preprocessor.

3. ABW: Activity based working.

4. Cloud Computing: It makes data backup, disaster, recovery and business continuity 
easier.

5. BYOD: Bring your own device
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Content:

Introduction - Office Systems 
and Procedures - Meaning - Definition 
- Principles of Office Systems and 
Procedures - Importance of Office 
Systems and Procedures - Distinguish 
between Office Systems and Procedures - 
Introduction - Office Manuals - Meaning 
- Definition - Types of Office Manuals - 
Steps in Preparation and Writing of Office 
Manuals - Revision and Distribution of 
Office Manuals 

Learning Objectives

•	 To study the meaning and 
definition of office systems and 
procedures

•	 To understand the principles of 
office systems and procedures.

•	 To know the importance of 
office systems and procedures

•	 To gain knowledge about office 
manuals.

6.1 �Introduction - 

A good office system and 
procedures shall bring in a lot of laurels 
to an organisation. An efficient way of 
maintaining office systems provides 

a sound environment and peaceful 
atmosphere inside an office, which results 
in a controlled working atmosphere. 
Similarly office procedures are considered 
to be very important for an efficient office 
system. So office systems and procedures 
are like double barrel guns, unless we have 
an effective and dynamic office system and 
procedures it is very difficult to achieve 
the organisation goals and objectives 
successfully.

Therefore, each organisation 
shall have well equipped and technology 
supported office systems and procedures 
so as to produce good results for their day 
to day routine business activities. 

Fig.6.1 Office Procedures

 6.1.1 Meaning: 

All the business undertakings, 
establishments and other organisations 
shall have clear vision and well defined 
objectives. These objectives can be 

OFFICE SYSTEMS AND PROCEDURES

UNIT – 66
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Moreover the systems are not the same in 
all offices. They differ with the type and size 
of business. Whatever system is followed, 
it should ensure maximum efficiency. 
Following are some of the important 
principles of office systems and procedures.

(i)	 Good flow of work

(ii)	 Repetition of work should be avoided.

(iii)	 Required staff should be maintained.

(iv)	 Unnecessary paper can be min-
imised and writing work can be 
avoided.

(v)	 Best use of specialisation should be 
made.

(vi)	 Principles of management by excep-
tion should be used.

(vii)	 Unnecessary checking should be 
avoided.

(viii)	Best use of Machine should be pro-
vided.

(ix)	 The overall system should be simple 
and easy to follow.

attained only when it is approached in an 
orderly manner. Any office systems and 
procedures of a business establishment 
comprising various other sub-systems. 

Management experts say that each 
business has a number of subsystems like 
production control system, marketing 
system, office system, purchase system, 
finance system etc., thus the office system 
itself they call it as a sub-system of the 
whole business. 

6.1.2 Definition: 

According to Milton Reitzfeld 
“Success in business, government and 
non-profit ventures is determined by the 
maximum utilisation of people, information 
and resources. Such utilities can be achieved 
only through the development, installation 
and supervision of appropriate systems and 
procedure”.

6.1.3 �Principles of Office Systems and 
Procedures:

At present, modern offices are 
functioning with their own systems. 

Fig.6.2 Office Systems and Procedures 
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6.1.4 �Importance of Office Systems and 
Procedures:

(i)	 In the system concept an uniform pro-
cedure is followed for similar transac-
tions. So it helps to reduce overall op-
erations cost. 

(ii)	 The cost of conducting routine office 
work is also reduced. 

(iii)	 Responsibility can be easily assigned.

(iv)	 Smooth functioning of office systems 
and procedures helps to reduce delay in 
work.

(v)	 To maintain better coordination be-
tween departments.

(vi)	 Helps management to provide training 
to the staff.

(vii)	 To improve overall efficiency of the or-
ganisation.

(viii)	 Helps to have flow of information from 
top to bottom of the organisation. 

6.1.5 �Distinguish between Office 
Systems and Procedures:

Office work is composed of a 
pattern of office system, procedure 
and methods. The word office system 
has been used in different senses. In 

the ordinary sense of the term office 
system means a particular set of 
work arranged in sequence. It gives a 
complete picture of personnel, forms, 
records, machines and equipment 
involved in completing all the work of 
the office routine. 

6.2 Introduction - Office Manuals:

An office manual is a guidebook, 
printed and bound and/or in digital 
format, which provides information 
regarding the organisational policies 
and procedures that are adopted within 
the office. It contains instructions 
for standard practices relating to the 
organisation, the office, workplace, the 
work itself and about the employees and 
workers. 

The importance of office manuals is 
to save time, create standard guidelines for 
everyone in the organisation, and provide 
a solid foundation of knowledge. Manuals 
can be used for policies, organisational 
means, departments, systems and 
procedures, or any combination of the 
above.

Office Systems Office procedures
1.It is a plan of work 1. It denotes the steps comprising a plan of 

work.
2. It states what work is to be done. 2. It shows how the work is done.
3. It denotes a broad division of work. 3. It denotes a small part of each division.
4. A system is prepared once for all. 4. Routines are used again and again.
5.A system includes number of routines 5. A routine does not include a system be-

cause it is a guide to work.

Difference between Office Systems and Procedures
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methods, standards, rules and regulations 
of an office operation.” 

6.2.3 Types of Office Manuals: 

Types of office manual are 
mentioned as follows:

a.	 Policy Manual

b.	 Organisation Manual

c.	 Rules and Regulations Manual

d.	 Departmental Manual

6.2.4 �Steps in Preparation and Writing 
of Office Manuals:

The preparation and/or revision 
of an office manual is the responsibility 
of an individual executive in a small 
size organisation. Whereas, if it is a 
bigger organisation a committee is 
formed, to prepare and/or revise the 
office manual. This committee consists 
of heads of various departments. It is 
expected that update information and 
instructions should be given in the 
office manual. 

A standard and an orderly 
procedure should be followed while 
preparing office manuals. If so, the 
completed manual should have clear, 
accurate and comprehensive information. 
The preparation work should be completed 
within reasonable time.

The following steps are taken while 
preparing an office manual:

(i)	 Assigning an individual or forma-
tion of a committee according to the 
nature of organisation.

Fig.6.3 Office Manuals 

6.2.1 Meaning:

An office manual is a kind of 
handbook which contains the standard 
practices as well as the organisational 
policies to give effect to those practices 
meant for an office. It is a guidebook for 
the members of the staff and employees. It 
sets out the guidelines along which the jobs 
have to be carried out and finished. It is a 
constant source of information available 
to all the staff members or employees of 
an organisation. 

6.2.2 Definition:

According to George R. Terry, 
an office manual has been defined as “a 
document disclosing the information 
about an organisation, its set up, 
conditions of employment and the 
established system, routine, procedures, 
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(ii)	 To prepare a list of subjects to be 
covered in the preparation of the of-
fice manual.

(iii)	 Receiving of ideas and suggestions 
from the functional departmental 
heads and supervisors.

(iv)	 Verification of ideas and suggestions 
whether it is relevant or not.

(v)	 Classification and arrangement of 
subject-wise information.

(vi)	 Prepare a Draft Manual (on trial ba-
sis)

(vii)	 Revision of the Draft Manual, wher-
ever correction or amendment is re-
quired.

(viii)	Submission for approval of Top level 
management.

(ix)	 Actual Production of Final manual

(x)	 Distribution of Office manual based 
on need basis. 

6.2.5 �Revision and Distribution of Office 
Manuals:

It is very much necessary to update 
your company or office manuals with current 
affairs, expectations from employees, such as 
attendance, safety rules, legal compliances 
with employment laws, facilities management 
and dress codes etc., Policies are guidelines 
that define company rules and procedures 
and the consequences are not following them. 
Policy manuals should be regularly reviewed 
and updated when necessary. 

Law changes, new issues arise, 
and the manual must be updated and 
kept current. And if your handbook is in 
multiple languages, each version needs 
to be updated as well. For this reason, a 
strategic approach to revising your policy 
manual means taking a fresh look at each 
and every policy to determine that they are

(i)	 Accurate

(ii)	 Up to-date

Fig.6.4 Department wise Office Manuals 
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(iii)	 In compliance

(iv)	 Complete

(v)	 Understandable
Office manuals are useless unless they 

are properly distributed amongst various 
employees for whom they are meant. It is the 
employees or staff responsibility to adhere 

to the rules and regulations mentioned in 
the office manuals. Organisation manuals 
may be distributed only at the top level 
management and in rare cases amongst those 
with lesser responsibility. The departmental 
manuals should be distributed to various 
other departments and employees as they 
are directly affected by them.

Points to be Remembered

•	 Systems and Procedures: It is 
defined as “Success in business, 
government and non-profit 
ventures is determined by the 
maximum utilisation of people, 
information and resources. 
Such utilities can be achieved 
only through the development, 

installation and supervision 
of appropriate systems and 
procedures.

•	 Office Manuals :  An office manual is 
a kind of handbook which contains 
the standard practices as well as the 
organisational policies to give effort 
to those practices for an office.

Evaluation

PART – A

OBJECTIVE TYPES :									         (1 Mark)

1. 	 Choose the Correct Answer :� (1 Mark)

1. 	 A good office __________________________ shall bring in lot of laurels to an 
organisation.

	 a. Atmosphere 	 b. Systems and Procedures

	 c. Policy Manual	 d. Practice Manual� Ans. (b)

2. 	 Office systems and Procedures of a business establishments comprising of various  
______________________________ .

	 a. Subsystems 	 b. Equipments 

	 c. Methods 	 d. Services � Ans. (a)
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3. 	 Modern offices are functioning with its ______________________

	 a. Own Policy 	 b. Own Structure 

	 c. Own Systems 	 d. Own Rules� Ans (c)

4. 	 Smooth functioning of office systems and procedures helps to reduce 
______________________ .

	 a. Delay in Work	 (b) Stress  

	 c. Repeated Work	 d. Overlapping of Work� Ans (a)

5. 	 An office manual is a __________________

	 a. Guide Book	 b. Report

	 C. Statement 	 d. Diagram� Ans (a)

6. 	 An office manual is a ______________________ disclosing the information about 
an organisation .

	 (a) Report 	 (b) statement

	 (c) Document	 (d)  chart� Ans (c)

7. 	 The completed manual should have clear, accurate and comprehensive 
_______________________ .

	 a. Information  	 b. Communication

 	 c. Forms 	 d. Systems � Ans (a)

8. 	 _______________________ should be regularly reviewed and updated when 
necessary.

	 a Office Manual 	 b. Practice Manual 

	 c. Organisation Manual	 d. Policy Manual� Ans (d)

9. 	 ___________________________ may be distributed only at the top level 
management.

	 a Department Manual	 b. Organisations Manual 

	 c. Policy Manual 	 d. Office Manual � Ans. (b)

10.	 _________________________ is composed of a pattern of office system, 
procedure and methods

	 a Administration Work 	 b. Office Work

	 c. Organisation Work   	 d. Group Work �  Ans. (b)
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PART – B

II.	 Very Short Answers:� ( 3 Marks)

1. 	 What is meant by the office system and procedures?

2. 	 Define the term office system and procedures.

3. 	 Write a short note on office manual.

4. 	 Define the term office manual.

5. 	 What are the types of office manuals?

PART – C

III. 	 Short Answers:� ( 5 Marks)

1. 	 What is the importance of office systems and procedures?

2. 	 Distinguish between office systems and procedures.

3. 	 Explain Revision and distributions of office manuals.

PART – D

IV. 	 Essay type questions :							�        (10 Marks)

1. 	 Explain the Principles of office systems and procedures.

2. 	 What are the steps in preparation and writing of office manuals?

Teachers Activity:

•	 Can show a chart regarding the formation of procedure. Types of manual.

•	 PowerPoint Presentation on office systems and procedures can be made.

Students Activity: 

•	 Can give assignments on office systems, procedures and manuals.

•	 Collect various office manuals and submit

ACTIVITY
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References :

1. Pressurearticles.com// office systems and office

2. Office manual : Your article library.

1. Laurels : An award or praise on recognition of an achievement.
2. Systems : Several procedures integrated together.
3. Procedures : Planned sequence of operations.
4. Manual : A Book giving instructions or information.
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Content:

Introduction – Database 
Management System – Meaning – 
Definition – Features of DBMS – Concept 
of DBMS – Steps to Create a Table using 
Table Wizard – Table Data View Dialog 
Box - Perform Operation on Table – 
Retrieve Data using Query – Grouping of 
Data. Structured Query Language (SQL) 
– Create Forms and Reports using Wizard 
–Forms in Base.

Learning Objectives

•	 Enable the students to understand 
the concept of DBMS.

•	 To know about the steps to 
create a table using table wizard 
and to retrieve data using query.

•	 To know about Structured 
Query Languages ( SQL).

•	 To analyze and create forms 
and reports using wizard.

7.1 Introduction:

A Database Management System 
(DBMS) is a software tool to organize 
(create, retrieve, update and manage) data 
in a database.

A database management system 
is a computerized record – keeping 

system. It is a container for collection of 
computerized data files.

7.1.1. Meaning :

A database is a collection of logically 
related data items stored in an organized 
manner. According to the requirements 
of the user, the datas being stored in a 
database can be added, modified, deleted 
or displayed. The software that is used to 
create, update and retrieve date is known 
as Database Management System (DBMS).

7.1.2 Definition:

Database defined, A Database is 
an organized collection of structured 
information or data, typically stored 
electronically in a computer system. 
A database is usually controlled by a 
Database Management System (DBMS).

7.1.3 Features of DBMS:

•	 Controls who can access and edit 
the data

•	 Create backups

•	 Allows data to be shared by many 
users

•	 Provides user interfaces to work 
with the data

•	 Provides high level of security.

•	 Permanent storage of data.

DATABASE MANAGEMENT SYSTEM(DBMS)

Unit – 77
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stored in different tables made up of rows 
and columns.

Eg. Oracle, MYSQL, IBM, etc.,

Field : A field is the smallest entity in the 
database.

Record: A collection of fields makes a 
record.

Table: A collection of records makes a 
table.

Database: Collection of tables make a 
database.

Primary Key:

A primary key is a column or a 
group of columns that uniquely identifies 
the rows in that table.

Register 
No.

Name  
of the  

Student

DOB Marks

   ^ ←Primary Key

Composite Primary Key :

A primary key having two or more 
attributes is called composite primary 
key. It is a combination of two or more 
columns.

Register 
No.

Name 
of the 

Student

DOB Marks

 ←—------------------------------>  
Composite Primary Key

Foreign Key :          

A foreign key is the one that is used 
to link two tables together via the primary 
key.

7.1.4 Concept of DBMS:

A Database Management System 
(DBMS) is a software package designed to 
define, manipulate, retrieve and manage 
data in a database.

A DBMS generally manipulates the 
data itself, the data format, field names, 
record structure and file structure. It also 
defines rules to validate and manipulate 
this data.

Fig.7.1 Database Management System

Concept and examples of Relational 
Database :

The Relational Database Model was 
proposed in 1970 by E.F. Codol. Relational 
database model is the most common type 
of database model. The data elements are 
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Register 
No.

Name 
of the 

Student

DOB Marks

PRIMARY KEY

 

Register 
No.

Group Student / STD

Foreign Key

DataBase Management System (DBMS) 
Software:

One of the DBMS software Libre Office 
Base.

Introduction :

Libreoffice Base is a free and open 
source DBMS. It can be downloaded from 
www.libreoffice.org and is available for both 
Linux and windows operating systems. Data 
has to be stored in an organized manner using 
a DBMS. Also, the data being stored can be a 
text, number, date or in any other form. Steps 
to create the database are as follows:

1.	 Start the Libreoffice Base as per 
the standard process of starting the 
application in Windows or Linux.

2.	 In windows, click start. In Libreoffice 
double/click on the Libreoffice icon 
on the desktop (or) select base 
DataBase option form the bottom 
left pane.

3.	 A Database wizard opens. It allows 
you to create a new database or open 
an existing database.

4.	 Click create a new database ratio 
button.

5.	 Gives the option to register our 
database with Libre office.org.

6.	 Open option enables the user to edit 
the database.

7.	 Click the Finish button to complete 
the database creation process.

8.	 The Save As dialog box appears.

9.	 Browse for the drive and folder 
where you want to store your 
database.

10.	 Type the name in the file name text 
box.

11.	 Click the Save button.

Fig.7.2 Database Management Software

7.2 Create a Table using Table Wizard: 
7.2.1 Steps to create a table using table 
wizard

Once the database is created, we can 
start working with objects of the database. 
First and foremost is the creation of the table.

In Libreoffice Base, a table can be 
created using a wizard or using the design 
View.
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Option to Set Primary Key :

Once the take is created, it will ask the 
user to set a primary key. The user can select 
the appropriate option to set the primary key 
or leave the table without a primary key.

7.2.2 Table Data View Dialog Box :

Table data view dialog box enables 
the user to define the layout of the table 
and insert the data into the appropriate 
fields of the table.

7.3 Perform Operations on Table :

Inserting data in the table.

To insert the data in the table, select 
the table and double click on it. The table 
will open in the Datasheet view in which 
data can be inserted.

Edit Records in the Table :

To edit the data either click on the 
edit icon or double click on the data in the 
cell of a label and modifications can be 
done.

Deleting Records from the table :

To remove the data from the table 
follow the steps :

Select the data – right click on 
selected data – select delete option.

Sorting Data :

Sorting means to arrange the data 
in either ascending order or descending 
order. Select the columns, then click on 
sort buttons. The data will be displayed 
accordingly.

To create a table at the time of 
creating a database in database wizard, 
select the radio button with option “create 
tables using the table wizard”, then click 
on the Finish Button.

In Base, ready-made tables are 
available.

•	 Step 1 - Click the sample tables List 
Box and select any one table.

•	 Step 2 - Click on Next Button

•	 Step 3 - Click on Next Button

•	 Step 4 - Click on Next Button – to 
complete the process of creating a 
table using wizard. 

•	 By default the “Insert data 
immediately” option is selected.

•	 Step 5 - Click on the Finish Button.

Data Types

Data types are used to identify 
which type of data (value) we are going to 
store in the database.

Data types are broadly classified 
into five categories are listed below :

1.	 Numeric Types (0 to 9)

2.	 Alphanumeric Types (a/A to z / Z 
& 0 to 9)

3.	 Binary types (storing photos, music 
files, etc.,)

4.	 Date & Time (DD/MM/YYYY) & 
(HH:MM)

5.	 Other variable types.
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Referential Integrity :

Referential integrity used to link 
between two or more tables with the help 
of primary key and foreign key constraints.

Creating and Editing Relationships 
between Tables :

A relationship refers to an 
association or connection between two 
or more tables. When the user relates two 
tables, then the same data need not be 
entered in separate tables.

There are three types of relationships 
which can be created in tables.

1.	 One to One

2.	 One to many or many to one

3.	 Many to Many

One to one relation :

In this relationship, both the tables 
must have a primary key column.

Register 
No.

Name 
of the 
Student

DOB Marks

PRIMARY KEY

  

Register 
No.

Group Student / STD

PrimaryKey

One to Many or Many to one Relation :

In relational databases, one – to – 
many relationships exist when one row in 

table A may be linked with many rows in 
table B, but one row in B is linked to only 
one row in table A.

In this relationship, one of the table 
must have Primary Key column.

Table A

←—--->
←—--->
←—--->

Table B
Record

Record
Record

Record

Many to Many relationship :

In many to many relationship no 
table has the primary key column.

A many to many relationship 
occurs when multiple records in a table 
are associated with multiple records in 
another table.

Eg. A Many – to – Many relationships 
exist between customers and products.

Customers can purchase various 
products and products can be purchased 
by many customers.

7.4 Retrieve Data using Query

As the name suggests, query is to 
collect specific information from the pool 
of data.

A query is one of the most important 
features of any DBMS. Using a query, we 
can retrieve and display data from one or 
more tables in a database.

 Customers  Products
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A Query can be created in three 
ways.

1.	 Using a Wizard

2.	 In design View

3.	 In SQT View

Steps :

1.	 In the Database Design Window, 
click the queries button.

2.	 In the Tasks Area, click on use 
wizard to create a query option.

3.	 Select fields from the respective 
tables.

4.	 From the list box, select the event 
name field.

5.	 Click on the next button that will 
display the screen to select the 
storing order.

6.	 To set the search conditions or the 
criteria on the basis of which records 
will be filtered from the table.

7.	 Select field from Fields drop down 
list, is equal to from condition,

8.	 Steps 4,5,6 given in the steps pane 
deal with tasks like summarizing 
and performing numerical 
calculations.

9.	 To give an alias name i.e. the column 
header name will be displayed when 
we run the query.

10.	 Displays the entire overview of the 
query

11.	 Click on the finish button.

12.	 Creation of query using design View :

This is a more flexible method to 
create a Query from either a single or a 
multiple table of a database.

1.	 Click the Queries icon on the objects 
pane in the Database window.

2.	 Click create Query in design view…
icon in the tasks Pane. The Query 
Design window appears.

3.	 Click on the Event table to be used 
in the Query and then click on Add 
button.

4.	 Similarly add table to tables Pane of 
The Query Design Window.

5.	 Click the close button in the ADD 
Table or Query dialog box to close it.

6.	 Next step is to select the fields.

7.	 In the grid, there is a row titled 
Alias. As mentioned before, it can 
be used to display meaning names 
in the output.

8.	 By default, the data that is displayed 
as a result of the query is not 
sorted. To sort the records in either 
ascending or descending orders of a 
particular field, the sort row is given 
in the grid.

9.	 Once the query is designed, click 
Run Query Button on the toolbar or 
press F5 key.

10.	 Click on save button to save the 
query.

11.	 By default, the query name will be 
displayed. Type a different name if 
required. Click on the OK button to 
save the query.
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7.4.1 Structure and Query language (SQL):

SQL stands for Structured Query 
Language. It is used for storing and managing 
data in Relational Database Management 
Systems (RDMS). It is a standard language 
for Relational database System. It enables 
a user to create, read, update and delete 
relational databases and tables.

SQL comprises both data definition 
and data manipulation languages. Using 
the data definition properties of SQL, one 
can design and modify database schema, 
whereas data manipulation properties 
allow SQL to store and retrieve data from 
a database.

SQL uses the following set of 
commands to define a database.

a. CREATE 

Create new databases, tables and views 
from RDMS.

Syntax : 

Create database students record

Create table article

Create view for – students

b. DROP

Drops commands, tables and databases 
from RDMS.

Syntax : Drop database students record

Drop Table article.

c. ALTER:

Modifies database

Syntax : Alter table article add subject 
varchar & Datetime

A SELECT : Statement retrieves zero or 
more rows from one or more database 
tables or database views. In most 
applications, select is the most commonly 
used Data Manipulation Language (DML) 
command.

The SELECT 

Statement has many optional clauses :

WHERE specifies which rows to retrieve

Order by specified an order in which to 
return the rows.

To retrieve all the columns in a table.

The syntax is SELECT from < TableName > ;

In order to execute queries click on the 
Queries option available on the left side 
under the database section, click create 
query in SQL view.

Fig.7.3 Data Sorting 

7.4.2 Grouping of Data :

To display the records containing the 
same type of values “WHERE” clause can 
be used with the select SQL command.
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Ex. : To get details about the list of students 
whose favorite color is blue

Syntax used : Select from S Details Where 
color = ‘Blue’;

7.5 �Create Forms and Reports Using 
Wizard :

Libreoffice base provides the form & 
reports feature for data entry purposes.

Both reports and forms are considered as 
objects of the database and are present in 
the database pane of the libreoffice Base 
user interface.

7.5.1. Forms in Base :

A form is an object of the database that 
has a user-friendly interface where data 
can be entered and seen in an attractive 
and easy to read format.

7.5.2 Creating a Form Using Wizard :

This is the simplest way to create a form.

Steps to create form using form wizard

Step 1 : Open the Database created in 
Libreoffice and click the form icon on the 
database pane.

Step 2 : To select the tables or queries for 
which the form has to be created,

Step 3 : After selecting the table, all the 
fields of the table will be listed in the 
available fields list Box.’

Step 4 : To appear all the fields in the form, 
shift all the fields of table form available 
fields list box to fields in the form list box 
using >> button.

Click on the next button to move forward.

Step 5 : To apply styles to the form being 
created

Step 6 : Click the next button to set the 
name of the form.

Step 7 : Click the Finish button.

Managing a Form :

To manage a form click on the 
forms object in the Database pane and 
select the form from the forms pane.

Use the forms toolbar to open, edit, 
enter or remove data, to modify data, to 
change label background, to search record 
and to insert and delete the data in forms.

7.5.3. �Steps to Create REPORT using 
Wizards :

Report helps to present information 
from the database in an easy to read, 
visually printable format.

Libreoffice Base makes it easy to 
create and customize a report using data 
from the database.

To create Reports using wizard is 
the recommended method for quickly and 
easily creating a report.

STEPS :

Step 1: From the database pane view select 
reports.

Step 2: Task view will appear from that click 
“Use wizard to create Report” options.

Step 3: In this step, select the tables’ fields 
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that are to be displayed in the report.

Eg. From the ‘student record’ Database, 
choose fields in reports.

Reg. No./ Name of the student / DOB

Step 4 : Click the next button and the 
report generates labels for each field.

Step 5 : A Report can group the results by 
one or more fields

Eg. : To group the results by assigning 

names as ‘student info’.

Step 6 : In this step, choose the layout for 
the data & the headers and footers of the 
report.

Step 7 : Here we specify the ‘Title’ and the 
‘Type’ of the report

Step 8 : Click “Create Report Now” option

Step 9: Click the ‘finish’ button.

Evaluation

PART – A

OBJECTIVE TYPES:

I Choose the Correct Answer � (1 Mark)

1.	 DBMS stand for _______________________________
	 a. Database Management System 	 b. Data Building Master System

	 c. Data Bundle Management System 	 d. Databank Management  
	 Services.� Ans (a) 

Points to be Remembered

•	 A DBMS is a software tool.

•	 A database is a collection of data 
in an organized manner.

•	 A Database is usually controlled 
by a database management system.

•	 Data in the database can be 
grouped or segregated using 

primary, composite primary and 

Foreign Keys.

•	 Libreoffice Base is one of the 

DBMS software.

•	 SQL is a standard language for 

storing, retrieving and managing 

data in a database.
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2.	 A Database is Collection of ___________________________

	 a. Unorganized Data	 b. Logically Related Data

	 c. Irrelevant Data	 d. Queries� Ans (b)

3.	 The relational Database Model was proposed in _______________________

	 a. 1980 	 b. 1975 

	 c. 1970 	 d. 1972� Ans (c) 

4.	 A collection of ____________________ make a table

	 a. Field	 b. Table 

	 C. Database 	 d. Record�  Ans (a)

5.	 ________________________ key is uniquely identified the rows in a table

	 a. Composite Primary Key	 b. Foreign Key

	 c. Primary key	 d. Composite Key � Ans ( c) 

6.	 Which one is the DBMS software from the following?

	 a. Linux	 b. Windows

 	 c. Libreoffice Base 	 d. Mac� Ans (c )

7.	 __________________________ is the recommended method to quickly and 
easily create a report.   

	 a. Design View 	 b. Wizard

	 c. SQL View 	 d. Table View� Ans ( b)

8.	 _________________________ can present data in the database in an attractive 
and easy to read format.

	 a. Forms	 b. Report

	 c. Table	 d. Wizard� Ans ( a)

9.	 _____________________ key is used to link two tables together via theh primary 
key.

	 a. Primary Key     	 b. Composite Key

	 c. Foreign Key     	 d. Composite Primary Key � Ans ( c)

10.	 ___________________ Types of relationships in creation of table.

	 a. 3	 b. 4

	 c. 2  	 d. 5 � Ans ( a) 
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PART – B

II.	 Very Short Answers:� (3 Marks)

1.	 		 Define DBMS.

2.	 		 What is the primary key?

3.	 		 Classify data types in database?

4.	 		 What are the types of relationships in tables?

5.	 		 What is a Query ?

PART – C

III.	 Short Answers:� (5Marks)

1.	 		 What are the features of DBMS ?

2.	 		 Define the concept of relational database and its elements.

3.	 		 Explain about different types of keys in relational database.

PART – D

IV. 	 Essay Type Questions:� (10Marks)

1.	 		 Explain about creating and editing relationships between tables.

2.	 		 Explain about types of operations performed on table.

Teachers Activity:

1.	 Teach the students about the procedure to download Libreoffice Base DBMS 
Software.

2.	 Teach the students about the functions of DBMS software.

Students Activity: 

1.	 Perform step by step procedure for creating a form losing a wizard.

ACTIVITY
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References :

1. www.psscove.ac.in

2. http://en.m.wikipedia.org

1. Data: Data are individual facts, statistics, or items of information, often numeric. In a 
more technical sense.
2. Database: A database is an organized collection of structured information or data, 
typically stored electronically in a computer system.
3. SQL:  SQL stands for structured Query Language. It is used for storing and managing 
data in relational database management systems (RDMS).
4. DBMS: A database management system (DBMS) is a software tool to organize (create, 
retrieve, update and manage) data in a database.
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Content:

Introduction-Meaning - Procedure 
for Opening Bank Accounts - Maintaining 
of  Bank Statements - Different Forms used in  
Banks Modern Banking Services – Types 
of Accounts/Deposits – Core Banking 
Solutions – No Frills Account - Common 
Banking Services.

Learning Objectives

•	 To understand the procedure for 
opening bank account

•	 To familiarize with different 
forms used in banks.

•	 To know various deposits 
available in banks.

8.1 �Introduction 

Modern office management 
needs banking services for its day to day 
operations. At every stage of its business 
operations, an organisation is required 
to open bank accounts irrespective of 
its nature, size and volume of business. 
Amongst various services like education, 
transport, insurance, health, information 
technology etc, Banking services are very 
important as it involves in commercial 
activities called profit making. Business 
is mainly conducted to mobilize funds. 

All the business entities regardless of its 
nature and size of commercial activities, 
aims to gain profits out of its operations. 
Therefore, soon after its establishment, it 
becomes mandatory for the business unit 
to open a bank account from one or more 
banks for easy financial dealing. 

Fig.8.1 Office Management Related Bank-
ing Services 

8.1.1 Meaning: 

The word “Bank” is derived from an 
Italian word “Banco” which means bench 
for keeping, lending and exchange of money 
or coins. A bank is generally understood as 
an institution which provides fundamental 
banking services such as accepting deposits 
and providing loans. Banking is a customer 
oriented service industry. The customers 
may be an individual, organisation or firms. 
Organisation needs to run the business. 
Many of the organisations approach 
banking services to run their business 
successfully. 

OFFICE MANAGEMENT RELATED BANKING SERVICES

UNIT – 88
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(iii)	 Utility bills with current address 
information.

8.1.3 Maintaining of Bank Statements:

Basically, the bank statements 
are required to keep tracking of routine 
business transactions and to monitor 
other transactions through bank account. 
Generally a savings account is opened for 
individual operations of a person, whereas, 
we have to necessarily open a current 
account for our business operations. The 
periodical bank statements are collected 
either in person or through mail to do 
Bank Reconciliation statements at our 
office regularly.

Having all of statements available 
when prepare your taxes will help the 
confirm income and track deductible 
expenses accurately. This holds true 
whether receive statements by mail or 
electronically. 

Statements from bank and credit 
card companies arrive regularly, either by 
mail or electronically. Reviewing them is 
an important step in keeping finances in 
order, but several factors affect how long 
should hold on to bank and credit card 

“Banking is defined as accepting for 
the purpose of lending or investment of 
deposits of money from the public, repayable 
on demand or otherwise and withdrawable 
by cheque, draft, order or otherwise “ – The 
Banking Regulation Act, 1949

8.1.2 �Procedure for Opening Bank 
Accounts:

•	 Choose a Bank or Credit Union

•	 Visit the convenient Bank Branch 
or Website.

•	 Pick the product you want whether 
savings or current account etc.,

•	 Provide your information 

•	 Consent to the terms 

•	 Fund your account

Basic steps required to open bank 
accounts: 

(i)	 At least two forms of government 
issued photo identification such a 
valid driver’s license or passport.

(ii)	 Social security number or individu-
al taxpayer identification number.

Fig.8.2 Banking Services
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statements. In most cases should save 
them at least until filed taxes for that year 
and resolved any pending fraud disputes, 
but storing them away for longer may pay 
off in the future. 

Fig.8.3 Online Banking 

8.1.4 Different forms used in banks:

Generally speaking a deposit 
challan is called bank form. A deposit 
slip is a small paper form that a bank 
customer includes when depositing funds 
into a bank account. A deposit slip by 
definition, contains the date, the name 
of the depositor, the depositor’s account 
number, and the amounts being deposited. 

Some of the important forms used 
in banks other than challan form:

•	 Withdrawal slips

•	 Cheque Book

•	 Demand draft form

•	 Debit card / Credit card form

•	 Bank Statement requisition form 

•	 Personal Loan/Business Loan 
Application/agreement form/Cash 
credit application form

•	 Letter of credit form

•	 Identity verification form

•	 KYC form 

8.1.5 Modern Banking Services:

During the year 1991-1996, after the 
successful implementation of Liberalisation, 
Privatisation and Globalisation (LPG) our 
economy had touched new heights, not 
only in our economy and also in our trade 
and commerce. All Indian banks were 
forced to compete with world banks that 
were permitted to open their branches in 
India. As a result, all banking customers 
were offered multiple and model banking 
products which are different from 
traditional and conventional banking 
systems in India and these banking 
functions are mostly based on information 
technology. 

Fig.8.4 Bank Statements and Pass Book 

8.1.6 Types of Accounts/Deposits:

(i) Savings Accounts:
Savings accounts are meant for 

encouraging savings habit among the 
customers and also giving a protected 
environment to their savings.
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8.3 No-Frills Account:
These accounts are opened mostly 

in rural areas as a part of a financial 
inclusion project encouraged by the 
Reserve Bank of India. These accounts are 
opened by banks without the condition of 
maintaining minimum balance. 

This was until the Reserve Bank of 
India introduced a “no-frills Account” which 
aims at providing all necessary banking 
facilities to consumers at minimum or nil 
charges. No-frills bank accounts require 
zero or very low minimum balance. Banking 
services such as withdrawals and ATM 
and Debit card facilities at zero charges to 
enable universal access to banking facilities. 
No-frills bank accounts are now known as 
Basic Saving Bank Deposit Accounts.

8.4 Common Banking Services:

(i) Introduction: An establishment 
authorized by a Government to accept 
deposits, pay interest, clear cheques, 
advance loans, act as an intermediary in 
financial transactions, and provide other 
financial services to its customers. People 
earn money to meet their day-to-day 
expenses on food, clothing, education of 
children, housing, etc. 

(ii) Savings Money: They also 
need money to meet future expenses on 
marriage, higher education of children, 
house building and other social functions. 
These are heavy expenses, which can be 
met if some money is saved out of the 
present income. Saving money is also 
necessary for old age and ill health when 
it may not be possible for people to work 
and earn their living.

(ii) Current Accounts:

Current accounts are normally 
maintained by business people. Banks are 
not offering any interest to such current 
accounts. Withdrawals from current 
accounts are not restricted.

(iii)Term Deposits:

Term deposits are maintained for 
the depositors who want to earn fixed 
return by way of interest. Term deposits 
are normally divided into short term 
deposits, medium term deposits and long 
term deposits.

(iv) Recurring Deposits: 

Recurring deposits are other types 
of deposits which are also considered as 
a term deposit in which a fixed sum of 
money is regularly deposited at regular 
intervals.

(v) Special Term Deposits:

This deposit can be opened in the 
same way as the term deposit accounts. The 
interest on this account is compounded at 
quarterly intervals and the principal and 
interest are paid on maturity. 

8.2 Core Banking Solutions:

Modern banking services include 
new products such as Core Banking 
Solutions: No frills account; Demat 
accounts; Net Banking /E-Banking;  
Mobile Banking; Debit card/Credit cards; 
Automated Teller Machines (ATM); 
Insurance etc., 
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(iii) Necessity of Banking services: 
The necessity of saving money was felt by 
people even in older days. They used to keep 
money in their homes. With this practice, 
savings were available for use whenever 
needed, but it also involved the risk of loss 
by theft, robbery and other accidents. Thus, 
people were in need of a place where money 
could be saved safely and would be available 
when required. 

(iv) Banks: Banks are such places 
where people can deposit their savings 
with the assurance that they will be able to 
withdraw money from the deposits whenever 
required. People who wish to borrow money 
for business and other purposes can also get 
loans from the banks at a reasonable rate of 
interest. Bank is a financial institution that 
accepts deposits and channels the money 
into lending activities.

(v) Lawful Organisation: “Bank is a 
lawful organization, which accepts deposits 
that can be withdrawn on demand. It also 
lends money to individuals and business 
houses that need it.” Banks also render 
many other useful services – like collection 
of bills, payment of foreign bills, safe-
keeping of jewellery and other valuable 
items, certifying the credit-worthiness of 
business, and so on. Banks accept deposits 
from the general public as well as from 
the business community. Anyone who 
saves money for the future can deposit 
his savings in a bank. Businessmen have 
income from sales out of which they have to 
make payment for expenses. They can keep 
their earnings from sales safely deposited 
in banks. Banks give two assurances to the 
depositors :

a. Safety of deposits, and 

b. Withdrawal of deposits, 

Banking Deposits: Whenever needed 
On deposits, Banks give interest, which adds 
to the original amount of deposits. It is a 
great incentive to the depositors. It promotes 
saving habits among the public. On the 
basis of deposits banks also grant loans and 
advances to farmers, traders and businessmen 
for productive purposes. Thereby banks 
contribute to the economic development of 
the country and well-being of the people in 
general. Banks charge interest on loans. The 
rate of interest is generally higher than the 
rate of interest allowed on deposits. Banks 
also charge fees for the various other services, 
which they render to the business community 
and public in general. Interest received on 
loans and fees charged for services are the 
main sources of income for banks from which 
they meet their administrative expenses.

 The activities carried on by banks 
are called banking activities. ‘Banking’ as an 
activity involves acceptance of deposits and 
lending or investment of money. It facilitates 
business activities by providing money and 
certain services that help in exchange of 
goods and services. Therefore, banking is 
an important auxiliary to trade. It not only 
provides money for the production of goods 
and services but also facilitates their exchange 
between the buyer and seller. You may be aware 
that there are laws which regulate banking 
activities in our country. Depositing money 
in banks and borrowing from banks are legal 
transactions. Banks are also under the control 
of the government. Hence they enjoy the trust 
and confidence of people. Banks depend a 
great deal on public confidence. Without 
public confidence Banks cannot survive.
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Points to be Remembered

Meaning :

A Bank is generally understood as an 
institution which provides fundamental 
banking services such as accepting 
deposits and providing loans.

Types of Deposit :

Saving Deposit, Current Deposit, 
Recurring Deposit, Term Deposit and 
Special Term Deposit.

Procedure for opening bank account :

•	 Choose the Bank

•	 Visit the convenient branch

•	 Select the accounts

•	 Provide information

•	 Consent to the terms.

•	 Find your account.

Evaluation

PART – A

OBJECTIVE TYPES:� (1 Mark)

1.	 Choose the Correct Answer :

1.	 __________________________ are very important as which involved in 
commercial activities.

	 a. Banking Services 	 b. Transport Services 

	 c. Insurance Services	 d. Maintenance Services� Ans. (a)

2.	 The Banking is a ______________________________ oriented service industry.

	 a. Seller 	 b. Buyer 

	 c. Customer 	 d. People� Ans. (c)

3.	 The bank statements are required to______________________ the bank account.

	 a. Monitor 	 b. Accept

	 c. Read 	 d. Check � Ans (a)

4.	 All Indian Banks were forced to compete with ______________________

	 a. Govt Bank	 b Reserve bank 

	 c. World Bank 	 d. Other Bank� Ans (c)
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5.	 Current accounts are normally maintained by __________________ people

	 a. Working	 b. Business

	 c. Rural 	 d. Royal � Ans (b) 

6.	 ______________________ Bank accounts require zero or very low minimum 
balance.

	 (a) Demat 	 (b) Savings 

	 (c) Current 	 (d) No frills� Ans (d)

7.	 _______________________ accounts encouraging savings habit among customers

	 a. Savings 	 b. Current 

	 c. Recurring 	 d. Fixed � Ans (a)

8.	 _______________________ are normally divided into short term, medium term 
long term deposits.

	 (a) Recurring Deposit 	 b. Term Deposit 

	 c. Current Deposit	 d. Special Term Deposit� Ans (a)

9.	 Bank is a ___________________________ institution that accepts deposits and 
lending activities

	 a Non financial	 b. Financial

	 c. Service Oriented 	 d. Technical� Ans. (b)

10.	 Banks depend a great deal on _________________________ confidence

	 a Public 	 b. Private

	 c. Government  	 d. Companies� Ans. (a)

PART – B

II.	 Very Short Answers:�  ( 3 Marks)

1.	 		 Define the term Banking.

2.	 		 Write a short note on core banking solutions.

3.	 		 What is meant by no frills account?

4.	 		 Write a note on Modern banking services.

5.	 		 What are the basic steps required to open bank accounts? 
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PART – C

III. 	 Short Answers:�  ( 5 Marks)

1.	 		 What are the procedures for opening a bank account?

2.	 		 Write short notes in maintaining bank statements.

3.	 		 Explain the types of accounts.

PART – D

IV.	 Essay Type Questions:� (10 Marks)

1.	 		 What are the forms used in banks? Explain elaborately.

2.	 		 Explain common banking services elaborately.

Teachers Activity:

•	 Teacher can arrange for a guest lecture by inviting bank manager

•	 Teacher can arrange a field trip to visit a nearby bank.

•	 Teacher can discuss how to open a savings bank account.

•	 Teacher should explain how to deposit and withdraw money from the 
bank.

Students Activity: 

Students should be asked to collect forms for opening an account, various deposit 
forms from the bank and fill it.

ACTIVITY

References :

1. https://www.brainkarl.com/article.

2. https://www.mckinsey.com/industries/finance.
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1.	 No-frills account: These accounts are opened mostly in rural  
areas without the condition of maintaining minimum balance.

2.	 KYC Forms: KYC means to “Know your Customer” which is an effective way for an 
institution to confirm and thereby verify the authenticity of a customer.

3.	 Current account: A current deposit account meant for the business class, where no 
interest is paid and withdrawal is allowed without notice.

4.	 Customer: The Individual who purchases the services from the bank.

5.	 Fixed deposit: A deposit kept for a specified term to earn interest.

6.	 Recurring deposit: A stipulated sum of money deposited at regular interval in a 
bank which is payable at the expiry of the fixed period.
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Content:

Introduction – IT and ITeS – 
Meaning – Business Process Outsourcing 
(BPO) Services- Advantages of BPO 
Services – BPO services in India – Business 
Process Management ( BPM) Industry in 
India – Definition – Structure of the IT 
– BPM Industry – Meaning – Parameters 
of IT – BPM Industry – Various IT 
Application.

Learning Objectives

•	 Enable the students to gain 
knowledge about IT and ITeS, 
that performing in Business 
operations.

•	 To acquire knowledge about 
various IT applications used 
now-a-days.

9.1 Introduction:

Information and communication 
technology (ICT) has become one of the 
inevitable requirements of the day to day 
activities of our modern society. Daily 
usage of mobile phones, laptops, electronic 
gadgets brings a lot of benefits to the 
common people and also to the industries 
those who are engaged in various fields 
of expertise. Information Technology 
(IT) is one of the world’s fastest growing 

economic activities, which envisages 
easier flow of information at various levels 
in the desired pattern. The Information 
Technology enabled Services (ITeS) sector 
has also made significant contributions 
to the growth and development of our 
country. 

Fig. 9.1 Information Technology 

9.1.1 Meaning:

Information technology (IT) 
means creating, managing, storing and 
exchanging information. It includes all 
types of technology used to deal with 
information, such as computer hardware 
and software technology used for creating, 
storing and transferring information. 
Computer takes data as input and 
processes it and produces the results as 
output. 

Information technology that 
enables the business by improving 
the quality of service is Information 
Technology enabled services (ITeS) is also 
called web-enabled services or remote 

IT AND ITeS SERVICES

UNIT – 99
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(iii)	 E-Publishing and web promotion

(iv)	 Legal Services and content writing

(v)	 Multimedia and design services

(vi)	 Health care services

Fig. 9.3 Business Process Outsourcing 

9.2.2 �Advantages of BPO services:

Some of the important benefits or 
advantages of BPO services as follows:

(i)	 Decreased costs: Outsourcing reduc-
es costs for labour, generally when it 
comes to staffing and training 

(ii)	 Able to concentrate on core compe-
tencies 

(iii)	 Increased flexibility

(iv)	 Expand global presence 

(v)	 Improved speed and efficiency

(vi)	 Security issues

(vii)	 Communication issues

9.2.3 BPO Services in India:

Business Process Outsourcing 
(BPO) service in India refers to tasking 
out certain functional tasks to a third-
party service provider. Internal business 

services that cover the entire operations 
which exploit Information Technology 
for improving the efficiency of an 
organisation. 

Fig. 9.2 Information Technology Enabled  
Services

9.2 �Business Process Outsourcing (BPO) 
Services:

Business Process Outsourcing 
(BPO) services means performing business 
operations through an outside service 
provider. BPO also comes under IT services 
as IT plays a very useful role in optimising 
the business performance.

9.2.1 Some of the Important BPO 
Services are listed below:

(i)	 Financial and accounting services

(ii)	 Taxation and insurance services
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functions such as billing and purchasing 
are outsourced, while front-of-house 
functions including customer support, 
marketing, and product customization 
are outsourced. All you need to do is 
to understand what services you wish 
to outsource and services you want to 
keep in-house. BPO services in India are 
growing at a fast pace and expanding to 
assist with services like conventional back 
and front office functions to services like 
digital marketing services and social media 
marketing. Moreover, BPO services can 
help you save big on cost, offer flexibility, 
agility, and access to tools and processes.

9.2.4 Classsification of major BPO 
Services:

(i) Information Technology enabled 
Services (ITeS)- It is a type of BPO service 
that manages and handles IT solutions 
over the internet. It involves handling IT 
services like technical support, production 
support analyst, and service desk analyst.

(ii) Knowledge Process Outsourcing 
(KPO)- In this type of outsourcing, the 
service provider offers advanced expertise 
for any particular business process.

(iii) Legal Process Outsourcing 
(LPO)- It offers services related to 
a high level of legal work. They also 
perform complex tasks like writing legal 
agreements, doing legal research, and 
drafting patent applications.

(iv) Recruitment Process 
Outsourcing (RPO) - It is when a company  
transfers all or part of its permanent 
recruitment to an external provider.

9.2.5 Advantages of BPO Service 
Industry:

(1) BPO service providers in India 
invest in hi-tech hardware and software to 
deliver the best of services. They follow 
quality checks to ensure error free and 
exceptional service.

(2) Government of India is 
encouraging the BPO Industry in India by 
providing necessary  Infrastructure and 
logistical support.

(3) BPO Industry in India is highly 
developed and capable of delivering 
numerous types of BPO services in 
exceptional quality.

9.3 �Business Process Management 
(BPM) Industry in India:

The IT-BPM (Business Process 
Management) industry has been 
fuelling India’s growth. In addition to 
contributing towards the country’s Gross 
Domestic Product (GDP) and exports, 
the growth of the IT BPM industry 
has provided India with a wide range 
of economic and social benefits which 
includes creating employment, raising 
income levels, and promoting exports. It 
has placed India. On the world map with 
an image of a technologically advanced 
and knowledge-based economy. This 
sector attracts amongst the largest 
investments by venture capitalists and 
has been credited with enabling the 
entrepreneurial ventures of many in 
the country. The IT-BPM industry has 
almost doubled in terms of revenue and 
contribution to India’s GDP over the last 
decade (2008–18).
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headquarters in India. While having 
offices in many international locations. 
While most have a client base, which 
is global as well as domestic, there are 
some that have focussed on serving 
only the Indian clients.

(c) Global In-house centres (GIC): GIC 
organisations cater to the needs of 
their parent company only and do not 
serve external clients.

(d) The Indian IT industry has more than 
16,000 registered companies in the 
sector across GIC, MNC and SME 
categories as of 2016. Concentration 
Ratio in the IT-BPM industry is very 
high with 11 players contributing to 
more than 40% of the revenue. The 
Indian IT-BPM sector is home to the 
world’s 3rd largest start-up community 
with more than 2000 start-ups across 
e-Commerce, aggregator platforms, 

9.3.1 Definition:

Business process management 
(BPM) is “an organizational discipline 
where a company takes a step back and 
looks at all of these processes in total 
and individually. It analyses the current 
state and identifies areas of improvement 
to create a more efficient and effective 
organization.”

9.4 Structure of the IT-BPM industry:

(a) Multinational Companies (MNCs): 
MNCs have their headquarters 
outside India but operate in 
multiple locations worldwide 
including those in India. They cater 
to external clients (both domestic 
and/or global).

(b) Indian Service Providers (ISPs): ISPs 
started with their operations in India. 
Most of these organisations have their 

Fig. 9.4 Business Process Management 
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analytics, consumer services and IoT 
alone.

9.4.1 Parameters of IT-BPM industry:

The organisations within the IT-
BPM industry are categorised along the 
following parameters:

•	 Sector the organisation is serving

•	 Type as well as range of offering 
the organisation provides

•	 Geographic spread of operations

•	 Revenues and size of operations

9.5 Various IT applications:

In technologically developed 
nations, Information Technology has 
become a part of everyday life. For a user, 
a computer is a tool that provides the 
desired information, whenever needed. 
The use of computer and Information 
Technology can be observed at home, 
workplace, in the modern service 

industry and in all aspects of our life. It 
includes listening to music, watching 
movies, playing games, doing office 
work, chatting and sending messages, 
managing daily planner, reading books, 
paying utility bills, booking tickets to 
travel, bank operations, etc. Computers 
and ICT are used in industries, in 
offices, and in houses also. The various 
application areas are business, banking, 
insurance, education, marketing, and 
health care, engineering design, military, 
communication, animation, research, 
agriculture and government. 

Information and communication 
technology (ICT): It can impact student 
learning when teachers are digitally 
literate and understand how to integrate 
it in to curriculum. Schools use a 
diverse set of ICT tools to communicate, 
create disseminate, store and manage 
information.

Points to be Remembered

•	 Information technology means 
creating, managing, storing and 
exchanging information.

•	 IT that enables the business by 
improving the quality of service is ITes.

•	 BPO means performing business 
operations via an outside service 
provider.

•	 IT BPM industry provides India, 
wide range of social and economic 
benefits.

•	 MNC, ISP and GIC are the 
structure of the IT – BPM Industry.  
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Evaluation

PART – A

OBJECTIVE TYPES:

I .	 Choose the Correct Answer :� (1 Mark)

1. 	 One of the world’s fastest growing economic activities, which envisages easier flow 
of information at various levels in the desired pattern in ________________

	 a. Information technology	 b. Informative theory

	 c. Information theory 	 d. Internet Times � Ans ( a)

2.	 BPO stands for ___________________________

	 a. Business Process Optimization 	 b. Business Process Object

	 c. Business Process Outsourcing	 d. Business Programs Office.� Ans ( c)

3.	 _______________________ is one of the advantages of BPO Services.

	 a. Increased costs 	 b. Decreased flexibility

	 c. Decreased costs 	 d. Inefficient.� Ans (c )

 4.	 _____________________ _ is the type of outsourcing, offers advanced expertise 
for any particular business process.

	 a. RPO 	 b. BPO 

	 c. KPO 	 d. LPO� Ans ( c)

5.	 G D P stands for ____________________________

	 a. Gross Domestic Product	 b. Good Distribution Practice

	 c. General Data Processor	 d. General Domestic Product� Ans (a)

6.	 Which one identifies areas of improvement to create a more efficient and effective 
organization?

	 a. Business process outsourcing	 b. Business process management

	 c. Information technology	 d. Level process outsourcing� Ans (b)

7.	 ________________________ organization caters to the needs of the parent 
company only and does not serve external clients.

	 a. Indian service providers	 b. Global In – house centres

	 c. Multinational companies	 d. SME� Ans ( b)
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8.	 Indian IT Industry has more _______________________ registered companies 
in the sector across GIC, MNC and SME categories as of 2016.

	 a. 18,000 	 b.17,000 

	 c. 16,000 	 d. 15,000 � Ans ( c)

9.	 ICT Abbreviation is _________________________

	 a. �Information & Communication  
technology	

b. �Information & Computer  
technology

	 c. �Information Centre  
technology	

d. �International Currency  
technologies.� Ans (a)

10.	 The IT – BPM Industry has almost _____________________ in terms of revenue 
and contribution to India’s GDP over the last decade.

	 a. Doubled 	 b. Singled 

	 c. Tripled 	 d. First� Ans ( a) 

 PART - B

II	 Very Short Answers: � ( 3 Marks)

1.	 		 Write important BPO Services ?

2.	 		 Write any 5 advantages of BPO services?

3.	 		 Define BPM

4.	 		 What are the various IT applications area?

5.	 		 What are the parameters of IT – BPM Industry.

PART - C

III	 Short Answers: 							       (5 Marks)

1.	 		� What is Business Process outsourcing (BPO) service and write important of BPO 
services.

2.	 		 Write structure of the IT-BPM industry.

3.	 		 Write abbreviations for the following 

		  a) ICT, b) IT c) ITeS d) BPO e) BPM f) KPO g) GDP h) ISP
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PART - D

III	 Essay type questions: 							       (10 Marks)

1.	 		 Explain BPO services in India.

2.	 		 Define BPM and explain BPM industry in India

Teachers Activity:

1.	 Field visit to various BPO service can be arranged to understand the 
functions of BPO services

2.	 Can take the students to nearby MNC to show the working of MNC

Students Activity: 

1.	 List out the major BPO services in Tamilnadu

2.	 Chart preparation of leading BPO companies with short profile

ACTIVITY

References :

1.	 	Electronics Corporation of Tamil Nadu Limited “Annual Reports”. Available from: 
https://elcot.in/betaversion/ annual reports.

2.	 	Electronics Corporation of Tamil Nadu Limited “ELCOT Manual”. Available from: 
https://www.elcot.in/files/ ELCOT Manual.pdf.

3.	 	Information Technology Department “Policy Note 2011-2012”, Available from: http://
cms.tn.gov.in/sites/ default/files/documents/information technology_2. pdf.

4.	 	Ministry of Electronics and Information Technology “Annual Reports”. Available from: 
http://meity.gov. in/content/annual-report.

5.	 	Software Technology Parks of India “Annual Reports”. Available form: https://www.
stpi.in/11042.

6.	 	IT and ITES Industry in India. Available form: http:// www.ibef.org/industry/
information technology.aspx.
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1.  IT-Information Technology (IT) is one of the world’s fastest growing economic activities, 
which envisages easier flow of information at various levels in the desired pattern. The 
Information Technology enabled services 
2.  ITes-ITeS sector has also made significant contributions to the growth and development 
of our Country.
3.  Business-A business is defined as an organization or enterprising entity engaged in 
commercial, industrial, or professional activities. Businesses can be for-profit entities or 
non-profit organizations.
4.  Information-Information is processed, organized and structured data
5.  Technology-Technology refers to methods, systems, and devices which are the result of 
scientific knowledge being used for practical purposes
6.  BPM-Business process management (BPM) is “an organizational discipline where a 
company takes a step back and looks at all of these processes in total and individually.
7.  Outsourcing-Outsourcing is the business practice of hiring a party outside a company 
to perform services or create goods that were traditionally performed in-house by the 
company’s own employees and staff.
8.  BPO services-Business Process Outsourcing (BPO) services means performing business 
operations through an outside service provider.
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Office Management and Secretaryship

MODEL QUESTION PAPER

										          Marks : 90	

										          Duration : 3 hrs.

PART – A

Answer all the questions:							      Marks : 15x1 = 15

I.	 Choose the best Answer:

1.	 Planning is the ------------------------ function of office management.

	 a) Best 					     b) First

	 c) Basic 					     d) Important

2.	 Direction can thus be regarded as the process of ------------------------ staff.

	 a) Planning 					     b) Organising

	 c) Guiding and Supervising 		  d) Administrative

3.	 -----------------  must provide good and satisfactory working conditions.

	 a) Office Accommodation 		  b) Office Layout

	 c) Office Environment 			   d) Office Building

4.	 Roof ventilation and internal tube ventilators provide ----------------- ventilation.

	 a) Natural 					     b) Artificial

	 c) Direct 					     d) Indirect

5.	 The use of Security cameras can ---------------------------------- activities.

	 a) Supervise 					    b) Check

	 c) Evaluate 					     d) Monitor

6.	 There are ---------------------------------- methods of classification of files.

	 a) 4 						      b) 3

	 c) 5 						      d) 6

Standard – XI
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7.	� -------------------------------- is referred as a document used by an organization to 
carry out its different tasks.

	 a) Filing 					     b) Record

	 c) Indexing 					     d) Personal Record.

8.	 ----------------------------- is the free software for managing projects.

	 a) Canva 					     b) Xtensio

	 c) Trello 					     d) Fresh Desk

9.	 Cloud Computing provides an alternative to the on-premises ----------------------.

	 a) Data Center 				    b) Data Software

	 c) Data Systems 				    d) Clouding

10.	� A good office ----------------------------- shall bring in lot of laurels to an organi-
sation.

	 a) Atmosphere 				    b) Systems and Procedures

	 c) Policy Manual 				    d) Practice Manual

11.	� ------------------------ is composed of a pattern of office system, procedure and 
methods.

	 a) Administration Work 			   b) Office Work

	 c) Organisation Work 			   d) Group Work

12.	 A collection of ------------------------ make a table.

	 a) Field 					     b) Table

	 C) Database 					    d) Record
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13.	 ------------------------ accounts encouraging savings habit among customers

	 a) Savings 					     b) Current

	 c) Recurring 					    d) Fixed

14.	� Bank is a ------------------------------ institution that accepts deposits and  
lending activities.

	 a) Non-financial 				    b) Financial

	 c) Service Oriented 			   d) Technical

15.	 ICT Abbreviation is -------------------------------------

	 a) Information & Communication	 b) Information & Computer 
	 technology	 technology

	 c) Information Centre technology	 d) International Currency
	 technology

PART – B

II.	 Answer any TEN questions:  
	 Question number 28 is compulsory.				    Marks: 10x3 = 30 

16.	 Who is the office manager?

17. 	 What is meant by Automation?

18. 	 What is a shared workspace?

19.	 What are safety measures?

20.	 Write a short note on modern office furniture.

21.	 Write a short note on office stationeries.

22.	 What is meant by Filing?

23.	 Give any two examples for office management software.

24.	 What is ABW?

25.	 What are the types of office manuals?
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26. 	 What is the primary key?

27.	 Explain the types of accounts.

28.	 Write short notes on Multinational company.

PART - C

III.	 Answer any FIVE questions
	 Question number 35 is compulsory.				    Marks: 5 x 5 = 25

29.	 State the objectives and importance of office layout.

30.	 What are the uses of office furniture?

31.	 What are the types of filing?

32.	 Discuss the importance of BYOD.

33.	 Explain about different types of keys in relational database.

34.	� What is Business Process Outsourcing (BPO) service and write important of BPO 
services.

35.	 Explain about banking deposits elaborately.

PART- D

IV.	 Answer all the questions:						      Marks: 2x10= 20

36.	 Explain the importance and functions of office Management.

				    (or)

	 Explain the advantages and disadvantages of office layout.

37.	 Explain the advantages and disadvantages of cloud computing.

				    (or)

	 Explain BPO services in India.
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Introduction Typing:

Typing is the art and technique of 
using letters and characters in a readable, 
legible and appealing format when 
displayed. The arrangement of type involves 
selecting typefaces, point sizes, line lengths, 
the spacing, letter spacing and adjusting the 
space between pairs of letters.

Introduction – Typewriter

Typewriter is a small machine, either 
manual or electrical. It has keys that produce 
letters on a piece of paper when operating it.

In 1714, Englishman Henry Mill filed 
a patent for a machine for the impressing 
or transcribing of letters progressively one 
after another.

Noiseless typewriter was developed 
by Wellington Parker Kidder in 1947.

1. Fingering charts :

Keyboard finger charts left and 
right finger, include home row keys, for 
lessons, to improve or learn how to type 
faster. Each finger rests on a particular 
key in the home row of the keyboard 
when not typing.

Fingering charts

1st Row 1 2 3 4 5 6 7 8 9 0

2nd Row Q W E R T Y U I O P

3RD Row A S D F G H J K L ;

4TH Row Z X C V B N M , . /

INTRODUCTION OF TYPEWRITING
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Left  hand Covers the “asdf ” in the home row 
keys while the right hand covers the “lkj;” 
and the thumb covers space bar.

1.2.2.  Mechanism of typewriter 
and its parts 

1. Handle / Line Space Lever 

2. Plunger knob 

3. Th umb Wheel 

4. Cylinder Release Lever 

5. Line Space Lever 

6. Carriage Release Lever Left  

7. Left  Hand Margin 

8. Margin Scale 

9. Type bar guide 

10. Ribbon Carrier 

11. Segment 

12. Paper bail Roller 

13. Right hand Margin

 

14. Cylinder (Platen Roller) 

15. Carriage Release Roller Right 

16. End of the Paper Indicator 

17. Cowl Cover 

18. Carriage 

19. Margin Release Key 

20. Shift  Lock 

21. Shift  Key 

22. Tabulator Bar 

23. Space Bar 

24. Ribbon Colour Indicator

1.4 Typing ergonomics 

Manual typewriters are independent 
from electrical and digital networks. It can 
be used at remote locations where electrical 
service is intermittent.13. Right hand Margin
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EXPERIMENT : 1

FIRST FINGERING – FIRST STEP

Objective :

To start typing practice as First Fingering – First Step.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following line 50 times for 2 days.

Subject :

		  asdf	 ;lkj	 asdf	 ;lkj	 asdf	    ;lkj 	

Step 3:  Typed papers should be filed properly

Result:

Thus First Fingering - First step was typed successfully.

Tools Required for Experiments (1-23)

S.No Name of the tools/equip-
ment

Range/Value Quantity in Nos

1 Typewriter Metal Casting 1
2 Ribbon/Colour  Nylon ribbon/Commonly used Navy 

Blue, Black & Red
1

3 Paper A4 size 2
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EXPERIMENTS – 2 

TO START TYPING PRACTICE AS FIRST FINGERING – SECOND STEP.

Objective : 

Students can practice typing of Ist fingering II step

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following line 100 times for 4 days.

Subject :

asdfgf	 ;lkjhj	 asdfgf 	 ;lkjhj 	 asdfgf 	 ;lkjhj

Step 3:Typed papers should be filed properly

Result :

Thus First fingering - Second step was typed successfully.
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EXPERIMENT : 3

FIRST FINGERING – WORDS PRACTICE

Objective :

To start typing practice as first Fingering – Words.

Procedure:

Step 1:Insert the papers properly

Step 2:Type the following each lines 15 times

Subject:

ask jag dash kala shal flash
fad slag hash alga ladak allah
has  all lash dass salad dhall
gal  lash  gall sash kajal jaffa 
sad  aha lass aska fagal slash
sag lala gaff shed safal lakhs
had gag fall half alkal halsh
ash flag glas shag halka sagas
lag gad shah agad fills jalal
gas hall saga kaka glass algas

Step 3:Typed papers should be filed properly.

Result :

Thus fingering - Words was typed successfully.
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EXPERIMENT : 4

SECOND FINGERING – FORWARD LETTERS

Objective : 

To start typing practice as Second Fingering – Forward Letter.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following line 100 times for 4 days.

Subject : 

awerqfa  ;oiupj awerqfa ;oiupj awerqfa ;oiupj  

Step 3:Typed papers should be filed properly.

Result : 

Second Fingering – Forward Letter was typed successfully.

Typography_Exp1-23.indd   107 26-04-2022   18:52:34

www.tntextbooks.in



108

EXPERIMENT : 5

SECOND FINGERING – FORWARD – WORDS PRACTICES

Objective : 

To start typing practice as Second Fingering - Forward words.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following each line 15 times 

Subject:

asp were grass herald federal

dug sale equip  jaguar leopard

oak idle fakir girder sparkle

que joke horse perish esquire

who rise arrow differ illegal

irk keep pedal squash worship 

kid urge laugh washer quarrel 

use fish grape afresh require 

low guid irish oppose hopeful

ego rusk sidle liquor jealous

Step 3:Types papers should be filed properly

Results : 

Second Fingering - Forward words was typed successfully.
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EXPERIMENT : 6

SECOND FINGERING – REVERSE – LETTERS PRACTICE

Objective : 

To start typing practice as Second Fingering - Reverse letters.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following line 50 times for 2 days.

Subject :

gftfrf hjyjuj gftfrf  hjujyj gftfrf hjujyj

Step 3:Typed papers should be filed properly

Result :

Second Fingering - Reverse letters was typed successfully.
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EXPERIMENT : 7

SECOND FINGERING – REVERSE – WORDS

Objective : 

To start typing practice as Second Fingering - Reverse words.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following line 15 times 

Subject :

apt east tight gaiety iterate

joy sway hasty future oratory

day host party quarry whistle

let just ought yellow satisfy

hut lady kitty repeat tragedy

was gift quest outlay royalty 

toy kite jolly poetry lateral

yet quit lotus trophy destroy 

jet fray tough strike yoghurt

spy west draft august utility.

Step 3:Typed papers should be filed properly

Result :

Second Fingering - Reverse words was typed successfully.
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EXPERIMENT : 8

THIRD FINGERING –FIRST STEPS

Objective : 

To start typing practice as Third fingering – First steps.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following line 15 times for 4 days.

Subject:

azxcvf ;,mnbj azxcvf ;,mnbj 

azxcvf ;,mnbj azxcvf ;,mnbj 

Step 3:  Typed papers should be filed properly

Result :

Third fingering – First step was typed successfully.
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EXPERIMENT : 9

THIRD FINGERING –WORDS

Objective : 

To start typing practice as Third fingering – Words.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following lines Each 15 times.

Subject:

wind equip colour brough penalize convinced hereditary 

have night answer realise fortieth dorminates excitement

give woven verbal elegant machines formulate tremendous

verb enemy nerves minimum exponent doubtless extinguish

Step 3:Typed papers should be filed properly.

Result :

Third fingering – Words was typed successfully.
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EXPERIMENT : 10

FULL ALPHABETS (FORWARD & REVERSE)

Objective : 

To start typing practice as Full alphabets (forward & reverse).

Procedure :

Step 1:Insert the papers properly 

Step 2:Type the following lines 75 times for 3 days.

Subject :

abcdefghijklmnopqrstuvwxyz., 	 ;zyxwvutsrqponmlkjihgfedcba

Step 3:Typed papers should be filed properly.

Result :

Full alphabets (forward & reverse) was typed successfully.
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EXPERIMENT : 11

FULL ALPHABETS – WORDS

Objective :

To start typing practice as Full Alphabets – Words.

Procedure :

Step 1:Insert the papers proper 

Step 2:Type the following lines each 15 times

Subject:

terms banker receipt midnight community vocabulary philosopher

dozen victim forward invested patronage honorarium diversified 

mount ultimo proximo esteemed materials experience subordinate

bonus parcel furnish expected newspaper competitor appropriate

bunch liquid instant vehicles endeavour convenient rationalism

Step 3:  Typed papers should be filed properly

Result :

Full Alphabets – Words was typed successfully.
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EXPERIMENT : 12

PRACTICE OF SIGNIFICANTLY USED WORDS

Objective :

To start typing practice as Significantly used words.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following lines each 15 times

Subject:

Monday January Srinagar Bangalore Refreshing

Ulysses Destructive  Sunday variety Material

September Population  Therein Opportunity  Wright

Quality Adultery Knowledge Government Neutral

Deteriorate Yellow Zoology Hertzian Dimension

Industrial Lottery Environment Museum Fortune

Umbrella Catalogue Pedestrian Yielder Recognition

Step 3:  Typed papers should be filed properly

Result :

Significantly used words was typed successfully.
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EXPERIMENT : 13

PRACTICE OF ALPHABETS WITH NUMERICAL NUMBERS

Objective :

To start typing practice as alphabets with numerical numbers.

Procedure :

Step 1:Insert the papers properly 

Step 2:Type the following lines each 75 times for 3 days.

Subject:

912345f ;09876j  912345f ;09876j 912345f ;09876j

Step 3:Typed papers should be filed properly

Result :

Alphabets with numerical numbers was typed successfully.
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EXPERIMENT : 14

PRACTICE OF NUMERICAL NUMBERS

Objective :

To start typing practice as numerical numbers.

Procedure :

Step 1:Insert the papers properly 

Step 2:Type the following lines each 15 times.

Subject:

23487 28958 76390 61851 64891 14021 19659 64813

85232 92831 65481 57342 57842 62835 56021 37254

75273 72160 40825 83651 83651 12525 90643 59642

23258 13829 18456 24375 24875 53826 12065 45273

37257 06127 52804 15638 15638 52521 34609 24695

Step 3:Typed papers should be filed properly.

Result :

Numerical numbers was typed successfully.
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EXPERIMENT : 15

PRACTICE OF LARGE NUMERICS

Objective :

To start typing practice as Large numbers.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following lines each 15 times.

Subject:

281652 6,45,910 7,56,083 2,75,083, 4,05,464 1,92,654

7,02,934 3,69,237  5.84,903 8,20,648 9,50,909 8,68,321

5,80,712 1,47,015 3,64,781 6,08,426 7,27,676 6.29,422

2,71,085 5,10,741 1,87,4632 6,24,908 6,96,291 2,64,916

2,56,182 0,19,495 1,80,695 3,05675 4,64,506 4,59,29

Step 3:Typed papers should be filed properly

Result :

Large numbers were typed successfully.
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EXPERIMENT : 16

PRACTICE OF SMALL SENTENCES

Objective :

To start typing practice as small sentences.

Procedure :

Step 1:Insert the papers properly 

Step 2:Type the following sentences each 10 times.

Subject :

Pack my box with five dozen liquor jugs

May we have Jack squires fix the big lamp for Andy Zieler?

Untouchability is a sin. Untouchability is a crime and also  
inhuman.

We must be proud of our Nation.

The French war was sin the year 1709

Step 3:Typed papers should be filed properly.

Results :

Small sentences were typed successfully.
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EXPERIMENT : 17

PRACTICE OF  PASSAGE

Objective :

To start typing practice as to make “Passages”.

Procedure :

Step 1:Insert the papers properly 

Step 2:Type the following passage 5times each.

Subject :

Our flag is a tri-colour saffron is the symbol of sacrifice and a 
strong mind. White is the symbol of purity, love and peace. Green 
is the symbol of plenty and joy. We hoist and salute our flag. We are 
ready to make sacrifices for our county. We want peace and prog-
ress.  We want the purse. Our National Flag has the Ashok Chakra 
on it. This wheel is a symbol of DHARMA. If we always do the right 
things, we follow DHARMA. The twenty four spokes in the wheel 
show the differences between our – people. A small circle connects 
these spokes. It shows that we are alike. The wheel also shows that 
we are going forward.

Step 3:Typed papers should be filed properly.

Result :

“Practice” was typed successfully.
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EXPERIMENT : 18

PRACTICE OF  MAKING  INVITATIONS.

Objective :

To start typing practice to make“invitation typing”.

Procedure :

Step 1:Insert the papers properly 

Step 2:Type the following  invitations 2 times each.

Subject :

Advertisement – Invitation

NIRMALA RAVINDRAN IAS ACADEMY

Cordially invites you to the Inaugural

Function of Academy’s

SIVASWAMY EDUCATIONAL AND

CHARITABLE TRUST

To ensure upliftment of the differently abled

Students, economically, socially, deprived rural and Urban students.

RUSH ! HURRY – UP !

SEATS ARE FIRST CUM FIRST BASIS

CONTACT : OFFICE

Plot No 869/24, 6th Avenue, Sai Baba Colony, Rani Nagar,

AB Block, Rani Nagar

Chennai – 600 088.

On

2nd June, 2018@ 5.00 P.M.

Director, Swamy IAS Academy
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RECEPTION

Place : Rani maniammai Marriage Hall,

No. 79, Krishnappa Nagar,

Kavangarai,

Chennai – 72.

Date : 12th June, 2018

Time : Evg 6 pm. to 9.00 p.m.

Music Party :

Film Famous BackGround Singer

Murali Krishna

Presents – ‘Subh Raag’.

Step 3:Typed papers  should be filed properly.

Result : 

Invitation was typed successfully.
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EXPERIMENT : 19

PRACTICE OF MAKING NOTICE

Object :

To start typing practice to make “notice”.

Procedure :

Step 1:Insert the papers properly 

Step 2:Type the following notice 2 times each

Subject :-

NOTICE

SUGANTHI TEXTILES PRIVATE LIMITED

Registered Office : 
4, SBI Main Road, 

Chittoor – A.P.

NOTICE

Notice is hereby given that the 20th Annual General Meeting of the Company will be 
held at its. Registered thereon Office at 3.00 pm. On Monday the 28th February 2010 to 

transact the following business:

To adopt the audited statement of Accounts for the year ended 31st December, 2009,  
And the Directors thereon.

To elect two Directors

To appoint an Auditor and fix his remuneration.

(By order of the Board)

Chittoor,	 S.J.Pradeepkumar,

5th February 2010	 Secretary.

Step 3:Typed papers should be filled properly
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Result :

“Notice” was typed successfully.

EXPERIMENT : 20

PRACTICE OF ABBREVIATIONS AND SYMBOLS

Object :

To start typing practice as abbreviations and symbols.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following abbreviations and symbols 2 times each

Subject :-

List of standard Abbreviations

SYMBOL MEANING
w/ With  (something)
w/o Without
w/i Within
i.e That is
e.g For example
Etc Et cetera, so forth
Bc Because
B4 Before
Re: Regarding, about
Esp Especially
Min Minimum
Max Maximum
Govt Government
ASAP As soon as possible
Wrt Write
Rt Right
Yr / yrs Year, years
c. Circa, about, around, from the year
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SYMBOL MEANING
Vs Versus, as opposed to
Ch Chapter
Q a Question answer
Ex Example
Wd wds Word words
Ref Reference
Diff Difference
w.r.t With reference to
w.e.f With effect from

Beginning words abbreviation Ignoring vowels
•	 Pol - politics

•	 Gov - government

•	 school Sub – subject

•	 Info – information

•	 Intro - introduction

•	 Prblm – problem

•	 Schl - school

•	 Bkgd - background

Beginning words using last letter Ignoring ‘ing’
•	 Govt – government

•	 Gov’t – government

•	 Interl – international

•	 Inter’s - international

•	 Ckg – checking

•	 Ckng – checking

•	 Ck’g - checking

Step 3:Typed papers should be filed properly
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Result :

abbreviations and symbols were typed successfully.

EXPERIMENT : 21

PRACTICE OF MAKING BUSINESS LETTERS.

Object :

To start typing practice to make “Business Letters”.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following business letter 2 times each

Ref. No. 8/27										          20th Nov. 2016.

	

Subject :
Type the following Business letter.

XXX FORGINGS INDIA LTD.,

( Mfrs. of Quality forgings)

TelephoneNo.

P.B.No,39

No.29, Amman Road

Chennai – 600 018.

Dear Sir,

We are in receipt of your notice 10th Oct’ 2016. Asking us to appear before you on the 20th 
Nov.2016  necessary slot.

We have forwarded all our a/c books and other relevant documents to our auditor.

Thanking  you,

								        For XXX Forgings India Ltd.,

											           (K.SAR RAM)

											           Fin. Manager.

Step 3:Typed papers should be filed properly.
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Result : 

Business letters was typed successfully.

EXPERIMENT : 22

PRACTICE OF OFFICIAL LETTER.

Object :

To start typing practice to make “Official Letter”.

Procedure :

Step 1:Insert the papers properly

Step 2:Type the following official  letter 2 times each

Subject :

(IV) Official Proceedings :  ( Model)

PROCEEDING OF THE COLLECTOR, 

SALEM

PRESENT : THIRU. D.YUVARAJ, I.A.S.,

Collector.

S.Dis.235/77 � Dated the 14th February 1977

Sub. : �Committees – Committee on Government Assurances of Legislative  Assembly 
– Meeting held at Salem from 6th to  8th August 1976 -  Transport Charges – 
Expendituresanctioned.

Ref. :  (i) G.O.Ms. No. 49, Legislative assembly, dated the 3rd August 1976.

	        (ii) Letter No. B4/843/76, dated the 11th September 1976, from the Tahsildar, 
Attur.

In pursuance of the order in G.O. Ms. 49, legislative Assembly, dated the 3rd August 1976, 
sanction is accorded for incurring an expenditure  not exceeding Rs. 1500/- (Rupees one 
thousand and five hundred only) being the charges for fuel supplied by Messrs. Indo Amer-
ican products Caltex distribution company. Attur. To jeep no. 9958 and TN 23 were allotted 
in connection with the meeting of the Committee on Government Assurance of the Tamil 
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Nadu Legislative Assembly held at Salem from 6th to 89th August 1976.

The Tahsildar, Attur is authorized to settle the bills, duty certifying that the said sum has not 
been settled previously.

Collector

To

The Tahsildar, Attur – 636 108.

Copy to

The Sub-Treasury Officer, Attur 636108.
The Secretary to Government, Legislative Assembly
Department, Madras – 600 008.

Step 3:Typed papers should be filed properly.

Result : 

“Official Letter” was typed successfully.
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EXPERIMENTS – 23

PRACTICE OF TYPING IN RAPID TYPING SOFTWARE

Objective : 

To start typing practice in rapid typing tutor software.

Procedure :

Step 1:Install the software(Rapid typing tutor 5.3)  on the computer.

Step 2:Open Rapid typing 5 software and click EN.1 introduction and click the 1.Basics 
lesson 1.

Step 3:Practice the Basics lesson 1 to Basics lesson 9.

Step 4:Take the screenshots of the result of lesson 1 to lesson 9.

Result :

Thus the lesson 1 to lesson 9 in introduction was typed successfully In rapid typing software..
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EXPERIMENT : 24

ARRANGEMENTS OF VARIOUS GADGETS AND ACCESSORIES  
OF COMPUTER FOR ITS OPERATIONS: -

Objective:

To learn the procedure of connecting and disconnecting different external Input and Output 
devices with the computer.

Operations/Experiments Covered Under the Project:

•• Identification of parts of computer

•• Identification of ports in CPU

•• Connecting the devices

Safety Measures:

1.	 Before placing your computer on a desk or table make sure it is set up near an electrical 
outlet and network/phone jack.

2.	 The keyboard should be reachable, the CPU should be well-ventilated, the monitor 
should be in full view and the mouse should be set up depending on which hand you 
plan on using.

3.	 Turn off the power and unplug equipment before performing service.

4.	 Cover sharp edges inside the computer case with tape.

5.	 Never open a power supply or a CRT monitor.

Tools and Equipment Required: 

Activity Title Sl.No Name of the apparatus/ 
components

Range/Value Quantity

Identification of parts of 
computer

1 Central Processing Unit I5-Dual Core 1
2 Keyboard 108 Keys 1
3 Monitor 14” LED 1
4 Mouse Optical 1
5 Printer Laser/Inkjet 1

COMPUTER APPLICATION EXP 24-38

Auditing Related Computer Applications

Auditing Related Computer Applications
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Identification of the 
ports in CPU

Central Processing Unit 15 Dual core 1

Connecting the devices Central Processing Unit I5-Dual Core 1

Keyboard 108 Keys 1

Monitor 14” LED 1

Mouse Optical 1

Printer Laser/Inkjet 1

Procedure:

Section 1. Identification of Parts:

a) CPU: The Central Processing Unit (CPU), also called as processor, is located inside 
the computer case on the motherboard. It is also called the brain of the computer and 
its job is to carry out commands. Whenever you press a key or click the mouse or start 
an application you are sending instructions to the CPU.

FIGURE 24.1 CPU.

b) Monitor or Screen:  This is the TV-type screen on which you can see the work you 
are doing on your computer.
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FIGURE 24.2 Monitor

c) Keyboard: The keyboard is one of the main ways to communicate with a computer. 
There are many different types of keyboards, but most are very similar and allow you 
to accomplish the same basic tasks.

FIGURE 24.3 Keyboard

d) Mouse: The mouse is another important tool for communicating with computers. 
Commonly known as a pointing device. It lets you to point the objects on the screen, to 
click on them, and move.

FIGURE 24.4 Mouse
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Section 2 . Identification of Ports in CPU :

FIGURE 24.5 Identification of ports in CPU

Step 1: Identify the power connector, smps cooling fan, CPU cooling fan, switch and 
screw.

Step 2: Identify the PS/2 port, USB port, Parallel port, VGA port, Ethernet port and 
Audio jacks in CPU.

Step 3: Identify the expansion slots and expansion cars in the CPU.

Section 3: Connecting the devices:

A) Setting up a Desktop computer

Step 1: Unpack the monitor and computer case from the box. Remove any plastic cover 
or protective tape. Place the monitor and computer case on a desk or work area.
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FIGURE 24.6 Desktop computer

Be sure to place your computer in an area that is well ventilated and has good airflow. 
This will help you to prevent the computer from overheating.

 

FIGURE 24.7 Ventilated CPU

Step 2 : Locate the monitor cable. There are several types of monitor cables. The one for 
your computer may not look a like the other one shown below.
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FIGURE 24.8 Monitor cable

If you are finding trouble with your monitor cable, refer to the instruction manual of 
your computer.

Step 3 : Connect one end of the monitor cable port on the back of the computer case and 
the other end to the monitor. If you’re using a VGA cable like the one in the picture 
below, you have to tighten the screws on the monitor cable to secure it.

Many computer cables only fit in a specific way. If the cable doesn’t fit, don’t force it. It 
might damage the connectors. Make sure the plug aligns with the port, then connect it.

FIGURE 24.9 VGA cable  

Step 4: Unpack the  keyboard  and determine whether it uses a  USB  (rectangular) 
connector or a PS/2  (round) connector. If it uses a USB connector, plug it into any 
of the USB ports on the back of the computer. If it uses a PS/2 connector, plug it into 
the purple keyboard port on the back of the computer.
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FIGURE 24.10 USB cable

Step 5: Unplug the mouse and determine whether it uses a USB or PS/2 connector. If it 
uses a USB connector, plug it into any of the USB ports on the back of the computer. If 
it uses a PS/2 connector, plug it into the green mouse port on the back of the computer.

FIGURE 24.11 PS/2 connector

If your keyboard has a USB port, you can connect your mouse to the keyboard instead 
of connecting it directly to your computer.

If you have a wireless mouse or keyboard, you may need to connect a Bluetooth dongle (USB 
adapter) to your computer. However, many computers have built-in Bluetooth, so an 
adapter may not be necessary.

Step 6: If you have external speakers or headphones, you can connect them to your 
computer’s  audio port  (either on the front or back of the computer case). Many 
computers have colour-coded ports. Speakers or headphones connect to the green port, 
and microphones connect to the pink port. The blue port is the line in, which can be 
used with other types of devices.
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FIGURE 24.12 Colour coded ports

Some speakers, headphones, and microphones have USB connectors instead of the usual 
audio plug. These can be connected to any USB port. In addition, many computers have 
speakers or microphones built into the monitor.

Step 7: Locate the two power supply cables that came with your computer. Plug the first 
power supply cable into the back of the computer case and then into a surge protector. 
Then, using the other cable, connect the monitor to the surge protector.

 

FIGURE 24.13 Power supply cable

You can also use an uninterruptible power supply (UPS), which acts as a surge protector 
and provides temporary power if there is a power outage.

Step 8 : Finally, plug the surge protector into a wall outlet. You may also need to turn on 
the surge protector if it has a power switch.
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FIGURE 24.14 Surge protector

If you don’t have a surge protector, you can plug the computer directly into the wall. 
However, this is not recommended because electrical surges can damage your computer.

Step 9: If you have a printer, scanner, webcam or other peripherals, you can connect 
them at this point. Many peripherals are  plug and play, which means they will be 
recognized by your computer as soon as they are plugged in.

FIGURE 24.15 Printer

Other peripherals may include software that needs to be installed before you can begin 
using them. Use the instructions included with the device to install it if necessary. 
Generally, peripherals are optional, and you can add new ones at any time; you don’t 
have to add all peripherals during the initial setup of your computer.
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Result:

Thus the procedure of connecting and disconnecting different external Input and Output 
devices with the Computer has been learned successfully. 

Simple Assessment:

1.	 Connect the parts as per this block diagram

FIGURE 24.16 Diagram

2.	 What are the safety precautions to be taken while assembling the computer?

•• Remove your watch and jewellery and secure loose clothing.

•• Turn off the power and unplug equipment before performing service.

•• Cover sharp edges inside the computer case with tape.

•• Never open a power supply or a CRT monitor.

•• Do not touch areas in printers that are hot or that use high voltage

•• Bend your knees when lifting heavy objects to avoid injuring your back

Table showing Video suggestions:

Table 2

S.No Title/purpose Link QR Code
1 Setting up a desk-

top computer
https://youtu.be/ 
KdQeU5QTfYE

GCFLeanaFree.org
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2 How to Setup a 
Desktop Computer 
at Home

https://youtu.be/
avaOf-kdb7w

Palmetto technolo-
gy group

3 Computer Funda-
mentals - Setting 
Up a Computer - 
How to Set a Desk-
top Computers and 
How to Plug In PC

https://youtu.be/
SM0qsvQBEPg

Professor Adam 
Morgan

Table 3

Student project Students are asked to set up three computers.
Guest lecture suggestions Invite a computer field technician for a guest lecture.

Invite an  IT engineer for a guest lecture.
Industrial/ Field visit suggestions A Visit to a Computer centre for field visit.

A Visit to  a software company for industrial visit.

1. Word Processing :

Word Processing refers to the act of using a computer to create, edit, save and print documents.

In order to perform word processing, specialized software (known as a word processor) is 
needed.

Ex: MS Word, Open Office Writer and Google Drive Document.

2. Introduction

Microsoft Word (MS Word) is a popular commercial word processor created by Microsoft. It 
is also one of the widely used programs in the suite.

It is available for both windows and Apple Operating Systems (OS)

Microsoft Word is in the Microsoft office productivity package and is also available as a 
standalone application.

Microsoft Word was first released in 1983 and has seen various revisions since then. It’s 
compatible with both Windows and Mac computers.

Although many other applications give it a competition, nothing has defeated it to date.
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3. Features of MS WORD:

i.	 It helps to make professional write-ups, editing and formatting the existing documents.

ii.	 It also helps in creating graphical documents comprising images and more.

iii.	 Millions of Office Workers, students and home users create, read and edit documents 
using this software program.

iv.	 MS-Word not only supports Word Processing textures but also DTP textures.

4. Application – MS – Office:

MS Office is a powerful service and it helps the worldwide business community to improve 
their efficiency and productivity.MS Office can be used in different operating systems namely 
Window OS, Mac OS, Android ios etc.,

MS Office provides tools enabling businesses to be productive and communicate effectively 
regardless of location.

EXPERIMENT : 25

CREATE A MS WORD DOCUMENTS AND ITS VARIOUS OPTIONS

Objectives:

To create a MS word documents and use its various options.

Operations / Experiments Covered Under the Project:

1.	 Creating a document

2.	 Parts of writer window

3.	 Cursor and mouse pointer

4.	 Text editing

5.	 Undo and redo

6.	 Moving and copying text

7.	 Copy and paste

8.	 Selecting text

9.	 Selecting a vertical block of text
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10.	Find and replace

11.	Using synonyms & the thesaurus

12.	Save and reopen the file

Tools and Equipment Required:

S.no Name of the tools/  
equipment

Range/Value Quantity

1 Computer or Laptop I5 processor/4GB RAM 1
2 Microsoft office MS office 2019 1

Shortcut Keys:

Table 1 

Table showing shortcut keys

Sl.no To do this Press

1 Open a document. Ctrl+O

2 Create a new document. Ctrl+N

3 Save the document. Ctrl+S

4 Close the document. Ctrl+W

5 Cut the selected content to the Clipboard. Ctrl+X

6 Copy the selected content to the Clipboard. Ctrl+C

7 Paste the contents of the Clipboard. Ctrl+V

8 Select all document content. Ctrl+A

9 Apply bold formatting to text. Ctrl+B

10 Apply italic formatting to text. Ctrl+I

11 Apply underline formatting to text. Ctrl+U

12 Decrease the font size by 1 point. Ctrl+Left bracket ([)

13 Increase the font size by 1 point. Ctrl+Right bracket (])

14 Center the text. Ctrl+E

15 Align the text to the left. Ctrl+L
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16 Align the text to the right. Ctrl+R

17 Cancel a command. Esc

18 Undo the previous action. Ctrl+Z

19 Redo the previous action, if possible. Ctrl+Y

20 Adjust the zoom magnification.
Alt+W, Q, then use the Tab key in 
the Zoom dialog box to go to the 
value you want.

21 Split the document window. Ctrl+Alt+S

22 Remove the document window split. Alt+Shift+C or Ctrl+Alt+S

Procedure:

Section 1. Creating a document:

	 Step 1: Create a new text document by using File → New → Blank Document.

FIGURE 25.1 Create a new document.
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Step 2:  Now save the file by clicking on the File → Save. Give the name of the file (for 
example:report). By default, the file is saved in .docx format. Different file formats are 
under Save as->Save as type->Choose the different format.

FIGURE 25.2 Type file name

FIGURE 25.3 Save as type 

Step 3: Saving the file by another name

It is possible to make another copy of the file by saving it with another name using the 
Save As option. Once the user saves the document by giving a name, it is called a ‘File’. 
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The user can save the file with another name in another location with another format 
using the Save As option. The user will get two files: the previous one and the one with 
the new name. 

FIGURE 25.4 Save the file

Step 4: Closing the document

After finishing the work, close the file, as too many opened files will cause a disturbance 
in working. To close the file, select File → Close

Step 5: Opening the document

It may further require opening a file for editing. Select File → Open (Ctrl+O) and the 
document will be open for editing.

FIGURE 25.5 Open the document.

Section 2. Parts of a Writer Window:

Title bar: Title bar is located on the top of the Writer window. It shows the title of the currently 
opened document. The name of the document means the file name of the document saved on 
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the disk. For a new document, it shows the title of the document as Untitled X, where ‘X’ is the 
document number Untitled 1, Untitled 2, Untitled 3... etc., as we go on opening the new document

Menu bar: It appears below the Title Bar. It shows the menu items File, Edit, View, Insert, 
Format, Tables, Tools, Window and Help. On selecting a menu item, its submenu will open 
below the menu item. We can select any item in the submenu as per the requirement. Selecting 
the File menu. The submenu item which shows three dots ‘...’ just after the submenu name, 
means, clicking on it will open the dialog box. The submenu item which shows right hand side 
arrows ‘’ just after the submenu name, means, clicking on it will open another submenu.

Toolbars: The tool bar appears below the Menu Bar. By default, the Standard Tool Bar and 
Formatting ToolBar will appear. The other toolbars can be activated by clicking on the ‘View’ 
menu, and selecting the ‘Toolbars’ of the submenu. The user can choose the required toolbars 
by clicking on it. Standard toolbar: It contains commands in the form of icons.

Formatting toolbar: It contains the various options for formatting a document. A graphical 
representation of commands is shown in the form of icons. 

Status bar: This is positioned at the left bottom of the Writer window and displays the number 
of pages, words, the language used, zooming, etc. It is located at the bottom of the workspace. 

Scroll button and Scroll bar: It is used to scroll the document. 

Zoom: It allows you to change the scale of the text and pictures in the document only for 
view. It does not affect the physical document. It is used to check the finishing quality of the 
document. To know the meaning of other tools, position the mouse pointer on the tool and 
see the Tool Tip.

FIGURE 25.6 Part of writer windows.
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Section 3. Cursor and Mouse Pointer:

Text Cursor: The Text Cursor is a flashing vertical line in the body of the text. The 4 arrow 
keys (← →) on the keyboard are called as cursor control keys

FIGURE 25.7 Text cursor.

Mouse Pointer:

This is the mouse pointer. It takes the pointer shape while moving it around the screen. The 
mouse pointer changes to I shape, when moved over the text in a document. Moving the ‘I’ 
shaped mouse pointer over the text and clicking on the desired text, helps to get the text cursor 
while editing the document. Thus, the mouse is used to control the Text Cursor location.

Section 4. Text Editing:

Step 1: Click Home Button

Step 2: Select the text that you want to edit.

Step 3: Using the tools in the edit toolbar, change the required formatting including 
font style, paragraph alignment, list formatting, and indentation options. 

FIGURE 25.8 Text editing. 

←

←
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Section 5. Undo and Redo:

Open the existing file (For example, report.docx) and then start editing in it. If, by mistake, you 
have made some changes and now you want to erase the last change done, then use the Undo 
option. After undo command, again if you want to go back then use the Redo option. 

FIGURE 25.9 Undo and Redo.

Section 6. Moving and Copying Text from One place to Another:

Step 1: Select the text and click on Select the text →

Step 2: Right click the mouse and select Cut option or press CTRL+X. 

Step 3: Place the cursor where the text has to be moved. 

Step 4: Right click the mouse and select Paste options or press CTRL+V.

FIGURE 25.10 Copying, pasting the text.
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Section 7. Copy and Paste:

Step 1: Select the text. 

Step 2: right click and select COPY option or press CTRL+C

Step 3: Place the cursor where the text has to be duplicated. 

Step 4: Right Click and select Paste option or press CTRL+V 

Section 8. Selecting Text:

Step 1: The editing can be done by left long click and drag the mouse require select text. 

Step 2: �It is necessary to select the text to perform copy and paste operation. 
The selected text will be highlighted. For editing the text, you must first 
select the required text;

Step 3: For selecting all select press Ctrl+A.

Step 4: Press ESC to turn off the selection mode.

Section 9: Selecting a Vertical Block of Text:

Step 1: Press CTRL+A for selecting all text.

Step 2: �A vertical block of text Press CTRL+SHIFT+F8, and then use the arrow  
keys or Use Alt key and select the required text for the vertical block of text. 

Step 3: Press ESC to turn off the selection mode.

FIGURE 25.11 Selecting a vertical block of text
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Section 10: Find and Replace:

Step 1: Click on Find & Replace option in Home toolbar.

Step 2: Write text under Search for option and click on Find button to locate the entered 
word. This will select the word which you want to search for text in your document.

Step 3: Write the text under Replace with option.

Now click on Replace if you want to change only the first occurrence of it and use 
Replace All to replace all the matching occurrences. 

FIGURE 25.12 Find and replace

Section 11: Using Synonyms & Thesaurus:

Sometimes you may search for a word having a similar meaning to the word. A word processor 
helps to look up synonyms (different words with the same meaning) and antonyms (words 
with the opposite meaning) in the thesaurus. The list of synonyms can be accessed from a 
context menu Right-click on a word and point to Synonyms on the context menu. A submenu 
of alternative words and phrases are displayed. Click on a word or phrase in the submenu to 
replace it with the highlighted word or phrase in the document. Synonyms are different from a 
dictionary. A dictionary contains definitions and pronunciations, whereas thesaurus will have 
words with similar meanings or opposite meanings.

Section 12: Save and Ropen the File:

Step 1: Select File → Save

Step 2: Select the location on disk to save the file

Step 3: Type a suitable name for the document

Step 4: Click on Save button. 
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Step 5: Reopen the file by clicking the File option and Click the open option.

Step 6: Enter the name and location of the document and open the document.

FIGURE 25.13 Synonyms & Thesaurus.

Result:

Thus the MS word document has been created and its various options are used successfully.

Video Suggestions:

S.No Title/Purpose Link

1 Create a new document https://youtu.be/4M5sjPGLZks
2 Parts of window in MS word https://youtu.be/COzqY5TBXD8

3 Text editing in MS word https://youtu.be/nHNTK8QQiUE

4 Undo and redo in MS word https://youtu.be/pnMrQ6U_vtA

5 Moving and copying text in MS word https://youtu.be/mGbOlT2cdVU

6 Copy and paste in MS word https://youtu.be/sOqaakHHSQY

7 Selecting text in MS word https://youtu.be/zNXZD0cS0VM
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8 Selecting a vertical block of text in MS word https://youtu.be/vIbxrddLLj8

9 Find and replace in MS word https://youtu.be/8ZSlu4DWJ5k

10 Using synonyms & the thesaurus, in MS word https://youtu.be/hXhpd0kehfg

11 Save and reopen the file in MS word https://youtu.be/0rnx5HoxO5s

Simple Assessments:

Student project 1. Students should create a voucher for organization.

2. Should prepare an advertisement poster for a function.

Guest lecture suggestions 1. Invite a MS office specialist for a guest lecture.

2. Invite a computer technician for a guest lecture.

3.Invite an office assistant working in MS office platform.

Industrial/ Field visit 
suggestions

1.A field Visit to an office nearby the school.

2. Visit nearby banks for field visits.

3.A field Visit to the nearby auditing office.

EXPERIMENT : 26

INSTRUCTIONS TO FORMAT THE MS WORD DOCUMENT

Objectives:

To practice to use formatting instructions in MS word document.

Operations / Experiments Covered Under the Project:

1.	 Formatting the document

2.	 Formatting text, removing manual formatting

3.	 Formatting paragraph and using bullets and numbering

4.	 Assigning color, border and background to paragraph

5.	 Formatting the page
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Tools and Equipment Required:

s.no Name of the tools/  
equipment

Range/Value Quantity

1 Computer or Laptop I5 processor/4gb ram 1

2 Microsoft office MS office 2019 1

1. Format the Document: 

Step 1: Open Word and type Ctrl+N to open word’s default blank document

Step 2: Type Ctrl+S to save this blank document

Step 3: Save the document as ‘My layout.docx’ to a chosen location (e.g. Favorites) on  
your computer.

FIGURE 26.1 Format the document.

You now have created a new document in which to save your preferred layout. To set 
the page margins, select the Layout ribbon.

Step 4: In the layout menu, click on the small icon in the right bottom corner of the 
Page Setup section of the ribbon to bring up the Page Setup dialog box.

Step 5: Click the Margins tab
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 FIGURE 26.2 Margin tab.

Step 6: Set the Left margin width to 3 cm

Step 7:  choose Portrait page under orientation

Step 8: check that the Apply to is set to whole document in the drop-down box and click 
OK.

FIGURE 26.3 Orientation tab. 
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The page margin and orientation settings will now be applied to your whole document.

Specify the page layout:

To set page margins and numbering for printing double-sided documents, select the 
Layout tab in the same Page Setup window as used in step 4.

Step 9: Click the different odd and even option in the headers and footers section

 FIGURE 26.4 Header and Footer section

Step 10: Click the Different first page option

Step 11. Make sure to check that the Apply to is set to Whole document in the drop-
down box.

These page layout settings will now be applied throughout your whole 
document. They ensure that page numbering can be adjusted for odd and even 
pages and that the inside margin will be wide enough to bind your printed document

Session 2: Formatting text, Removing Manual Formatting:

Step 1: Select the text you want to format.

Step 2: To select a single word, double-click it. To select a line of text, click to the right of it.

Step 3: Select an option to change the font, font size, font color, or make the text bold, 
italic, or underline.
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FIGURE 26.5 Font alignment.

Step 4: Select the text with the formatting you want to copy.

Step 5: Click Format Painter  , and then select the text you want to copy the formatting to.

Removing Manual formatting

Step 1: Select the text from which you want to remove formatting in Word. Use your 
mouse to highlight only part of the text or select all the text in the document by selecting 
anywhere inside the document and pressing Ctrl+A to highlight all the text.

Step 2: Select the  drop-down arrow  in the lower-right corner of the Styles box to 
expand the Styles menu.

Step 3: Select Clear Formatting. Any formatting applied to the selected text will be 
removed.

Common text Formatting:

To change the text case:

Step 1: Select the text you want to modify.

Step 2:  Click the Change Case command in the Font group on the Home tab.

FIGURE 26.6 Change Case
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Step 3: Select one of the case options from the list.

To use the Bold, Italic, and Underline commands:

Step 1: Select the text you want to modify.

Step 2: Click the Bold, Italic, or Underline command in the Font group on the Home tab.

To format font size:

Select the text you want to modify.

Step 1: Left-click the drop-down arrow next to the font size box on the Home tab. The 
font size drop-down menu appears.

Step 2: Move your cursor over the various font sizes. A live preview of the font size will 
appear in the document

FIGURE 26.7 Font size box

To format font color:

Step 1: Select the text you want to modify.

Step 2: Left-click the drop-down arrow next to the font color box on the Home tab. The 
font color menu appears.
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FIGURE 26.8 Font color box

Step 3: Move your cursor over the various font colors. A live preview of the color will 
appear in the document

To format font style:

Step 1: Select the text you want to modify.

Step 2: Left-click the drop-down arrow next to the font style box on the Home tab. The 
font style drop-down menu appears.

Step 3: Move your cursor over the various font styles. A live preview of the font will 
appear in the document

FIGURE 26.9 Font style box

Apply superscript or subscript formatting to text:

Step 1: Select the text you want to format as either a superscript or subscript

Step 2: In the ribbon, click the Home tab and then click either the Superscript or 
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FIGURE 26.10 Superscript or subscript formatting to text

Subscript button, found in the lower row of the Font section. 

Session 3: Formatting paragraph and using bullets and numbering:

Paragraph style:

Styles can include character formatting (such as font, size, and color), paragraph 
formatting (such as line spacing and outline level), or a combination of both. Styles are 
stored in the template that is attached to a document.

Step 1: Home tab

Step 2; Styles gallery

Step 3: You can add styles to the gallery or remove those that you don’t often use.
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FIGURE 26.11 Style sets

Step 1: Click the design tab

Step 2: Document Formatting gallery

To open the Styles pane:

Step 1: click the Home tab, 

Step 2: Select the Styles dialog box launcher

Step 3: Select the text you want to style 

FIGURE 26.12 Formatting gallery
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To format a paragraph, you can use different commands such as different text 
alignments, bullets, numbering, multi-level list, paragraph indents, sorting text, line 
spacing, shading, and different borders. To format a paragraph, follow the steps below 
the picture

FIGURE 26.13 Indenting paragraphs 

Step 1: Select the text you want to indent

Step 2: The entire paragraph can be indented in one step. 

Step 3: Place the Text Cursor anywhere in the paragraph, select and click on the 
‘Increase Indent’ tool. Each time when you click on the Increase Indent tool, the current 
paragraph’s indent will increase. There is also a Decrease Indent tool that removes the 
indent.

Aligning paragraphs:

Step 1: Select the text and set the paragraph alignment before you start typing into  
your document.

Step 2: Then click the “Home” tab in the Ribbon.

Step 3: Then click either the “Align Left (Ctrl+L) ,” “Center (Ctrl+E),” “Align Right (Ctrl+R),” 
or “Justify” (Ctrl+J) button in the “Paragraph” button group to set the desired paragraph 
alignment.
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Creating a Bulleted List:

Step 1: Go to the Home tab

Step 2: Click on the drop-down arrow of the Bullets, which is the first option in the   
Paragraph group.

Step 3: Under the command “Bullet”, Select one of the options that you want to start 
the bulleted list   

Step 4: Now the Bullet is being inserted into your word document to start its list

Step 5: After you insert the bullet, start typing the word/sentence that you want

Step 6: Then press the enter key to start the next bullet point. Do this in the same way 
to create the Bulleted List.

Step 7: To start the new section with a word, sentence or paragraph without a Bulleted list, 
strike the Enter key 2 times

FIGURE 26.14 Bulletin library.

Creating a Numbered List:

Step 1: Go to the Home tab

Step 2: Click on the drop-down arrow of the Numbering, which is the second option in 
the Paragraph group.

Step 3: Under the command “Numbering”, Select one of the options that you want to 
start the numbered list

CA.indd   162 5/2/2022   5:21:08 PM

www.tntextbooks.in



163Computer Applications

Step 4: Now the Number is being inserted into your word document to start its list.

Step 5: After you insert the number, start typing the word/sentence that you want, 

Step 6: Then press the enter key to start the next serial number. Do this in the same way 
to create the Number List.

Step 7: To start the new section with a word, sentence or paragraph  without 
a Numbered list, strike the Enter key 2 times.

 

FIGURE 26.15 Numbering list.

Session 4: Assigning color, border and background:

Assign Page Color:

You can also add a background color to your document. This color will only appear in 
digital copies of the document—Word will not print the page color.

Step 1: On the Design tab, click the Page Color button.

Step 2 : Select a color.
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FIGURE 26.16 Assign the color.

Add Page Borders:

You can also add page borders along the margins to give it a finished look.

Step 1: On the Design tab, click the Page Borders button.

Using the Borders and Shading dialog box, customize how you want the border to look.

Step 2: Select a border style from the Style list.

You can choose from a variety of solid lines, dotted and dashed lines, and patterns.

Step 3: Select a border color.

Step 4: Select a border width.

FIGURE 26.17 Add page borders
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Step 5: Choose which sides of the page will have a border by clicking the top, bottom, 
and/or sides of the preview.

Step 6: Choose which sections of the document will have the border.

Step 7: You can choose the whole document, just this section, just the first page in this 
section, or every page in the section but the first page.

Step 8: Click OK.

The border is added to the selected pages.

Section 5: Page formatting:

To change page orientation:

Step 1: Select the Layout tab.

Step 2: Click the Orientation command in the Page Setup group

Step 3: A drop-down menu will appear. Click 

either Portrait or Landscape to change the page orientation.

 

FIGURE 26.18 Page orientation.

The page orientation of the document will be changed.
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Page size:

By default, the page size of a new document is 8.5 inches by 11 inches. Depending on 
your project, you may need to adjust your document›s page size. It’s important to note 
that before modifying the default page size, you should check to see which page sizes 
your printer can accommodate.

Step 1 :  Select the Layout tab, then click the Size command

Step 2: A drop-down menu will appear. The current page size is  highlighted. Click the  
desired predefined page size

FIGURE 26.19 Page size

The page size of the document will be changed

To use a custom page size:

Step 1 : Click the Page Setup dialog box.

Step 2:  Click page Layout>Size>More Paper Sizes from the drop-down menu.

Step 3 : The Page Setup dialog box will appear.

Step 4 : Adjust the values for Width and Height, then click OK.
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FIGURE 26.20 Page Setup dialog box 

Step 5: The page size of the document will be changed.

Page margins:

A margin  is the space between the text and the edge of your document. By default, 
a new document’s margins are set to Normal, which means it has a one-inch space 
between the text and each edge. Depending on your needs, word allows you to change 
your document’s margin size.

Step 1: Select the Layout tab, then click the Margins command.    

Step 2: A drop-down menu will appear. Click the predefined margin size you want

FIGURE 26.21 Page margins
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Step 3: The margins of the document will be changed.

Insert a page break in Word:

Word automatically adds a break at the end of each page. You can also insert a manual 
page break anytime you want to start a new page in your document.

Step 1: Put your cursor where you want one page to end and the next to begin. 

Step 2: Go to Insert > Page Break.

FIGURE 26.22 Page break.

Add page numbers to a header or footer:

Step 1: Click or tap in the header or footer where you want the page numbers.

Step 2: Go to Insert > Page Numbering.

Step 3: Select Page number

Step 4: Choose a style.

Add a border to a page:

Step 1: Go to Design > Page Border

Step 2: Make selections for how you want the border to look.
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FIGURE 26.23 Page break.

Page border

Step 3: To adjust the distance between the border and the edge of the page, select Options. 
Make your changes and select OK.

Step 4: ok

Inserting symbols, images, shapes and special characters in a document:

You can easily insert a special character, fraction, or other symbol in your Word 
documents.

Step 1: Place your cursor in the file at the spot where you want to insert the  
symbol.

Step 2: Go to Insert > Symbol.

Step 3: Pick a symbol, or choose More Symbols.

Step 4: Scroll up or down to find the symbol you want to insert. When you find the 
symbol you want, double-click it. The symbol will be inserted in your file.

Step 5. Select Close.
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FIGURE 26.24 Inserting equation and symbol.

Result:

Thus the formatting instructions in the MS word document has been practiced successfully.

Video suggestions:

s.no Title/purpose Link
1 Formatting the document https://www.youtube.com/watch?v=F6Vhzl4XxvU
2 Formatting text, remov-

ing manual formatting.
https://www.youtube.com/watch?v=SiVjclEjw9E

3 Formatting paragraphs 
and using bullets, num-
bering.

https://www.youtube.com/watch?v=yV4i29Xo0iM

4 Assigning color, border 
and background to para-
graphs.

https://www.youtube.com/watch?v=ZJyvWpZOTKY

5 Formatting the page. https://www.youtube.com/watch?v=Ci1P40GsDy8

Simple Assessments:

Student project 1. Students should create a voucher for organization.

2. Should prepare an advertisement  poster for an event in school .
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Guest lecture suggestions 1. Invite a MS office technician for a guest lecture.

2. Invite a computer technician for a guest lecture.

3. Invite an office assistant working in MS office platform.

Industrial/ Field  
visit suggestions

1. A field Visit to an office nearby the school.

2. Visit nearby banks for field visit.

3.A field Visit to the nearby auditing office.

EXPERIMENT : 27

INSTRUCTIONS TO CREATE TABLES AND  
ITS VARIOUS APPLICATIONS IN MS WORD DOCUMENT

Objective:

To practice to create tables and learn the various applications in MS word.

Operations / Experiments Covered Under the Project:

Create and use table

1.	 Inserting and Deleting the rows & columns in a table.

2.	 Splitting and Merging a table

3.	 Deleting, Copying & Moving a table

Tools and Equipment Required:

S.no Name of the tools/equipment Range/Value Quantity

1 Computer or Laptop I5 processor/4gb ram 1

2 Microsoft office MS office 2019 1

Procedure:

Section 1 : Create and use Table:

Step 1: Place the insertion point where you want the table to appear.

Step 2: Navigate to the Insert tab, then click the Table command.

Step 3: This will open a drop-down menu that contains a grid. Hover over the grid to 
select the number of columns and rows you want.
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FIGURE 27.1 Insert the table.

Step 4: Click the grid to confirm your selection, and a table will appear.

Step 5: To enter text, place the insertion point in any cell, then begin typing.

FIGURE 27.2 Enter the text in table.

Note : To navigate between cells, use the Tab key or arrow keys on your keyboard. If the 
insertion point is in the last cell, pressing the Tab key will automatically create a new row.

Section 2: Inserting and deleting the rows/columns in a table :

To add a row or column:

Step 1: Hover outside the table where you want to add a row or column. Click the plus 
sign that appears.

Step 2: A new row or column will be added to the table

CA.indd   172 5/2/2022   5:21:09 PM

www.tntextbooks.in



173Computer Applications

FIGURE 27.3 To add a new column and row to the table.

Note: You can also right-click the table, then hover over Insert to see various row and  
column options.

To delete a row or column:

Step 1: Place the insertion point in the row or column you want to delete.

Step 2: Right-click, then select Delete Cells from the menu.

Step 3: A dialog box will appear. Choose Delete entire row or Delete entire column, 
then click OK.

FIGURE 27.4 Delete a row or column to the table.

Step 4: The row or column will be deleted.
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Section 3: Splitting a table:

Step 1: Click in a cell, or select multiple cells that you want to split.

Step 2: Under Table Tools, on the Layout tab, in the Merge group, click Split Cells.

Step 3: Enter the number of columns or rows that you want to split the selected  
cells into 

FIGURE 27.5 Split table. 

Merging a table:

Step 1: Select the cells that you want to merge.

Step 2: Under Table Tools, on the Layout tab, in the Merge group, click Merge Cells.

FIGURE 27.6 Merge table.

Section 4: Deleting, copying, & moving tables:

Deleting a table:

Step 1: Right-click in a table cell, row, or column you want to delete.
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Step 2: On the Mini toolbar, click Delete.

 

FIGURE 27.7 Deleting the table.

Step 3: Choose Delete Cells, Delete Columns, or Delete Rows as required.

Coping Table:

Step 1: In the Print Layout view, rest the pointer on the table until the table move 
handle appears.

FIGURE 27.8 Copying table.

Step 2: Click the table move handle to select the table.
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Step 3: Do one of the following:

1.  To copy the table, press CTRL+C.

2.  To cut the table, press CTRL+X.

Step 4: Place the cursor where you want the new table.

Step 5: Press CTRL+V to paste the table in the new location.

Moving a table:
Step 1: In the Print Layout view, rest the pointer on the table until the table move 
handle appears.

Step 2: Keep the pointer over the table move handle until the pointer becomes a four-
headed arrow, and then click the table move handle.

Step 3: Drag the table to a new location.

Result:

Thus the tables have been created successfully.

Thus the various applications in MS document has been practiced successfully.

Video suggestions:

s.no Title/purpose Link

1 Create and use Table https://www.youtube.com/watch?v=XNBrCEgzddw

2 Inserting and deleting  
the rows and columns in 
a table

https://www.youtube.com/watch?v=Ctey7JNeoGg

https://www.youtube.com/watch?v=LS7WtlXsM5Q

3 Splitting and Merging  
a table 

https://www.youtube.com/watch?v=mWY03aAZ4vM

Simple Assessments:

Student project students should make a class time table and a month calendar.

students should prepare table content for the chapter

students should prepare a table for daily expenditure. 

Guest lecture suggestions 1. Invite a MS office technician for a guest lecture.

2. Invite a computer technician for a guest lecture.

3.Invite an office assistant working in MS office platform.
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Industrial/ Field visit  
suggestions

1.A field Visit to an office nearby the school.

2. Visit nearby banks for field visits.

3.A field Visit to the nearby auditing office.

EXPERIMENT : 28

INSTRUCTIONS TO TAKE PRINTOUT AFTER COMPLETION  
OF DOCUMENT

Objective:

To practice to take printout after completion of document in MS word.

Operations/Exercises Covered Under the Project:

1.	 Viewing print preview of the document

2.	 Editing print and controlling option in MS word

3.	 Printing the document in MS word

4.	 Printing the letters and documents using mail merge in MS word

Safety Measures:

i.	 Put your printer on a flat, stable surface such as a desk that is free of vibration and 
shocks. 

2.	 Use the printer in a well-ventilated room. 

3.	 DO NOT put the printer where the ventilation hole of the printer is blocked.

Tools and Equipment Required:

S.No Name of the tools/equipment Range/Value Quantity

1 Computer or Laptop I5 processor/4gb ram 1

2 Microsoft office MS office 2019 1

Procedure:

Section 1: Viewing print preview of the document:

Step 1: Open the MS word document to be printed.

Step 2: Click File in the left top corner of the word file or press CTRL + P
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Step 3: Select print in the menu bar (Now we can see the print preview of the document 
on the right side. (We can see all pages by scrolling the mouse up and down) 

FIGURE 28.1 Print preview of the document

Section 2: Editing print and controlling option in MS word:

Step 1: Open MS word Document to be printed

Step 2: Click File in the left top corner of the word file or Click CTRL + P

Step 3: Click the printer option to select the printer Which is currently connected with 
your PC or laptop.

Step 4: Click the up and down arrow of copies dialogue box to change the number of 
copies of the printing.

Step 5: Click Print all pages option to choose print all pages, print current page only or 
custom print option

Step 6: Click portrait option. we can choose portrait or landscape printing option

Step 7: Click letters to select size of the paper to be printed

Step 8: Click normal margin to select margin of the printing area of the paper

Step 9: Click 1 page per sheet to choose number of pages per sheet to be printed
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FIGURE 28.2 Edit the printing option

Section 3: Printing the document in MS word:

Step 1: Open the MS word document to be printed

Step 2: Click File in the left top corner of the word file or Click CTRL + P

Step 3: Click the print icon to print the document

FIGURE 28.3 Printing the document
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Section 4: Printing the letters and documents using mail merge in MS word:

Open the blank MS word document or existing document which is to be printed

Step 1: Click Mailing tab

Step 2: Click Start mail merge button

Step 3: Click step by step mail merge 

FIGURE 28.4 Opening of the mail merge

Step 4: Select document type 

Step 5: Click Next Starting document

FIGURE 28.5 Starting the document
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Step 6: Select use the current document or start from existing document (For demo we 
select use current document option)

FIGURE 28.6 Select recipient

Step 7: Click Next: select recipients and select type a new list or existing list( for demo 
we select type a existing list)

FIGURE 28.7 Existing file selection
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FIGURE 28.8 Select existing list from browse

Step 8: Click the browse button and select the existing file. If you don’t have an existing 
address list, you can click the Type a new list button and click Create. You can then type 
your address list.

Step 9: Click Next: Write your letter which one you want to be printed. Select Address 
block, Greeting line, Electronic postage, or More items from the task pane to add 
recipient information to your letter.

FIGURE 28.9 Writing your letter
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FIGURE 28.10 Add recipient information

Step 10: Click Next: Preview your letter to view letters of the all recipients

FIGURE 28.11 Print preview of the letter
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Step 11: Click Next: Complete the merge

FIGURE 28.12 Complete the merge

Step 12: Click print and select All option and click ok button.

FIGURE 28.13 Merge to printer dialog box
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FIGURE 28.14 Printing the document

Result:

1.	 Thus the students are able to view print preview of the document

2.	 Thus the students are able to know different printing and control option while printing 
the document

3.	 Thus the students are able to print the letter and document using mail merge in MS word.

Video suggestions:

s.no Title/purpose Link

1 Print preview of the document in MS word https://youtu.be/OxudZfGR7lk

2 Printing and controlling option while 
printing the document in MS word`

https://youtu.be/8PvKeny-_Fo

3 Print the letter and document using mail 
merge in MS word

https://youtu.be/27-Vj4-71xw

Simple Assessments:

Student project 1. �Student have to prepare quotations of different features of 
various printers with their price list.

2. Students have to prepare printer working principles in a chart.

3. �Students should take  samples of print out while working on file.
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Guest lecture 
suggestions

1. Invite a MS office technician for a guest lecture.

2. Invite a computer technician for a guest lecture.

3. Invite an office assistant working in MS office platform.
Industrial/ Field visit 
suggestions

1. A field Visit to an office nearby the school.

2. Visit nearby banks for field visits.

3. A field Visit to the nearby auditing office.

EXPERIMENT : 29

UTILITY OPTIONS IN SELECTING A SUITABLE  
TEMPLATE AND IMAGE IN MS WORD DOCUMENT.

Objective:

To learn about utility options in selecting a suitable template and image in MS excel  
document.

Operations/Exercises Covered Under the Project:

1.	 Apply styles in a document

2.	 Insert and use images in the document

3.	 Create and use templates in document

4.	 Create table of contents for a document

Tools and Equipment Required:

S.no Name of the tools/equipment Range/value Quantity

1 Computer or Laptop I5 processor/4gb ram 1

2 Microsoft office MS office 2019 1

Safety Measures:

1.	 Make sure to save your document at regular intervals.

1.	 Remember that before closing your word document should save the document and its 
file location.
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Procedure:

Section 1: Create and apply styles in the Document:

Step 1: Open a MS office word document.

Step 2: Click Home>Font for fonts modifying options.

Step 3: Click Home>Paragraph for paragraph formatting.

Step 4: Click Home>Styles for heading styles.

29.1 Create and apply styles in the document.

Section 2: Insert and use images in document:

Step 1: Click Insert>Pictures and select images from the source.

29.2 Insert and use images in document.
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Step 2: Select or Click picture and choose Format in the top right corner, Select the 
mode which has to be selected.

29.3 Formatting and resize the images in the document.

Step 3: Enter the size of images in the place and press Enter.

Section 3: Create and use Template:

Step 1: Prepare a template file in a word document.

Step 2: Click Home>Save as and enter the file name, Select the file type as Word 
Template(.dotx) and press Enter or Click Save.

Step 3: Close or Open a new Document file.

Step 4: Click File>Open>Personal and select your template file.

Section 4: Create table of contents:

Step 1: Open a word document. 

Step 2: Select a topic which you want to make in table of content.

Step 3: Enter the numbering and select styles. 

Step 4: Follow step 2 & 3 to the entire document. Click on References>Table of contents, 
Select the type of contents in automatic mode.
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29.4 Create the table content.

Result:

Thus the utility options in selecting a suitable template and image in MS word document has 
been learned successfully.

Simple Assessments :

1.	 Which command is used to save a document?

2.	 How will you create or modify a template?

3.	 How to resize a picture in a document?

Video suggestions:

s.no Title/purpose Link

1 Create and update new styles in 
a document.

https://youtu.be/Gk5M32aqsjUhttps://youtu.be/
Gk5M32aqsjU

2 Insert and modify pictures in the 
document.`

https://youtu.be/Lgd2QR0ltic

3 Create and use templates in doc-
ument.

https://youtu.be/qs2HzP9Q9eg

4 Create and make a table of con-
tents for a document.

https://youtu.be/0cN-JX6HP7c
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Student project 1. Create a template for a student’s identity card.

2. Create a title of content for any paragraph with page  
number.

3. Create a new style and update in your computer.

Guest lecture sugges-
tions

1. Invite a MS office technician for a guest lecture.

2. Invite a computer subject expert for a guest lecture.

3. Invite an office assistant working in MS office platform.

Industrial/ Field visit 
suggestions

1. A field Visit to an office nearby the school.

2. Visit to nearby e-seva center for field visit.

3. A field Visit to the nearby computer center.

EXPERIMENT : 30

CREATING A PURCHASE ORDER FOR ITEMS  
NEEDED FOR THE CLASSROOM USING MS WORD

Objective:

To create a purchase order for items needed for the classroom using MS word document.

Operations/Exercises Covered Under the Project:

1.	 Create a word document

2.	 Insert tables and enter the data of the purchase order

3.	 Print the document

Tools and Equipment Required:

s.no Name of the tools/ 
equipment

Range/Value Quantity

1 Computer or Laptop I5 processor/4gb ram 1

2 Microsoft office MS office 2019 1

3 Printer Epson L3250 1
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Procedure:

Section 1: Create a word document:

Step 1: Create a new document using File.

Step 2: Click the New option and save as document format.

Step 3: Rename the document.

FIGURE 30.1 Create the new word document.

Section 2: Insert tables and enter the data of the purchase order:

Step 1: Select the insert tab.

Step 2: Insert the tables using the table option.

Step 3: Enter the data in purchase order for your classroom.

FIGURE 30.2 Insert tables and enter the data of the purchase order
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Section 3: Print the document:

Step 1: Open the MS word document to be printed

Step 2: Click File > Print or Click CTRL + P

Step 3: Click the print icon to print the document

FIGURE 30.3 Print the document			   FIGURE 30.4 Purchase order-sample

Result:

Thus the purchase order for items needed for the classroom using MS word document has 
been created successfully.

Video suggestions:

s.no Title/purpose Link

1 Creating a purchase order for items need-
ed for the classroom using MS word

https://youtu.be/lyx8Anp9d-4

2 Insert tables and enter the data of the 
purchase order

https://youtu.be/zKkWZgIaRrQ

3 Print the document https://youtu.be/cweN_MQlTQE

Simple Assessments:

Student project 1. Students have to prepare the checklist for classroom items.

2. Students have to prepare the list of students in class.    
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Guest lecture sug-
gestions

1. Invite a MS office technician for a guest lecture.

2. Invite a computer technician for a guest lecture.

3. Invite an office assistant working in MS office platform.

Industrial/ Field 
visit suggestions

1. A field Visit to an office nearby the school.

2. Visit nearby stores for field visits.

Section 4: Excel Basics:

4.1. Introduction:

MS-EXCEL is a part of Microsoft office suite software. It is an electronic spreadsheet with 
numerous rows and columns, used for organizing data, graphically represent data(s) and 
performing different calculations.

It consists of 1048576 rows and 16383 columns. A row and a column together make a cell. 
Each cell has an address defined by column name and row number.

Eg: A1

  B2   - Row No.

		  Column Name.

By default, a workbook consists of 3 spread sheets (sheet 1, sheet 2 & 3)

Section 5: Features of MS EXCEL:

1.	 Easy to store and analyze huge amount of data.

2.	 Easy to recover Data.

3.	 Application of Mathematical Formulas

4.	 Neater and Cleaner visibility of information stored at workbook

5.	 Spreadsheets is excel used to segregate, handle and helps to product using password 
protection features.
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EXPERIMENT : 31

CREATE AN EXCEL FILE AND  
USING OF ITS VARIOUS OPTIONS

Objective:

To create an excel file and using of its various options MS word document.

Operations/Exercises Covered Under the Project:

1.	 Identify the rows number and columns letter, cell address.

2.	 Identify the row range, column range, row & column range of cells.

3.	 Demonstrate to enter the text, numeric data in a cell.

4.	 Construct the formula using mathematical operators

5.	 Use the basic functions to perform calculations on data

Tools and Equipment Required:

Sl.No Name of the tools/  
equipment

Range/Value Quantity

1 Computer or Laptop I5 processor/4GB ram 1

2 Microsoft office MS office 2019 1

Shortcut keys:

Sl.no To do this Shortcut keys
1 Close a workbook. Ctrl+W
2 Open a workbook. Ctrl+O
3 Go to the Home tab. Alt+H
4 Save a workbook. Ctrl+S
5 Copy selection. Ctrl+C
6 Paste selection. Ctrl+V
7 Undo recent action. Ctrl+Z
8 Remove cell contents. Delete
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9 Choose a fill color. Alt+H, H
10 Cut selection. Ctrl+X
11 Go to the Insert tab. Alt+N
12 Apply bold formatting. Ctrl+B
13 Center align cell contents. Alt+H, A, C
14 Go to the Page Layout tab. Alt+P
15 Go to the Data tab. Alt+A
16 Go to the View tab. Alt+W
17 Open the context menu. Shift+F10 or Windows Menu key
18 Add borders. Alt+H, B
19 Delete column. Alt+H, D, C
20 Go to the Formula tab. Alt+M
21 Hide the selected rows. Ctrl+9
22 Hide the selected columns. Ctrl+0

Procedure:

Section 1:

Identify the rows number and columns number, cell address. MS excel sheet: The MS excel 
sheet can have many sheets. Each sheet can have many individual cells arranged in rows and 
columns. The sheet tab shows its default name as Sheet1, Sheet2, Sheet3, ….

Rows and columns: The sheet is divided into vertical columns and horizontal rows. Each 
sheet can have a maximum of 1,048,576 (220) rows and 1024 (210) columns. The rows are 
numbered as 1,2,3,4,… and columns are numbered as A, B, C, D, …., Z, AA, AB, AC, …., AZ, 
BA to BZ, CA,…., AMJ.  

Cell and cell address: The intersection of a row and column is called a cell. It is the basic 
element of a MS excel sheet. It holds data, such as text, numbers, formulas and so on. A cell 
address is denoted by its column (letter) and row number. For example, D4, E9, Z89 are the 
valid example of cell address.

Active cell: In a MS excel sheet, cell is the place where we enter the data. Before entering any 
data in the cell, it has to be first selected by placing a cursor on it. When we position the mouse 
cursor on a cell, it gets selected, and is ready to take data from the user. This selected and 
activated cell is called an active cell. It is always highlighted, with a thick border. The address 
of the active cell is displayed in the name box. 
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Section 2: Identify the row range, column range, Cell range:

Key or Key Combination Result of Key or Combination

Arrow keys (←→) Move a single cell in arrow direction

Ctrl + Arrow Keys Moves the cell to the end of the data range in a particular 
direction

Home Moves to column A along the row where the active cell is 
there.

Ctrl + Home Moves the cell to A1 position

Ctrl + End Moves to bottom right cell of the data range

Page Up Moves the worksheet one screen up

Page Down Moves the worksheet one screen down

The column range is the number of cells spread across the column. The cell address is represented 
by single column letter and multiple row number in a sequence. In this example the column 
letter C is constant with rows varying from 2 to 7. The range of cells starts in C2 and ends in 
C7. This range of cells consists of the cells, namely C2, C3, C4, C5, C6, and C7. The range of 
cells starts in C2 and ends in C7 and it is represented by C2:C7. The row range is the number of 
cells spread across the row. The cell address is represented by single row number with columns 
varying from B to D columns. The range of cells starts in B3 and ends in D3. This range of cells 
consists of the cells, namely B3, C3, D3, and it is represented by B3:D3 The row and column 
range is the number of cells spread across the row and columns. This range is a matrix with the 
number of rows and number of columns. In this example, the range starts in cell B2 and ends 
in cell C7. This range of cells consists of the cells from B2 to B7 and cells from C2 to C7. The 
range it is represented by B2:C7.

Note: The control key is used to select more than one ‘range of cells’ in a worksheet. The control 
key is marked as ‘Ctrl’ on the keyboard.

Section 3: Demonstrate to enter the text, numer3ic data in a cell:

To enter any data in a worksheet, practically in the cell, it is required to select the cell. Cell can be 
selected by positioning the pointer in a cell. The data to be entered can be the label, values or formula. 

1.	 Label: Label is any text entered by using a keyboard. It may combine with letters, 
numbers, and special symbols.
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2.	 Values: The numerical data consisting of only numbers are called values. By default, 
values are right aligned. There are various forms of values, such as integer, decimal and 
so on.

3.	 Formulae: Any expression that begins with an equals ‘=’ is treated as formula. In the 
expression, the ‘=’ followed by values, cell address and functions are called as formula. 
When a formula is entered in a cell in a worksheet the value of the equation is displayed 
in the cell and the formula is shown in the formula bar.

Section 4: Construct the for formula using mathematical operators:

MS Excel Software has the most powerful features to calculate numerical data using 
formulae. As we use a calculator for calculation, excel sheet can add, subtract, divide, 
multiply and much more. MS-Office uses standard operators for formulae, such as a 
plus(+), minus(-), multiplication (*), a division (/) for arithmetic operation. Note: The 
order of evaluation can be changed by using brackets. (The expressions within the brackets 
are evaluated first)

Symbols Operations
+ addition

- subtraction
* multiplication
/ division
^ exponentiation (power)

Operator Formula Result

Addition (+) = 23+ 7 30

Subtraction 0 – 3 - 3

Multiplication (*) 9*6 54

Division (/) 77/7 11

Section 5: Use the basic functions to perform calculations on data:

Step 1: The main advantage of entering formulas with cell addresses and operators, works 
just like a variable. When the values of the cells concerned change, the results obtained by the 
formula also get updated accordingly. Suppose to add the values in two cells A1 and A2 and 
get the addition in cell A3. If we position the cursor in cell A3 and simply add the values as 
=5+8, then we will get the correct addition in cell A3. But if we change the values in cell A1 
to 6 and A2 to 7, then again we have to get the addition in cell A3 by writing =6+7. But if we 
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write the general formula in cell A3 is =A1+A2. Then we need not do the addition in cell A3. 
We will get the respective addition with the change in values in cell A1 and A2 For calculating 
the volume of a box with given length, width and height in cells A2, B2 and C2, respectively, 
see the formula derive the volume entered in cell D2.

FIGURE 31.1 Basic functions to perform calculations on data

Step 2: In the example of the Stationery Bill, to calculate the total cost of all the items to obtain the 
bill amount, we need to add the amount of each item. We may add each cell by using the formula. 
Position the cursor on the cell D8, and enter the formula ‘=D2+D3+D4+D5+D6+D6+D7’ and 
get the total in cell D8. But this may not be practically possible if there are hundreds of items 
and also there are more chances of error. When there is a large quantity of data it becomes 
difficult and complex task to write formula using only the cell addresses. In such situations, Ms 
Office Calc provides built in functions. SUM is the function to get the sum of range of cells. So 
we can use the function, ‘Sum(D2:D7)’ in D8 cell to obtain the total cost of all the items. In the 
function we need to include only the cell range (starting and last cell address).

FIGURE 31.2 Summation of stationery bill in excel sheet.

Step 3: Think on, which of the following method will be more appropriate to add cell data. 

Method 1

= SUM (D2:D7)		  Method 2

= D2+D3+D4+D5+D6+D7 
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The spreadsheet applications contain different functions to meet the requirements of different 
fields. 

Function Syntax Use
SUM =SUM (Number1, Number2,.....) Adds the values contained in a 

range of cells.
AVERAGE =AVERAGE (Number1, Number2,....). Finds out the average of the val-

ues contained in a range of cell
MAX =MAX (Number1, Number2,......) Finds out the largest value con-

tained in a range of cells.
MIN =MIN(Number1,Number2,......) Finds out the smallest value 

contained in a range of cells.
COUNT =COUNT(Number1,Number2,.....) Counts the number of cells 

within a range of cells

Step 4: Calculate the students mark sheet for 5 students using formula. Use all the above 5 
formula in it.

Result:

Thus the excel file has been created successfully.

Thus the various options in MS excel has been used successfully.

Video suggestions:

s.no Title/purpose Link

1 create a MS excel sheet. https://youtu.be/NzwQ_BbD2G4

2 entering and editing the text in MS excel sheet. https://youtu.be/bK1YP_y0SWE

3 Create a Excel file and using of its  
various options

https://youtu.be/NzwQ_BbD2G4

Simple Assessments:

Student project 1. �Students have to prepare shop bills by using formulas for cal-
culation.

2. �Students have to prepare a budget for the month by expenses. 

Guest lecture  
suggestions

Create a data of your assessment marks.

Create data and average your class result.

Create a new style and update it on your computer.
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Industrial/ Field visit  
suggestions

1. Invite a MS office technician for a guest lecture.

2. Invite an accounts auditor for a guest lecture.

3. Invite an office assistant working in MS office platform.

EXPERIMENT : 32

INSTRUCTIONS TO FORMAT THE MS EXCEL DOCUMENT

Objective:

To practice to use formatting instructions in MS excel document.

Operations/Exercises Covered Under the Project:

1.	 Formatting toolbar

2.	 Format range of cells with decimal places

3.	 Format range of cells to labels

4.	 Format of a cell range as scientific

5.	 Format a range of cells to display time

6.	 Align the cell data range

7.	 Create number series using fill handle

8.	 Copy formula by dragging the formula using fill handle

Tools and Equipment Required:

S.No Name of the tools/ 
equipment

Range/Value Quantity

1 Computer or Laptop I5 processor/4gb ram 1

2 Microsoft office MS office 2019 1

Procedure:

Section 1: Formatting toolbar:

Step 1: Change the font by clicking the font option(Times new roman).

Step 2: Change the size of the font by clicking the font size option (12 font size).
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Step 3: Change the font color(Black).

Step 4:  Make the text bold, italics, or underline by clicking bold, italics or       underline 
option(if required).Change the alignment by clicking the alignment option(Left, Right, 
Center and Justify).Change the borders by clicking the borders option. Fill (highlight) 
the text by clicking the highlight option.

Section 2: Format range of cells with decimal place:

Step 1: Select the cells to limit the number of decimal places.

Step 2: Right click the selected cells and select the Format Cells from the right-clicking 
menu on the screen.

FIGURE 32.1 Format range of cells with decimal place

Step 3:I n the Format Cells dialog box, go to the Number tab, click to highlight the 
Number in the Category box, and then type a number in the Decimal Places box.

For example, if you limit only 2 decimal place for selected cells, just type 2 into the 
Decimal places box.
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FIGURE 32.2 Different categories of format cell.

Step 4: Click the OK in the Format Cells dialog box. Now the selected decimals in cells 
are changed to two decimal places.

FIGURE 32.3 Conversion of format cell.

Section 3: Format range of cells to labels:

•• Open the ‘format cells dialog’ box

•• Click the Number tab
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•• Select Text

•• Click ‘OK’

•• Enter numbers

Section 4: Format of a cell range as scientific:

Step 1: The Scientific format (also referred to as Standard or Standard Index form ) is a  
way to display very large or very small numbers.

For example, instead of writing 0.0000000043, you can write 4.3 x 10-9. And if you apply 
the Excel Scientific notation format to the cell containing 0.0000000043, the number 
will be displayed as 4.2E-09.

Step 2: Select the cells and right-clicking menu of the mouse.

Step 3: Select the Format Cells from the right-clicking menu in the screen.

Step 4: In the coming Format Cells dialog box, go to the Scientific tab and select the 
decimal places.

FIGURE 32.4 Format of a cell range as scientific 
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To quickly apply the default Excel Scientific notation format with 2 decimal places, 
press Ctrl+Shift+^ on the keyboard

Section 5: Format a range of cells to display time:

Step 1: To quickly use the default date or time format, click the cell that contains the 
date or time, and then press CTRL+SHIFT+# or CTRL+SHIFT+@.

Step 2: If a cell displays ##### after you apply date or time formatting to it, the cell 
probably isn’t wide enough to display the data. To expand the column width or double-
click the right boundary of the column containing the cells. This automatically resizes 
the column to fit the number. You can also drag the right boundary until the columns 
are the size you want.

Step 3: When you try to undo a date or time format by selecting General in the Category 
list, Excel displays a number code. When you enter a date or time again, Excel displays 
the default date or time format. To enter a specific date or time format, such as January 
2010, you can format it as text by selecting Text in the Category list.

Step 4: To quickly enter the current date in your worksheet, select any empty cell, and 
then press CTRL+; (semicolon), and then press ENTER, if necessary. To insert a date 
that will update to the current date each time you reopen a worksheet or recalculate a 
formula, type =TODAY () in an empty cell, and then press ENTER.

Step 5: On the Home tab, in the Number group, click the Dialog Box Launcher next to 
Number.

FIGURE 32.5 Number group

Step 6: You can also press CTRL+1 to open the Format Cells dialog box.

•• In the Category list, click Date or Time.

Step 7: In the Type list, click the date or time format that you want to use. 
Note: Date and time formats that begin with an asterisk (*) respond to changes in 
regional date and time settings that are specified in Control Panel. Formats without an 
asterisk are not affected by Control Panel settings.

Step 8: To display dates and times in the format of other languages, click the language 
setting that you want in the Locale (location) box.
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FIGURE 32.6 Category list, click Date or Time.

FIGURE 32.7 Language setting and  Locale (location) box.

Step 9: The number in the active cell of the selection on the worksheet appears in the 
Sample box so that you can preview the number formatting options that you have 
selected.

FIGURE 32.8 Sample box  in formatting cell.

Create a custom date or time format:

Step 1: On the Home tab, click the Dialog Box Launcher next to Number. You can also 
press CTRL+1 to open the Format Cells dialog box.
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Step 2: In the Category box, click Date or Time, and then choose the number format 
that is closest in style to the one you want to create. (When creating custom number 
formats, it’s easier to start from an existing format than it is to start from scratch.)

Step 3: In the Category box, click Custom. In the Type box, you should see the format 
code matching the date or time format you selected in the step 3. The built-in date or 
time format can’t be changed or deleted, so don’t worry about overwriting it.

Step 4: In the Type box, make the necessary changes to the format. You can use any of 
the codes in the following tables: Days, months, and years

To display Use this code
Months as 1–12 m
Months as 01–12 mm
Months as Jan–Dec mmm
Months as January–December mmmm
Months as the first letter of the month mmmmm
Days as 1–31 d
Days as 01–31 dd
day as sun -sat ddd
Day as sunday-saturday dddd
Years as 00–99 yy
Years as 1900–9999 yyyy

If you use “m” immediately after the “h” or “hh” code or immediately before the “ss” code, 
Excel displays minutes instead of the month.

Hours, minutes, and seconds:

To display Use this code

Hours as 0–23 h

Hours as 00–23 hh

Minutes as 0–59 m

Minutes as 00–59 mm

Seconds as 0–59 s

Seconds as 00–59 ss

Hours as 4 AM h AM/PM

Time as 4:36 PM h:mm AM/PM
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Time as 4:36:03 P h:mm:ss A/P

Elapsed time in hours; for example, 25.02 [h]:mm

Elapsed time in minutes; for example, 63:46 [mm]:ss

Elapsed time in seconds [ss]

Fractions of a second h:mm:ss.00

AM and PM: 	If the format contains an AM or PM, the hour is based on the 12-hour clock, 
where “AM” or “A” indicates times from midnight until noon and “PM” or “P” indicates times 
from noon until midnight. Otherwise, the hour is based on the 24-hour clock. The “m” or 
“mm” code must appear immediately after the “h” or “hh” code or immediately before the “ss” 
code; otherwise, Excel displays the month instead of minutes.

Creating custom number formats can be tricky if you haven’t done it before. For more 
information about how to create custom number formats, see Create or delete a custom 
number format. 

Section 6:Align the cell data range:

Change the orientation of text in a cell:

Step 1: Select a cell, row, column, or a range.

Step 2: Select Home > Orientation  , and then select an option.You can rotate your 
text up, down, clockwise, or counterclockwise, or align text vertically.

FIGURE 32.9 Align the cell data range

Rotate text to a precise angle:

Step 1: Select a cell, row, column, or a range.

Step 2: Select Home > Orientation    > Format Cell Alignment.

Step 3: Under Orientation on the right side, in the Degrees box, use the up or down 
arrow to set the exact number of degrees that you want to rotate the selected cell 
text. Positive numbers rotate the text upward. Negative numbers rotate the text 
downward.
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Align a column or row

Step 1: Select the cells you want to align.

Step 2: On the Home tab, in the Alignment group, select a horizontal alignment option:

Align Left Center Align Right

On the Home tab, in the Alignment group, select a vertical alignment option:

Top Align Middle Align Bottom Align

FIGURE 32.10 Alignment group.

Section 7: Create number series using fill handle:

Step 1: Select the first cell in the range that to fill.

Step 2: Type the starting value for the series.

Step 3: Type a value in the next cell to establish a pattern.

Tip: For example, if you want the series 1, 2, 3, 4, 5..., type 1 and 2 in the first two cells. 
If you want the series 2, 4, 6, 8..., type 2 and 4.

Step 4: Select the cells that contain the starting values.

Step 5: Drag the fill handle  across the range that you want to fill.

Note: As you drag the fill handle across each cell, Excel displays a preview of the value. 
If you want a different pattern, drag the fill handle by holding down the right-click 
button, and then choose a pattern. 

To fill in increasing order, drag down or to the right. To fill in decreasing order, drag up 
or to the left.

Section 8: Copy formula by dragging the formula using fill handle

Step 1: Enter a formula in the top cell.

Step 2: Select the cell with the formula, and hover the mouse cursor over a small square 
at the lower right-hand corner of the cell, which is called the Fill handle. As you do this, 
the cursor will change to a thick black cross.
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Step 3: Hold and drag the fill handle down the column over the cells where you want to 
copy the formula.

FIGURE 32.11 Copy formula by dragging the formula using the fill handle.

In a similar manner, you can drag formula into adjacent cells to the right, to the left or upwards.

If the formula includes relative cell references (without the $ sign), they will automatically 
change based on a relative position of rows and columns. So, after copying the formula, verify 
that the cell references have got adjusted properly and produce the result. If necessary, switch 
between absolute, relative and mixed references by using the F4 key.

In the above example, to make sure the formula was copied correctly, let’s select some cell 
in column C, say C4, and view the cell reference in the formula bar. As you can see in the 
screenshot below, the formula is all right - relative to row 4, exactly as it should be:

FIGURE 32.12 Using references.

Result:

Thus the formatting instructions in the MS excel document has been practiced successfully.
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Video suggestions:

s.no Title/purpose Link

1 MS Excel - Editing & Formatting Data in Tamil https://youtu.be/y7GZnwbf4EE

2 Complete Excel learning https://youtu.be/YGG1aXJws4A

3 Excel basics and fundamentals for Beginners  
in Tamil

https://youtu.be/3qNOa9JjBZk

4 How to add an zero in front of numbers https://youtu.be/mijhtkFLKCY

Simple Assessments:

Student project 1.Students have to prepare a mark list by using formulas for calculation.

2. Students have to prepare a scorecard of cricket match. 

Guest lecture 
suggestions

Create a data of your assessment marks.

Create data and average your class result.

Create a new style and update it on your computer.

Industrial/ Field 
visit suggestions

1. Invite a MS office technician for a guest lecture.

2. Invite an accounts auditor for a guest lecture.

3. Invite an office assistant working in MS office platform.

EXPERIMENT : 33

USE OF REFERENCING

Objective:

To practice to use of referencing in MS excel document.

Operations/Exercises covered under the project:

1.	 Referencing

2.	 Concept of Referencing

3.	 Types of cell Reference

4.	 Relative Referencing

5.	 Mixed Referencing - Column letter is Absolute

6.	 Absolute Referencing - No change
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Tools and Equipment Required:

s.no Name of the tools/  
equipment

Range/Value Quantity

1 Computer or Laptop I5 processor/4gb ram 1

2 Microsoft office MS office 2019 1

Procedure:

Section 1: How to do Referencing in a spreadsheet: 

Step 1: Click the cell in which you want to enter the formula.

Step 2: Type the equal sign (=).

Step 3: Type the reference directly in the cell or in the formula bar, or Click the cell you 
want to refer to.

Step 4: Type the rest of the formula and press the Enter key to complete it.

Step 5: To add up the values of cells A1 and A2, you type the equal sign, click A1, type 
the plus sign, click A2 and press Enter:

FIGURE 33.1 Referencing in a spreadsheet. 

Section 2: Relative cell reference in Excel:

Step 1: A relative reference is the one without the $ sign in the row and column 
coordinates, like A1 or A1:B10. By default, all cell addresses in Excel are relative.

Step 2: To multiply numbers in column A by 5, you enter this formula in B2: =A2*5

Step 3: When copied from row 2 to row 3, the formula will change to: =A3*5

FIGURE 33.2 Relative cell reference in Excel.
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Section 3: Absolute cell reference in Excel:

Step 1: An absolute reference is the one with the dollar sign ($) in the row or column 
coordinates, like $A$1 or $A$1:$B$10.

Step 2: To multiply the numbers in column A by the number in B2, you input the 
following formula in row 2, and then copy the formula down the column by dragging 
the fill handle: =A2*$B$2

FIGURE 33.3 Absolute cell reference in Excel.

Section 4: Mixed cell reference:

Step 1: A mixed reference contains one relative and one absolute coordinate, like $A1 
or A$1.

Step 2: To multiply a column of numbers (column A) by 3 different numbers (B2, 
C2 and D2), you put the following formula in B3, and then copy it down and to the 
right:=$A3*B$2

Step 3: As the result, all the calculations are performed with a single formula, which 
changes properly for each row and column where it is copied:

FIGURE 33.4 Mixed cell reference.

Result:

Thus all types of referencing in the MS excel document has been practiced successfully.
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Video suggestions:

S.no Title/purpose Link

1 How to Make Referenc-
ing in a spreadsheet.

https://www.youtube.com/watch?v=pHEz6MrdYfo

2 Relative cell reference in 
Excel

https://www.youtube.com/watch?v=s3EiyUSR59c

3 Absolute cell reference in 
Excel

https://www.youtube.com/watch?v=pJYCll3Uh30

4 Mixed cell reference https://www.youtube.com/watch?v=SfV_MT2wWjs

Simple Assessments:

Student project 1.Students have to prepare a reference material and price. 

(use reference)

2.students have to prepare relative,absolute, mixed with per-
son ,salary,with allowance. 

Guest lecture suggestions 1. Invite a MS office technician for a guest lecture.

2. Invite a computer subject expert for a guest lecture.

3.Invite an office assistant working in MS office platform.

Industrial/ Field visit sug-
gestions

1.A field Visit to an office nearby the school.

2. Visit to nearby banks for field visit.

3.A field Visit to the nearby auditing office.

EXPERIMENT : 34

PREPARE A CHART IN MS EXCEL

Objective:

To prepare a chart in MS excel.

Operations/Exercises Covered Under the Project:

1.	 Column chart

2.	 Line chart
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3.	 Pie chart

4.	 Bar chart

Tools and Equipment Required:

S.No Name of the tools/  
equipment

Range/Value Quantity

1 Computer or Laptop I5 processor/4gb ram 1

2 Microsoft office MS office 2019 1

Procedure:

Section 1: Column chart:

Step 1: Create a new excel sheet and save the document.

Step 2: Enter the sales and expenses of the month.

Step 3: Click insert option in toolbar.

Step 4: Select the typed cells and click the clustered column chart option.

Step 5: It shows the sales and expenses of the month in column chart.

FIGURE 34.1 Column chart.

CA.indd   214 5/2/2022   5:21:11 PM

www.tntextbooks.in



215Computer Applications

Section 2: Line chart:

Step 1: Create a new excel sheet and save the document

Step 2: Enter the product trends by the month

Step 3: Click insert option in tool bar.

Step 4: Select the typed cells and click the line chart option.

Step 5: It shows the product trends by the month in line chart

FIGURE 34.2 Line chart.

Section 3: PIE chart:

Step 1: Create a new excel sheet and save as the document

Step 2: Enter the profit of the months.

Step 3: Click insert option in tool bar.

Step 4: Select the typed cells and click the pie chart option.

Step 5: It shows the profit of the different month in pie chart.

Step 6: Click the layout option in tool bar and click the data labels -->center for view 
the data’s in center of pie chart.
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FIGURE 34.3 pie chart.

Section 4: Bar chart:

Step 1: Create a new excel sheet and save the document

Step 2: Enter the product life in days 

Step 3: Click insert option in tool bar.

Step 4: Select the typed cells and click the bar chart option.

Step 5: It shows the product life in days in bar chart.

FIGURE 34.4 Bar chart.
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Result:

Thus the chart has been prepared successfully.

Video suggestions:

S.no Title/purpose Link

1 Excel chart in tamil https://youtu.be/CamobfRkSbI

2 MS Excel - Pie, Bar, Column &  
Line Chart

https://youtu.be/Z2gzLYaQatQ

3 Chart creation and in types in excel  
in Tamil

https://youtu.be/W7m8cNdMz94

Simple Assessments:

Across

1. which chart will be more useful to view sales information?

2. which chart will be used to track changes over short and long periods of time

Down

1. it shows data changes over a period of time or for illustrating comparisons among items.

2. which chart will be used to show comparisons between categories of data?
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Student project Draw the pie chart to view your quarterly examination marks 
subject wise.

Draw the column chart to view the January month income 
and expenditure of your family.

Guest lecture suggestions 1. Invite a MS office technician for a guest lecture.

2. Invite a computer subject expert for a guest lecture.

3. Invite an office assistant working in MS office platform.

Industrial/ Field visit  
suggestions

1. A field Visit to an office nearby the school.

2. Visit nearby banks for field visits.

3. A field Visit to the nearby auditing office.

EXPERIMENT : 35

ADVANCE CREATION OF ELECTRONICS  
SPREADSHEET IN MS EXCEL.

To create a spreadsheet using references, hyperlinks and macro, share the spreadsheet reviewing 
and merging in Ms excel.

OPERATIONS:

•• Consolidating data

•• Creating data

•• Setting up multiple worksheet creating reference

•• Creating and using ‘What if analysis’

•• Using Macro Recorder

SAFETY MEASURE

These are the top do’s and don’ts to keep in mind when using Excel:

•• Do plan your spreadsheet.

•• Don’t leave blank rows or columns when entering related data.

•• Do save frequently and save in two places.

•• Don’t use numbers as column headings and don’t include units with the data.

•• Do use cell references and named ranges in formulas.

•• Don’t leave cells containing formulas unlocked.

•• Do sort your data.
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TOOLS AND EQUIPMENT REQUIRED:

S.No Name of the tools/equipment Range/Value Quantity
1 Computer or Laptop i5 processor/4GB RAM 1
2 Microsoft office MS office 2019 1
3 Printer Epson 1

PROCEDURE

CREATING AND USING ‘ WHAT –IF  ANALYSIS’ IN MS-EXCEL

Step 1- In Ms Excel Open a new workbook.

Step 2-Type the following data:

S.No A B
1 Price 83
2 Qty 12
3 Amt 996

FIGURE 35.1 Scenario Manager

Step 3 - Click Data > What if analysis in Data Tools group and select Scenario Manager.

Step 4 - Scenario Manager Dialog box appears.
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Step 5 - Click add button, Add Scenario dialog box appears.

FIGURE 35.2 Add Scenario dialog box

Step 6 – In ‘Scenario Name’ textbox, type the Scenario name. In ‘changing cells’ textbox, 
select the cell address whose value is to be changed. Click OK button.

Step 7- Scenario values dialog box appears. Enter values for changing cells then click 
OK button.

Step  8 –Follow steps from 5 to 7 to create more scenarios.

Step  9 - Finally click Summary button. Scenario summary dialog box appears.

Step  10 – Select Report type and click OK button. 

Step 11- Scenario summary will appear in a new sheet. 

INSERTING HYPER LINK IN MS EXCEL

Step 1 - In Ms Excel Open a new workbook.

Step 2 – Click Insert > Hyperlink, dialog box appears.

Step 3 – From link to: section select place in this document.

FIGURE 35.3 Hyperlink dialog box
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Step  4 – In text to display textbox type the text to display as hyperlink.

Step 5 – In Type the cell reference textbox, type the cell address or select the cell reference 
from the given list. Click OK button.

Step 6 – In Active cell the text is highlighted as blue in color with underlined. This is 
the hyperlink, by clicking on it the cursor will take you to the place where it is linked.

Step 7 – Once visited, the color of the hyper link text will be changed.

LINKING EXTERNAL DATA

To import data from MS Access database, 

Step 1- In Ms Excel Open a new workbook.

Step 2 – On Data tab, in Get external data group, click from Access.

FIGURE 35.4 Get External Data

Step 3 – Select any MS Access file and click open.

Step 4 – Select a table and click OK. In Import data dialog box select table and existing 
workbook. Click OK.

Step 5 – Now we can see our database records in MS Excel. 

FIGURE 35.5 Import Data Dialog box
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RECORDING A MACRO

Step 1- In Ms Excel Open a new workbook.

Step 2 – Click View > Macros > Record Macro. A dialog box will appear. 

FIGURE 35.6 Recording a Macro

Step 3 – Give a name for the Macro. Assign shortcut key for the macro apart from the 
regular shortcut keys used in MS Excel.

Step 4 – Type the description for macro. Click OK button.

Step 5 – Now do the actions (typing text or number or formatting) to record, click 
stop recording once you complete. 
Step 6 – The created macro will be available in view macro option.

Step 7 – Now we can use the shortcut key or Click Run button in View Macro option to 
see our repeated actions

CONCLUSION:

Thus the spreadsheets using external data, hyperlinks and macro, ‘what if analysis’ in MS excel 
clearly obtained and verified.

VIDEO SUGGESTIONS:

S.No Title Video link
1 What if analysis in Excel https://youtu.be/FXaV4lckino
2 MS Excel - multiple worksheet creating 

reference, hyperlink, sharing the spread sheet
https://www.youtube.com/
watch?v=0-I1BpSlE3sz

3 MS Excel - sorting the columns using macro 
recorder

https://www.youtube.com/
watch?v=KobPARZhN2c

SIMPLE ASSESSMENTS:

 1 ____________ can be used in spreadsheet software to jump to a different location from 

CA.indd   222 5/2/2022   5:21:12 PM

www.tntextbooks.in



223Computer Applications

within a spreadsheet 

2.A __________ is an action or a set of actions that you can run as many times as you want in 
spreadsheet.

3. __________refers to a cell or a range of cells on a worksheet.

4. __________ short cut key is used to open an existing workbook.

5. ___________ short cut key is used to insert a new worksheet.

Answer (1. hyper link  2. macro  3. cell reference 4. ctrl+o  5. shift+f11 )

1 Student project Prepare an account summary sheet with a blank Balance 
column by using what if analysis.

Prepare a macro file with an example

Prepare  a hyperlink data file with an example

2 Guest lecture suggestions 1. Invite a MS office subject expert for a guest lecture.

2. Invite an auditor for a guest lecture.

3. Invite a business analyst working in MS office platform.

3 Industrial/ Field visit 
suggestions

1. A field Visit to an auditing office nearby the school.

2. Visit nearby banks for field visits.

3. A field Visit to the nearby front office of the organization.

EXPERIMENT : 36

PREPARE A BALANCE SHEET IN MS EXCEL

Objective:

To prepare a balance sheet in MS excel.

Operations/Exercises Covered Under the Project:

1.	 Creating the excel file

2.	 Enter the data’s of balance sheet

3.	 Print the document

CA.indd   223 5/2/2022   5:21:12 PM

www.tntextbooks.in



224 Computer Applications

Tools and Equipment Required:

S.No Name of the tools/equipment Range/Value Quantity

1 Computer or Laptop I5 processor/4gb ram 1

2 Microsoft office MS office 2019 1

3 Printer Epson L3250 1

Procedure:

Section 1: Creating the excel file:

Step 1: Open Excel.

Step 2: Click New Blank Workbook.

Step 3: Enter column headers into row 1.

Step 4: Enter data on individual rows.

Step 5: Click the Page Layout tab to format the data.

Step 6: Click File > Save As to save the document.

FIGURE 36.1 Creating the excel file.

Section 2: Enter the datas of balance sheet:

Step 1: Pick the balance sheet date

Step 2: List all of assets

Step 3: Add up all of assets
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Step 4: Determine current liabilities

Step 5: Calculate long-term liabilities

Step 6: Add up liabilities. 

Step 7: Calculate owner’s equity

Step 8: Add up liabilities and owners’ equity

FIGURE 36.2 Enter the datas of the balance sheet.

Section 3: Print the document:

Step 1: Open the MS excel document to be printed

Step 2: Click File in the left top corner of the excel file or Click CTRL + P

Step 3: Click the print icon to print the document

FIGURE 36.3 Print the document.
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Result:

Thus the balance sheet in Ms excel has been prepared successfully.

Video suggestions:

s.no Title/purpose Link

1 How to Prepare Balance Sheet in Tamil | 
Final Accounts in Tamil

https://youtu.be/2JY04NU_qsk

2 Salary Sheet of Cutechinfo Pvt Ltd in excel https://youtu.be/B--Dkqpcqd8

3 Microsoft excel Personal Accounts exam-
ple | House incomes and Expenses Sheet

https://youtu.be/HDlTAYedZjs

Simple Assessments:

Student project 1.Student should have to prepare the balance sheet of the 
sole trader.

2.Student should have to prepare the balance sheet of a part-
nership firm.

3.Student should have to prepare the balance sheet of a joint 
stock company.

4. Students should have to prepare the balance sheet of a not 
for profit organisation.

Guest lecture suggestions 1. Invite a MS office subject expert for a guest lecture.

2.Invite an office assistant working in MS office platform.

2.Invite an auditor working in MS office platform.

Industrial/ Field visit  
suggestions

1.A field Visit to an office nearby the school.

2. Visit nearby banks for field visit.

3.A field Visit to the nearby auditing office.
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EXPERIMENT : 37

CREATE A POWERPOINT PRESENTATION  
AND ITS VARIOUS OPTIONS

Objective:

To create a power point presentation and use of various options in MS power point 
presentation.

Operations/Exercises Covered Under the Project:

1.	 Create a presentation

2.	 Work with slides

3.	 Format the text in presentation

4.	 Create and use tables in presentation

5.	 Insert and format image in presentation

6.	 Work with slide master

Tools and Equipment Required:

S.No Name of the tools/  
equipment

Range/Value Quantity

1 Computer or Laptop I5 processor/4gb ram 1

2 Microsoft office MS office 2019 1

Shortcut keys:

Table 1 Table showing Shortcut keys

Sl.no To do this Press

1 Create new presentation. Ctrl+N

2 Add a new slide. Ctrl+M

3 Make selected text bold. Ctrl+B

4 Change the font size for selected text. Alt+H, F, S

CA.indd   227 5/2/2022   5:21:12 PM

www.tntextbooks.in



228 Computer Applications

5 Open the Zoom dialog box. Alt+W, Q

6 Cut selected text, object, or slide. Ctrl+X

7 Copy selected text, object, or slide. Ctrl+C

8 Paste cut or copied text, object, or slide. Ctrl+V

9 Undo the last action. Ctrl+Z

10 Save the presentation. Ctrl+S

11 Insert a picture from your device. Alt+N, P, D

12 Insert a shape. Alt+N, S, H

13 Select a theme. Alt+G, H

14 Select a slide layout. Alt+H, L

15 Go to the next slide. Page down

16 Go to the previous slide. Page up

17 Go to the Home tab. Alt+H

18 Go to the Insert tab. Alt+N

19 Start the slide show. F5

20 End the slide show. Esc

21 Close PowerPoint. Ctrl+Q

Procedure:

Section 1: Create a presentation:

Step 1: To create a new blank presentation, select the File Menu→New or click on the 
icon New or use the combination of keys Ctrl+N. 

Step 2: A window ‘Select a Template’ will appear. Choose a template as per your choice 
by clicking on the template 
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FIGURE 37.1 Create a presentation.

Section 2: Working with slides:

The appropriate layout can be selected from the Layouts section in the Properties 
window. The layouts included in Libre Office range from a blank slide to a slide with six 
content boxes and a title. You can also select a slide layout by using menu, Slide → Slide 
Layout → Title slide 

FIGURE 37.2 Working with slides
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Adding text: 

To add text to a slide that contains a text frame, click on Click to add text in the text 
frame and then type your text. The Outline styles are automatically applied to the text 
as you insert it. 

Saving a presentation: 

While creating a presentation, you can save it to the disk with some name, so that the 
content may not be lost or to use the presentation further. Select the File Menu→Save, 
or, use the shortcut key combination Ctrl+S, or click on the Save button on the Standard 
Toolbar. 

To Select the slide you want to duplicate from the Slides Pane:

Step 1: Select from menu bar Slide → Duplicate Slide.

Step 2: Or right-click on the slide and select Duplicate Slide from the menu.

Step 3: Or right-click on a slide in Workspace and select Slide → Duplicate Slide from 
the menu.

Step 4: Or click the Duplicate Slide icon in the Presentation toolbar. Select from menu 
bar Slide → New Slide.

Step 5: Or right-click on a slide and select New Slide from the context menu. 

Step 6: Or right-click in an empty space in the Workspace and select Slide → New Slide 
from the context menu.

Section 3: Create and use tables in presentation:

A Table can be inserted from the Insert menu by selecting Insert→Table. In the Insert 
Table dialog box, the Number of columns and the Number of rows are specified in the 
Insert Table dialog box, the Number of columns and the Number of rows are specified. 
Adjusting column width and row height using the mouse to change the width of the 
column, position on the border line between the two columns, and when the cursor 
changes to a () sign, press the left mouse button, hold and drag it until the column 
achieves the desired width. The same can be done for adjusting the row height. The 
various table formatting options can be applied on the table just like Writer. The borders 
and background can be assigned to the table. To do this, right click on the table border, 
the Table Properties dialog box will open from where you can change the borders and 
background of the table.

CA.indd   230 5/2/2022   5:21:12 PM

www.tntextbooks.in



231Computer Applications

FIGURE 37.3 Create and use tables in presentation

Section 4: Insert and format image in a presentation:

Step 1: To insert an image into the presentation, select Insert → Image on the menu bar 
or, click on the Insert Image icon located on the standard toolbar. The Insert Image 
dialog opens. Select the file from the desired directory. By selecting the Preview option, 
a thumbnail of the selected image will be displayed in the preview pane on the right 
Moving images.

FIGURE 37.4 Insert and format image in a presentation
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Step 2: To move the image in the slide, click on an image, observe that the cursor 
changes to hand shape. 

Step 3: Click and drag the picture to the desired position.

Step 4: Release the mouse button.

Resizing images:

Step 1: Select the image by clicking on it. Observe that selection handles are displayed.

Step 2: Position the cursor over one of the selection handles. The cursor changes the 
shape giving a graphical representation of the direction of the resizing. 

Step 3: Click and drag to resize the image

Step 4: Release the mouse button when satisfied with the new size.

The image can be rotated in any direction using the Rotate icon. To manually rotate an image:

Step 1: Select the image to display the selection handles.

Step 2: Click the Rotate icon on the Line and Filling toolbar.

Step 3: Click again on the selected image and the selection handles change shape and colour 
Formatting using the Image toolbar When an image is selected, the Image toolbar becomes 
available under the Properties window. This toolbar provides a number of formatting 
options. The Image toolbar can also be displayed by selecting View → Toolbars→Image from 
the menu bar.

Drawing tools:

Powerpoint provides various drawing tools. The Drawing toolbar having the majority 
of the tools are used to create graphical objects. To activate this toolbar, select View → 
Toolbars →Drawing from the main menu bar.

Section 5: Work with slide master:

Working with Slide Masters comes with various slide masters. These slide masters 
are available in the Master Pages section of the Sidebar. There are three subsections 
namely, used in this Presentation, Recently Used, and Available for Use. Click the 
expand marker next to the name to expand it. It will show thumbnails of the slides. 
Just click the collapse marker to collapse the subsection to hide the thumbnails. 
Every slide masters shown in the Available for Use lists form templates with the 
same name. 
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Adding transitions:

Step 1: In the Slidebar, select the Slide Transition icon to open the Slide Transition 
section.

Step 2: In the Slides pane or Slide Sorter view, select the slides to apply the transition. If 
you want to apply the transition to all the slides, do not select any slides.

Step 3: In the Apply to selected slides list, select a transition.

Step 4: Modify the selected transition by changing the speed or adding a sound, in the 
Modify transition section. To play a sound during transitions, select a sound from the 
Sound list.

Step 5: If a sound is selected, the Loop until the next sound option becomes active. 
Select this option to play the sound repeatedly until another sound starts. 

Step 6: Select how to advance to the next slide: manually (By mouse click) or automatically 
(Automatically after). To select an automatically advance, you will have to specify how 
long the slide should remain visible before it automatically advances to the next slide.

Step 7: To apply transition to all slides, click Apply to All Slides.

Step 8: To start the slide show from the current slide, check transitions, click Slide Show.

FIGURE 37.5 Work with slide show

Close Encounters
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FIGURE 37.6 Work with slide master

Result:

Thus the power point presentation has been created successfully.

Thus the various options in MS power point presentation has been used successfully.

Video suggestions:

s.no Title/purpose Link

1 PowerPoint Tutorial in Tamil https://youtu.be/gtGz4elezS8
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2 DATA ENTRY WORK IN EXCEL IN 
TAMIL | How to do data entry work in  
excel in Tami

https://youtu.be/TwRf2J8xj_Y

3 MS PowerPoint - Basic Presentation https://youtu.be/tcj2BhhCMN4

4 PowerPoint Full Tutorial in Tamil  https://youtu.be/S2KqmNq7eP8

Simple Assessments:

Student project

Guest lecture suggestions 1. Invite a MS office subject expert for a guest lecture.

2. Invite a computer technician for a guest lecture.

3.Invite an office assistant working in MS office platform.

Industrial/ Field visit sugges-
tions

1.A field Visit to an office nearby the school.

2. Visit nearby banks for field visit.

3.A field Visit to the nearby auditing office.

EXPERIMENT : 38

PREPARE THE +1 ACCOUNTANCY JOURNAL  
ENTRIES AND LEDGER ACCOUNTS

Objective:

To prepare the +1 accountancy journal entries and ledger accounts using MS power point 
presentation.

Tools and Equipment Required:

S.No Name of the tools/equipment Range/value Quantity

1 Computer or Laptop i5 processor/4gb ram 1

2 Microsoft office MS office 2019 1

Flow chart:

1.	 Create a presentation using PowerPoint

2.	 Create a new slide
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3.	 Insert a table

4.	 Enter the labels and datas

Safety Measures:

1.	 Make sure to save your presentation at regular intervals.

2.	 Remember that before closing your PowerPoint document you need to save the 
document and it’s file path location.

Procedure:

Step 1: Open a presentation on your computer.

Step 2: Click File>New >Blank presentation. Double click on the blank presentation.

 

FIGURE 38.1 Create a new presentation.

Step 3: Click Design>Themes, Select any theme shown in the options.
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FIGURE 38.2 Add design in the presentation.

Step 4: Enter your title name and submit it by your name in boxes.

Step 5: Click on slide 1 and press enter.

FIGURE 38.3 Add more slides and enter data in the presentation.  

Step 6: Enter the title for the Journal Entries. And Click Insert>Table>Insert Table 
enter the no of rows and columns.

CA.indd   237 5/2/2022   5:21:13 PM

www.tntextbooks.in



238 Computer Applications

FIGURE 38.4 Insert the table in presentation.

Step 7: Enter Labels and data in the table.

FIGURE 38.5 Insert the labels in table.

Step 8: Follow step 5 & 6 for Ledger Accounts.
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FIGURE 38.6 Prepare ledger account in presentation.

Step 9: Click Home>Layout and choose your layout for thanks.

FIGURE 38.7 End of the slides.

Step 10: Click Slide show>From beginning or Press F5 key to view in full screen for 
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presentation.

Result:

Thus the +1 accountancy journal entries and ledger accounts has been prepared successfully.

Video suggestions:

s.no Title/purpose Link

1 PowerPoint Tutorial in Tamil https://youtu.be/gtGz4elezS8

2 DATA ENTRY WORK IN EXCEL IN TAMIL | 
How to do data entry work in excel in Tami

https://youtu.be/TwRf2J8xj_Y

3 Class 11 - Accountancy - PPT Presentation 
- Journal, Meaning, Objectives, Limitations  
7-8-20 - MCS

https://youtu.be/82WeltyaYog

Simple Assessments:

1.	 Write down the method to open a presentation page?

2.	 Which shortcut key is used to view your presentation in full screen?

3.	 How many rows and columns are used for a Ledger account?

Student project 1. Create a data ledger presentation for your school.

2. Create a data of journal presentation for your school.

3. �Create a presentation of a trial balance with an imaginary  
Figure.

4. Create a presentation and present it to your friends.

Guest lecture  
suggestions

1. Invite a MS office subject expert for a guest lecture.

2. Invite an accounts auditor for a guest lecture.

3. Invite an office assistant working on the MS office platform.

Industrial/ Field visit 
suggestions

1. �A field Visit to an office or data maintaining center nearby  
the school.

2. Visit the nearby insurance office for a field visit.

3. A field Visit to the nearby computer center.
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